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ПРЕДИСЛОВИЕ 

Настоящий практикум является дополнением к учебнику 
"Проектирование программного обеспечения экономических 
информационных систем" (М.: Финансы и статистика. - 2-е изд., 
перераб. и доп. — 2005). Практикум содержит задания и упражне­
ния на построение моделей программного обеспечения (ПО) с 
использованием методики, применяемой в унифицированном 
процессе создания программного обеспечения (наиболее полно 
реализованном в технологии IBM Rational Unified Process). Пост­
роение моделей и диаграмм стандартного языка моделирования 
UML выполняется с помощью инструментального средства IBM 
Rational Rose, а описание требований к программному обеспече­
нию — с помощью IBM Rational RequisitePro. Использование 
упомянутых инструментальных средств не является строго обяза­
тельным: для реализации методики, описанной в практикуме, 
могут применяться средства других компаний, таких, как Borland 
или Sybase. 

Цель данного пособия — формирование у пользователей на­
выков самостоятельного практического применения современ­
ных методов и средств проектирования программного обеспече­
ния экономических информационных систем, основанных на 
использовании визуального моделирования. 

Практикум состоит из шести глав. В главе 1 приведены основ­
ные сведения об инструментальных средствах IBM Rational Rose 
и Rational RequisitePro. В главах 2—6 последовательно рассматри­
ваются моделирование бизнес-процессов, спецификация требо­
ваний и анализ требований к программному обеспечению, про­
ектирование системы и генерация кода, используется сквозной 
пример учебного проекта. 

Приложения 1—4 содержат примеры документов учебного 
проекта, методические указания по курсовому проектированию, 
возможные темы курсовых проектов по проектированию про­
граммного обеспечения и рекомендации по установке инстру­
ментальных средств для выполнения упражнений практикума. 

Практикум подготовлен в соответствии с Государственным 
образовательным стандартом по специальности "Прикладная ин-
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форматика (по областям)", но может быть использован студента­
ми и преподавателями других специальностей, связанных с про­
ектированием информационных систем и профаммного обеспе­
чения, в частности "Математическое обеспечение и администри­
рование информационных систем" и "Прикладная математика и 
информатика", а также системными аналитиками и разработчи­
ками программного обеспечения. 

Материал практикума используется в рамках курса "Объект­
но-ориентированный анализ и проектирование" на факультете 
вычислительной математики и кибернетики Московского госу­
дарственного университета им. М. В. Ломоносова, а также в учеб­
ных курсах для специалистов различных организаций. 

Автор выражает глубокую благодарность рецензентам, взяв­
шим на себя труд прочитать рукопись и сделавшим ряд конструк­
тивных замечаний, направленных на совершенствование мето­
дики подачи материала, а также своим близким за поддержку и 
терпение, которое они проявили в период написания книги. 



Глава 1 
ИНСТРУМЕНТАЛЬНЫЕ СРЕДСТВА 
IBM RATIONAL ROSE 
И RATIONAL REOUISITEPRO 

1.1 . ИНСТРУМЕНТАЛЬНОЕ СРЕДСТВО 
IBM RATIONAL ROSE 

1.1 .1 . ОБЩИЕ СВЕДЕНИЯ 

Инструментальное средство IBM Rational Rose (в дальнейшем — 
Rose) является одним из основных средств комплекса компании 
IBM Rational Software. Оно предназначено для построения моде­
лей профаммного обеспечения в процессе его анализа и проек­
тирования, а также генерации кода на различных языках про-
фаммирования и выпуска проектной документации. Rose ис­
пользуется в процессе объектно-ориентированного анализа и 
проектирования ПО, описанном в технологии Rational Unified 
Process (RUP). В основе работы Rose лежат создание элементов 
моделей с их спецификациями и построение диафамм языка мо­
делирования UML, определяющих архитектуру системы, ее ста­
тические и динамические аспекты. В составе Rose можно выде­
лить шесть основных компонентов: репозиторий, фафический 
интерфейс пользователя, средства просмотра проекта (браузер), 
средства контроля проекта, средства сбора статистики и генера­
тор документов. К ним добавляются генераторы кода для каждо­
го поддерживаемого языка, состав которых меняется от версии к 
версии. 

Репозиторий представляет собой базу данных проекта. Брау­
зер обеспечивает навигацию по проекту, в том числе перемеще­
ние по иерархиям классов и подсистем, переключение от одного 
вида диафамм к другому и т. д. Средства контроля и сбора стати­
стики дают возможность находить и устранять ошибки в процес­
се развития проекта, а не после завершения его описания. Гене­
ратор отчетов формирует тексты выходных документов на основе 
содержащейся в репозиторий информации. 
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Средства автоматической генерации кода, используя инфор­
мацию, содержащуюся в диаграммах классов и компонентов, 
формируют файлы описаний классов. Создаваемый таким обра­
зом скелет программы может быть уточнен путем прямого про­
граммирования на соответствующем языке (основные языки, 
поддерживаемые Rose, — C++ и Java). 

В результате разработки проекта с помощью Rose формиру­
ются следующие документы: 

• диаграммы UML, в совокупности представляющие собой 
модель разрабатываемой программной системы; 

• спецификации классов, объектов, атрибутов и операций; 
• заготовки текстов программ. 
Тексты программ являются заготовками для последующей ра­

боты программистов. Состав информации, включаемой в про­
граммные файлы, определяется либо по умолчанию, либо по ус­
мотрению пользователя. В дальнейшем эти исходные тексты пре­
образуются программистами в полноценные программы. 

В настоящее время компания IBM Rational Software развивает 
новое поколение инструментальных средств моделирования и 
разработки ПО (IBM Rational Software Modeler и Software 
Architect), входящих в комплекс IBM Software Development 
Platform, основой которого служит интефированная среда разра­
ботки Eclipse. Эти средства развивают возможности Rose в части 
синхронизации модели и кода (исключающей необходимость 
прямой генерации кода и обратного преобразования кода в мо­
дель). 

1.1.2. ЭЛЕМЕНТЫ ИНТЕРФЕЙСА 

Интерфейс Rose состоит из пяти основных элементов — это 
браузер, окно документации, панели инструментов, окно диа­
граммы и журнал. Их назначение заключается в следующем: 

• браузер (browser) используется для быстрой навигации по 
модели; 

• окно документации (documentation window) применяется 
для работы с текстовым описанием элементов модели; 

• панели инструментов (toolbars) используются для быстрого 
доступа к наиболее распространенным командам; 

• окно диаграммы (diagram window) прилагается для просмо­
тра и редактирования одной или нескольких диаграмм UML; 
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• журнал (log) используется для просмотра ошибок и отчетов 
о результатах выполнения различных команд. 

На рис. 1.1 показаны части интерфейса Rose. 

Рис. 1.1. Интерфейс Rose 

Браузер — это иерархическая структура, позволяющая осуще­
ствлять навигацию по модели. Все, что добавляется к ней — дейст­
вующие лица, варианты использования, классы, компоненты, — 
будет показано в окне браузера. 

С помощью браузера можно: 
• добавлять к модели элементы (действующие лица, варианты 

использования, классы, компоненты, диаграммы и тд.); 
• просматривать существующие элементы модели и связи 

между этими элементами; 
• перемещать элементы модели; 
• переименовывать эти элементы; 
• добавлять элементы модели к диафамме; 
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• связывать элемент с файлом или адресом URL (Uniform 
Resource Locator); 

• группировать элементы в пакеты; 
• работать с детализированной спецификацией элемента; 
• открывать диафамму. 
Браузер поддерживает четыре представления (view): представ­

ления вариантов использования, компонентов, размещения и 
логическое представление. Все они и содержащиеся в них эле­
менты модели описаны в подразд. 1.1.3. 

Браузер организован в древовидном стиле. Каждый элемент 
модели может содержать другие элементы, находящиеся ниже 
него в иерархии. Знак "—" около элемента означает, что его ветвь 
полностью раскрыта, знак "+" ~ ветвь свернута. 

С помощью окна документации можно документировать эле­
менты модели Rose, например, сделать краткое описание каждо­
го действующего лица. При документировании класса все, что 
будет написано в окне документации затем появится как коммен­
тарий в сгенерированном коде, что избавит от необходимости 
вносить эти комментарии вручную. Документация будет выво­
диться также в отчетах, создаваемых в среде Rose. 

Панели инструментов Rose обеспечивают быстрый доступ к 
наиболее распространенным командам. В этой среде существуют 
два типа панелей инструментов: стандартная панель и панель ди­
аграммы. Стандартная панель видна всегда, ее кнопки соответст­
вуют командам, которые могут использоваться для работы с лю­
бой диафаммой. Панель диафаммы своя для каждого типа диа­
грамм и ML. 

Все панели инструментов могут быть изменены и настроены 
пользователем. Для этого выберите пункт меню Tools > Options, а 
затем вкладку Toolbars. 

Для того чтобы показать или скрыть стандартную панель ин­
струментов (или панель инструментов диаграммы): 

1. Выберите пункт Tools > Options. 
2. Выберите вкладку Toolbars. 
3. Пометьте (или снимите пометку) контрольный переключа­

тель Show Standard ToolBar (или Show Diagram ToolBar), для того 
чтобы сделать видимой или невидимой стандартную панель ин­
струментов. 

Для того чтобы увеличить размер кнопок на панели инстру­
ментов: 
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1. Щелкните правой кнопкой мыши по требуемой панели. 
2. Выберите во всплывающем меню пункт Use Large Buttons 

(Использовать большие кнопки). 
Для того чтобы настроить панель инструментов: 
1. Щелкните правой кнопкой мыши по требуемой панели. 
2. Выберите пункт Customize (настроить). 
3. Выберите соответствующую кнопку для того чтобы доба­

вить или удалить кнопки, а затем щелкните мышью по кнопке 
Add (добавить) или Remove (удалить), как показано на рис. 1.2. 

Настройка панели инструмент»» 

Разделитель '4^1 

' СгеаЛе$ а parameterized class, 
S Creates a dan utity 
Щ Creates a parameterized cias? 
J^ Create? an Actor 

О Creates a Use Case 
Ш Deates an instantiated class 
И Creates m instantiated class t ̂ « 

j Deates a generalization 3 -
^^ Creates a realise relationship , 

::йр6Шт^^'*>1\ 

<*MA^J^^^ I 

IJT* DeaAes an associatbn relatior 
\^ Crepes an aggregation 
1 ^ Cie^es on unidirectional aggr 
^ Deates a Business Use Case 
! ^ Creates a Busbess Event 

WrtliirtiiiirtiliiriilirWiiW. 

Рис. 1.2. Настройка стандартной панели инструментов 

В окне диаграммы видно, как выглядит одна или несколько 
диаграмм UML-модели. При внесении в элементы диаграммы 
изменений Rose автоматически обновляет браузер. Аналогично 
при внесений изменений в элемент Rose автоматически обновля­
ет соответствующие диафаммы с помощью браузера, что помога­
ет поддерживать модель в непротиворечивом состоянии. 

В процессе работы над моделью определенная информация бу­
дет направляться в окно журнала, например, сообщения об ошиб­
ках, возникающих при генерации кода. Не существует способа за­
крыть журнал совсем, но его окно может быть минимизировано. 

1.1.3. ПРЕДСТАВЛЕНИЯ МОДЕЛИ ROSE 

В модели Rose поддерживаются четыре представления (views) -
представления вариантов использования, логическое, компонен­
тов и представление размещения. 
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Представление вариантов использования содержит модели биз­
нес-процессов и вариантов использования. На рис. 1.3 показано, 
как выглядит представление вариантов использования в браузере 
Rose (при использовании здесь и далее шаблона структуры моде­
ли, принятой в технологии Rational Unified Process). 

4 Rational Rose ~ (untlHed) 

•i^i^i. 1 1 ^ ^ ^ ^ 2^Ё^Ш 
->^^:^ж-^^м^ж^>^.ж^$^-т:^-ж^^^^:^;^^^^^т>-^^ 

B 'L3 Use Case View 
В'СЗ BusinessU$eCa$eModel 

t Global View of Business Actors and Business Use Cases 
^ Associations 

В СЗ Use-Case Model 
; B ' O Actors 
: ; Й' J^ <ActorName> 
I \ --^ Associations 
I Й-СЗ Use Cases 

a СЗ <Use Case Name> 
Й О <Use Case Name> 

г ̂  Ш ^<^^^ ̂ ^®w - <Use Case Name> 
|> - ̂  lhe<Actor Name> (<Actor Name> ) 
'-' ^ the<U$e-Case Name> (<U$e'Ca$e Name> ) 

• ^ Associations 
& £3 lr>cluded Use Cases 

ip СЗ <Use Ca^e Name> 
; " O <anlncludedUseCa$e> 
'- " ^ Associations 

'• '^ Associations 
Щ Architecturally Significant Use-Cases 
• ^ Associations 

Щ Global View of Actors md Use Cases 
" ^ Associations 
Main 

fe^ 

iî  

^̂ 1 

m 

im 

• " " ^ ' " ""•••Й^.»||Г!1>|ЗД}>Й1И1^>.Н||)Г 

Ж 
„ „..SSS^^^^iv^!?:^ 

•МШЫкй1Ь1МЫЬтш|£|йМММШмкмйш 

Рис. 1.3. Представление вариантов использования 
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Представление вариантов использования содержит: 
• действующих лиц бизнес-процессов (Business Actor); 
• варианты использования с точки зрения бизнес-процессов 

(Business Use Case); 
• действующих лиц и варианты использования системы; 
• документацию по вариантам использования, детализирую­

щую их процессы (сценарии или потоки событий). Каждый доку­
мент соответствует внешнему файлу, прикрепленному к элементу 
модели Rose. Вид значка этого документа зависит от приложе­
ния, используемого для до1сументирования потока событий (на­
пример, Microsoft Word); 

• диаграммы вариантов использования, отображающие дей­
ствующих лиц, варианты использования и взаимодействие меж­
ду ними. Обычно для описания бизнес-процессов и системы 
применяется несколько таких диаграмм, каждая из которых по­
казывает подмножество действующих лиц и/или вариантов ис­
пользования; 

• диаграммы деятельности, которые служат для наглядного 
описания сценариев бизнес-процессов или вариантов использо­
вания системы; 

• пакеты, содержащие группы вариантов использования 
и/или действующих лиц. 

Логическое представление (рис. 1.4) определяет то, как система 
будет реализовывать поведение, описанное в вариантах использо­
вания. Оно дает подробную картину составных частей системы и 
описывает их взаимодействие. Логическое представление вклю­
чает в основном классы и диафаммы классов. С их помощью кон­
струируется детальный проект создаваемой системы. 

Логическое представление содержит: 
• классы, являющиеся основными элементами архитектуры 

системы; 
• диаграммы классов, используемые для представления клас­

сов, их атрибутов, операций и связей. Как правило, для описания 
системы применяется несколько диафамм классов, каждая из 
которых отображает некоторое подмножество всех классов сис­
темы; 

• диафаммы взаимодействия, применяемые для отображения 
объектов, участвующих в сценарии варианта использования или 
в реализации некоторой системной операции; 
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Рис. 1.4. Логическое представление 
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• диаграммы состояний, описывающие динамику поведения 
объектов некоторого класса; , 

• пакеты, содержащие фуппы взаимосвязанных классов. Ти­
пичная система может содержать сотню классов или больше, и 
объединение их в пакеты снижает сложность модели. Для понима­
ния общей картины системы достаточно взглянуть на ее пакеты. 

Наполнение логического представления осуществляется в 
три этапа. 

На первом этапе (при моделировании бизнес-процес­
сов) строится модель бизнес-анализа (пакет Business Object 
Model), содержащая классы со стереотипами <<business worker>> 
(исполнитель) и <<business entity>> (сущность). Модель бизнес-
анализа может состоять из диаграмм разных типов. В состав мо­
дели обязательно должны входить диаграммы классов, содержа­
щие исполнителей и сущности. Кроме диаграмм классов модель 
бизнес-анализа может включать: 

• диаграммы последовательности (и кооперативные диаграм­
мы), описывающие сценарии Business Use Case в виде последова­
тельности обмена сообщениями между объектами-действующи-
ми лицами и объектами-исполнителями; 

• диафаммы деятельности с потоками объектов и "плаватель­
ными дорожками", описывающие взаимосвязи между сценария­
ми одного или различных Business Use Case; 

• диаграммы состояний, описывающие поведение объектов 
отдельных классов-сущностей. 

На втором этапе в процессе анализа в пакете Analysis 
Model определяются классы анализа: фаничные классы (bound­
ary), управляющие классы (control) и сущности (entity). Диаграм­
мы классов, реализующих вариант использования, и диафаммы 
взаимодействия, отражающие взаимодействие объектов в про­
цессе реализации сценариев варианта использования, помеща­
ются в кооперацию с именем данного варианта использования и 
стереотипом <<use case realization>>. Все кооперации помещают­
ся в пакет с именем Use Case Realizations, входящий в пакет 
Design Model. 

На третьем этапе в процессе проектирования классы 
анализа преобразуются в проектные классы (design class) и поме­
щаются в пакет Design Model. Данный пакет содержит также опи­
сание архитектурных уровней, подсистем и структуры потоков 
управления. 
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Представление компонентов содержит: 
• компоненты, являющиеся физическими модулями кода; 
• диаграммы компонентов, отображающие компоненты и их 

связи. Связи между компонентами системы отражают зависимо­
сти, возникающие при компиляции; 

• пакеты, содержащие фуппы связанных компонентов. Как и 
в случае классов, одним из критериев объединения компонентов 
в пакеты является повторное использование. 

Представление размещения определяет физическую архитек­
туру системы, которая может отличаться от ее логической архи­
тектуры. 

В представление размещения входят: 
• процессоры, в том числе любые компьютеры, способные 

обрабатывать данные. Любой процесс системы, определенный в 
структуре потоков управления, выполняется на одном или не­
скольких процессорах; 

• устройства — любая аппаратура, не способная обрабатывать 
данные, например, терминалы ввода-вывода и принтеры; 

• процессы, использующие отведенные для них ресурсы (про­
цессоры); 

• диафамма размещения, на которой показаны процессоры и 
устройства сети, а также физические соединения между ними. 
Кроме того, на диаграмме размещения изображают процессы и 
обозначают, какие процессы выполняются и на каких компьюте­
рах. 

1.1.4. РАБОТА В СРЕДЕ ROSE 

Создание моделей 

Первым шагом в работе с Rose является создание моделей. 
Их можно строить либо с нуля, либо взяв за основу существую­
щий шаблон. Готовую модель Rose со всеми элементами и диа­
граммами можно сохранить в одном файле, имеющем расшире­
ние .mdl. 

Для создания модели: 
1. Выберите в меню пункт File > New. 
2. Если установлен мастер шаблонов (Framework Wizard), то 

на экране появится список доступных шаблонов (рис. 1.5). Выбе-
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Рис. 1.5. Окно мастера шаблонов 

рите шаблон и щелкните по кнопке ОК. Если не планируется ра­
ботать с шаблонами, щелкните по кнопке Cancel. 

После выбора шаблона Rose автоматически зафужает уста­
новленные по умолчанию для этого шаблона пакеты, классы и 
компоненты. Например, шаблон Rational Unified Process по 
умолчанию формирует структуру модели (см. рис. 1.3 и 1.4). 

Rose позволяет создавать собственный шаблон. В этом случае 
состав и структура модели подлежат согласованию с общими 
стандартами проектирования, принятыми в организации, и 
должны использоваться всеми участниками проекта. 
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Сохранение моделей 

Как и в случае других приложений, рекомендуется периоди­
чески сохранять файлы во время работы с ними. Вся модель со­
храняется в одном файле. Кроме того, в отдельном файле можно 
сохранить журнал. 

Для сохранения модели выберите в меню пункт File > Save 
или щелкните мышью по кнопке Save стандартной панели инст­
рументов. 

Для сохранения журнала: 
1. Выделите окно журнала. 
2. Выберите в меню пункт File > Save log As или щелкните мы­

шью по кнопке Save стандартной панели инструментов. 
3. Введите название журнала. 

Экспорт и импорт моделей 

Rose поддерживает экспорт и импорт моделей и их элементов 
с целью дальнейшего повторного использования. 

Для экспорта модели: 
1. Выберите в меню пункт File > Export Model. 
2. Введите имя экспортируемого файла. 
Для экспорта пакета с классами: 
1. Выберите пакет на диаграмме классов, который нужно экс­

портировать. 
2. Выберите в меню пункт File > Export <Package>. 
3. Введите имя экспортируемого файла. 
Для экспорта класса: 
1. Выберите класс на диаграмме классов, который нужно экс­

портировать. 
2. Выберите в меню пункт File > Export <Class>. 
3. Введите имя экспортируемого файла. 
Для импорта модели, пакета или класса: 
1. Выберите в меню пункт File > Import Model. 
2. Укажите файл, который требуется импортировать. Более 

подробно с информацией, относящейся к типу импортируемых 
файлов, можно ознакомиться в справочной информации Rose. 

Публикация модели на Web-странице 

С помощью Rose можно публиковать модели на Web-страни­
цах, например, в корпоративной сети группы участников проек-
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та. Таким образом, все желающие смогут изучить созданные мо­
дели, не будучи пользователями Rose и не распечатывая большое 
количество соответствующей документации. 

Для публикации модели в Web: 
1. Выберите в меню пункт Tools > Web Publisher. 
2. Укажите представления модели и пакеты в окне "Web 

Publisher" (рис. 1.6). 

4^ Rose Web Publisher 

1111ИИ1Й1 

Use Case View 
г B^OQicalView 
\'Ш. Componer̂ View 
'H21 Depbynn«r»tVjew 

Е1^т^:Ш(1^ш;:; 

iMMwiiilWfMMMMltMM 

~p '^•i • " 

.-'0 
' -iw: 

^EbJ '^ 

Рис. 1.6. Окно "Web Publisher" 

3. Выберите требуемый уровень детализации. Уровень 
Documentation Only (только документация) соответствует наибо­
лее общей информации, при этом не будут показаны никакие 
свойства элементов модели. При выборе уровня Intermediate 
(промежуточный) будут показаны те свойства элементов моде­
ли, которые описаны на вкладке "General" их спецификаций. 
Уровень Full (полный) означает публикацию всех свойств, вклю­
чая те, что содержатся на вкладке "Detail" спецификации 
элементов модели. 
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4. Выберите требуемую нотацию. По умолчанию будет ис­
пользоваться та нотация, что принята по умолчанию в среде 
Rose. 

5. Укажите, нужно ли публиковать наследуемые элементы 
(inherited item), свойства и ассоциации (связи между элементами 
модели). Если установлен соответствующий флажок, то в дереве 
браузера будут показаны ассоциации. 

6. Введите название корневого файла .html, в котором будет 
опубликована модель. 

7. Нажмите на кнопку Diagrams. Если нужно использовать 
для диаграмм графические файлы, в появившемся окне "Diagram 
Options" укажите формат, в котором будут опубликованы диа­
граммы. 

8. Закончив, щелкните по кнопке Publish. В результате будут 
созданы все \\^Ь-страницы, требуемые для публикации модели. 

9. Щелкните мышью по кнопке Preview, если необходимо оз­
накомиться с результатом публикации модели. 

Добавление в элемент модели Rose ссылок 
на файлы и адресов URL 

Различные данные, находящиеся вне модели, например, до­
кумент с требованиями к системе или спецификацию варианта 
использования, можно связать с определенными элементами мо­
дели Rose. Затем открыть этот документ, дважды щелкнув по его 
значку в окне браузера. 

Для подключения к элементу модели файла или адреса URL: 
1. Щелкните правой кнопкой по нужному элементу в брау­

зере. 
2. Выполните New > File или New > URL. 
3. Укажите нужный файл или адрес URL в окне файлов. 
4. Щелкните дважды по значку адреса или файла для его от­

крытия. 
5. После того как будет подключен адрес или файл, щелкните 

по значку файла или адреса URL в браузере правой кнопкой и 
выберите Delete, чтобы удалить файл или адрес URL. С помощью 
этой операции удаляется связь между моделью Rose и файлом 
(адресом), но сам файл остается в системе. 
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Удаление элементов модели 

Существуют два способа удалить элемент модели - из одной 
диаграммы или из всей модели. 

Для того чтобы удалить элемент модели из диаграммы: 
1. Вьщелите элемент на диаграмме. 
2. Нажмите на клавишу Delete. 
3. Обратите внимание на то, что, хотя элемент и удален с ди-

афаммы, он остался в браузере и на других диаграммах системы. 
Для того чтобы удалить элемент из модели: 
1. Выделите элемент на диаграмме. 
2. Выберите в меню пункт Edit > Delete from Model или на­

жмите сочетание клавиш CTRL + D. 

Установка параметров изображения 

Глобальные параметры, например такие, как шрифт и цвет 
применяются для всех элементов модели — классов, вариантов ис­
пользования, интерфейсов, пакетов и т.д. Значения для этих пара­
метров по умолчанию устанавливаются в меню Tools > Options. 

В среде Rose разрешается изменять шрифты элементов на ди­
аграмме. Назначить элементу новые шрифт или размер шрифта 
можно следующим образом: 

1. Выделите нужный элемент или элементы. 
2. Выберите в меню пункт Font > Format. 
3. Выберите требуемый шрифт, а также его стиль и размер. 
Индивидуально изменять можно не только шрифт, но и цвет 

линии элемента. 
Для изменения цвета линии элемента: 
1. Выделите нужный элемент или элементы. 
2. Выберите в меню пункт Format > Line Color. 
3. Выберите требуемый цвет линии. 
Для того чтобы изменить цвет заливки элемента: 
1. Вьщелите нужный элемент или элементы. 
2. Выберите в меню пункт Format > Fill Color. 
3. Выберите требуемый цвет заливки. 
В Rose имеется возможность настроить диафаммы классов 

так, чтобы: 
• показывать все атрибуты и операции; 
• скрыть операции; 
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• скрыть атрибуты; 
• показывать только некоторые атрибуты или операции; 
• показывать операции вместе с их полными сигнатурами или 

только их имена; 
• показывать или не показывать видимость атрибутов и опе­

раций; 
• показывать или не показывать стереотипы атрибутов и опе­

раций. 
Значения каждого параметра по умолчанию можно задать с 

помощью окна, открываемого при выборе пункта меню Tools > 
Options. 

У данного класса на диаграмме можно: 
• показать все атрибуты; 
• скрыть все атрибуты; 
• показать только выбранные вами атрибуты; 
• подавить вывод атрибутов. 
Подавление вывода атрибутов приведет не только к исчезно­

вению атрибутов с диаграммы, но и к удалению линии, показы­
вающей место расположения атрибутов в классе. 

Существуют два способа изменения параметров представле­
ния атрибутов на диаграмме. Первый способ заключается в том, 
чтобы установить нужные значения у каждого класса индивиду­
ально. Второй — изменить значения нужных параметров по умол­
чанию до начала создания диафаммы классов. Внесенные таким 
образом изменения повлияют только на вновь создаваемые диа­
фаммы. 

Для того чтобы показать все атрибуты класса: 
1. Выделите на диафамме нужный класс. 
2. Щелкните по нему правой кнопкой мыши, чтобы открыть 

контекстно-зависимое меню. 
3. Выберите в меню Options > Show All Attributes. 
Для того чтобы показать у класса только избранные атрибуты: 
1. Вьщелите на диафамме нужный класс. 
2. Щелкните по нему правой кнопкой мыши, чтобы открыть 

контекстно-зависимое меню. 
3. Выберите в меню Options > Select Compartment Items. 
4. Укажите нужные атрибуты в окне Edit Compartment. 
Для того чтобы подавить вывод всех атрибутов класса диа­

граммы: 
1. Вьщелите на диафамме нужный класс. 
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2. Щелкните по нему правой кнопкой мыши, чтобы открыть 
контекстно-зависимое меню. 

3. Выберите в меню Options > Suppress Attributes. 
Для того чтобы изменить принятый по умолчанию вид атри­

бута: 
1. Выберите в меню модели пункт Tools > Options. 
2. Перейдите на вкладку "Diagram". 
3. Воспользуйтесь контрольными переключателями Suppress 

Attributes и Show All Attributes для установки значений парамет­
ров отображения атрибутов по умолчанию. Изменение этих зна­
чений по умолчанию повлияет только на новые диафаммы, вид 
существующих диаграмм классов не изменится. 

Как и в случае атрибутов, имеется несколько вариантов пред­
ставления операций на диаграммах, например: 

• показать все операции; 
• показать только некоторые операции; 
• скрыть все операции; 
• подавить вывод операций. 
Кроме того, можно: 
• показать только имя операции. Это означает, что на диа­

грамме будет представлено только имя операции, но не аргумен­
ты или тип возвращаемого значения; 

• показать полную сигнатуру операции. Это означает, что на 
диаграмме будет представлено не только имя операции, но и все 
ее параметры, типы данных параметров и тип возвращаемого 
значения операции. 

Для того чтобы показать все операции класса: 
1. Выделите на диаграмме нужный класс. 
2. Щелкните по нему правой кнопкой мыши, чтобы открыть 

контекстно-зависимое меню. 
3. Выберите в меню Options > Show All Operations». 
Для того чтобы показать только избранные операции класса: 
1. Вьщелите на диаграмме нужный класс. 
2. Щелкните по нему правой кнопкой мыши, чтобы открыть 

контекстно-зависимое меню. 
3. Выберите в меню Options > Select Compartment Items. 
4. Укажите нужные операции в окне "Edit Compartment". 
Для того чтобы подавить вывод всех операций класса диа­

граммы: 
1. Вьщелите на диаграмме нужный класс. 
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2. Щелкните по нему правой кнопкой мыши, чтобы открыть 
контекстно-зависимое меню. 

3. Выберите в меню Options > Suppress Operations. 
Для того чтобы показать на диафамме классов сигнатуру опе­

рации: 
1. Вьщелите на диафамме нужный класс. 
2. Щелкните по нему правой кнопкой мыши, чтобы открыть 

контекстно-зависимое меню. 
3. Выберите в меню Options > Show Operation Signature. 
Для того чтобы изменить принятый по умолчанию вид опера­

ции: 
1. Выберите в меню модели пункт Tools > Options. 
2. Перейдите на вкладку "Diagram". 
3. Воспользуйтесь контрольными переключателями Suppress 

Operations, Show All Operations и Show Operation Signatures для ус­
тановки значений параметров отображения операций по умолча­
нию. 

Для того чтобы показать видимость атрибута или операции 
класса: 

1. Вьщелите на диафамме нужный класс. 
2. Щелкните по нему правой кнопкой мыши, чтобы открыть 

контекстно-зависимое меню. 
3. Выберите в меню Options > Show Visibility. 
Для того чтобы изменить принятое по умолчанию значение 

параметра показа видимости: 
1. Выберите в меню модели пункт Tools > Options. 
2. Перейдите на вкладку "Diagram". 
3. Воспользуйтесь контрольным переключателем Show 

Visibility для установки параметров отображения видимости по 
умолчанию. 

Для переключения между нотациями видимости Rose и UML: 
1. Выберите в меню модели пункт Tools > Options. 
2. Перейдите на вкладку "Notation". 
3. Воспользуйтесь переключателем Visibility as Icons для пере­

ключения между нотациями. Если этот переключатель помечен, 
будет использоваться нотация Rose. Если нет, то нотация UML. 
Изменение данного параметра повлияет только на новые 
диаграммы, существующие диаграммы классов останутся 
прежними. 
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1.2. ИНСТРУМЕНТАЛЬНОЕ СРЕДСТВО 
IBM RATIONAL REQUISITEPRO 

1.2.1. ОБЩИЕ СВЕДЕНИЯ 

Назначение RequisitePro — управление требованиями (орга­
низация требований и отслеживание их изменений в жизненном 
цикле ПО). Каждое требование имеет определенный тип (ис­
пользуемый для классификации требований) и наименование. 
Требования содержат текст и обладают следующим стандартным 
набором атрибутов, который может быть расширен при необхо­
димости: 

• приоритет (высокий, средний, низкий); 
• статус (предложено, одобрено, утверждено, реализовано, ве­

рифицировано); 
• стоимость (высокая, средняя, низкая или числовое значе­

ние); 
• сложность реализации (высокая, средняя, низкая); 
• стабильность (высокая, средняя, низкая); 
• исполнитель. 
Требования могут быть созданы в документе или в представ­

лении (view). Вся информация о требованиях сохраняется в базе 
данных. 

Проект RequisitePro включает базу данных требований и на­
бор связанных с ней документов (например, документы вариан­
тов использования в RequisitePro содержат их обычные текстовые 
описания). Требования в этих документах связаны с базой дан­
ных, в которой хранится дополнительная информация о требова­
ниях — атрибуты, связи трассировки, сведения о версии, история 
изменений, уровень обеспечения безопасности проекта и др. Из 
базы данных RequisitePro можно запросить информацию о требо­
вании для проверки его выполнения и оценки влияния измене­
ния. Проект обычно создается менеджером проекта, который оп­
ределяет его структуру и устанавливает права доступа для участ­
ников проекта. 

Проектная база данных — база данных требований, управляе­
мая RequisitePro (одна из трех физических баз данных - Microsoft 
Access, Oracle или Microsoft SQL Server). Каждый проект 
RequisitePro имеет собственную базу данных. 
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Рис. 1.7. Интерфейс RequisitePro 

Основным элементом интерфейса RequisitePro (рис. 1.7) яв­
ляется Проводник (Explorer). В его окне отображаются в иерар­
хической упорядоченности различные рабочие продукты проекта 
(документы, требования, представления и содержащие их паке­
ты). Проводник позволяет осуществлять навигацию по проекту. 

1.2.2. СОЗДАНИЕ ПРОЕКТА REQUISITEPRO 

Для создания проекта RequisitePro: 
1. Запустите RequisitePro из меню программ, сразу после запу­

ска может появиться интерфейс системной помощи Let's Go. За­
кройте его. Затем появится диалоговое окно "Open Project" (рис. 
1.8). Оно позволяет выбрать проект для работы с ним (вкладка 
"Existing") или создать новый проект (вкладка "New"). 

2. После выбора вкладки "New" появится диалоговое окно 
"Create Project" (рис. 1.9). Здесь необходимо указать шаблон, на ос­
нове которого будет создан новый проект. Шаблоны "Composite 
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Рис. 1.8. Диалоговое окно "Open Project" 

Template", "Traditional Template" и "Use Case Template" содержат го­
товые наборы типов требований и типов документов, которые 
можно использовать для того, чтобы приступить к новому проекту 
RequisitePro. При выборе одного из указанных шаблонов эти типы 
требований и документов будут добавлены в новый проект. Описа­
ние выделенного шаблона можно получить в нижнем поле окна 
"Create Project" (например, на рис. 1.9 описанием вьщеленного 
шаблона "Blank" является "Use this template to create a blank proj­
ect"). Выбор пустого шаблона "Blank" позволит создать новый про­
ект с чистого листа. Выбор "Маке New Template" запускает специ­
альный мастер, позволяющий самостоятельно построить новый 
шаблон на основе имеющегося проекта. При этом в шаблон вой­
дут уже имеющиеся требования и докумен гы этого проекта. 
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Рис. 1.9. Диалоговое окно Create Project 

3. Выберите шаблон "Blank" и щелкните по кнопке Create. 
Появится новое диалоговое окно "Rational RequisitePro Project 
Properties" (рис. 1.10), в котором необходимо указать название со­
здаваемого проекта (под которым он будет зарегистрирован в 
RequisitePro), заранее созданную папку на диске (где будут хра­
ниться файлы проекта), тип базы данных (эта база данных будет 
содержать требования проекта и дополнительную информацию) 
и описание проекта. 

4. Щелкните по кнопке ОК для создания проекта. Проект по­
явится в окне Проводника. Если появится сообщение "Project 
directory does not exist. Do you want to create it?", щелкните no 
кнопке Yes. 
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Рис. 1.10. Окно свойств проекта 
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МОДЕЛИРОВАНИЕ 
БИЗНЕС-ПРОЦЕССОВ 

2 . 1 . ФОРМУЛИРОВКА ПРОБЛЕМЫ 

В данном практикуме мы будем рассматривать проблему, свя­
занную с созданием системы регистрации студентов университе­
та на дополнительные платные курсы. 

В настоящее время процесс регистрации студентов, желаю­
щих прослушать те или иные дополнительные курсы, и распреде­
ления курсов между профессорами непрост и продолжителен. 

После того как профессора примут решение, какие курсы 
они собираются преподавать в очередном семестре, сотрудник 
деканата вводит полученную информацию в базу данных, со­
держащую всю информацию о курсах (каталог курсов) и распе­
чатывает отчет, содержащий сведения о распределении педаго­
гической нагрузки. Соответствующий каталог курсов также 
публикуется и передается студентам. Информация о каждом 
курсе включает имя профессора, наименование кафедры и тре­
бования к предварительному уровню подготовки (прослушан­
ным курсам). 

Каждый студент заполняет специальную форму, отмечает вы­
бранные курсы и передает форму в деканат. Студент в течение се­
местра может посещать занятия по четырем курсам. На каждый 
курс может записаться не более 10 и не менее 3 студентов (если 
менее 3, то курс не состоится). Данные из форм, полученных от 
студентов, поступают в систему. Как только вся информация бу­
дет введена, выполняется процедура формирования учебного 
плана. В большинстве случаев первый вариант выбора, предъяв­
ленный студентом, оказывается окончательным. Если возникают 
разногласия или несоответствия, студента приглашают в деканат, 
где его требования и предпочтения уточняются и учитываются 
вновь. По завершении согласования студентам рассылаются 
"твердые" копии расписаний занятий. На весь процесс обычно 
уходит одна-две недели. 
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После того как процесс регистрации студента завершен, со­
трудник деканата направляет информацию в расчетную систему, 
чтобы студент мог внести плату за семестр. 

После окончания регистрации профессорам передаются спи­
ски студентов по каждому курсу. 

2.2. СОЗДАНИЕ МОДЕЛИ ВАРИАНТОВ 
ИСПОЛЬЗОВАНИЯ ДЛЯ БИЗНЕС-ПРОЦЕССОВ 

Моделирование бизнес-процессов предусматривает построе­
ние двух моделей: 

• модели вариантов использования для бизнес-процессов 
(Business Use Case Model); 

• модели бизнес-анализа (Business Analysis Model). 
Модель Business Use Case — модель, описывающая бизнес-

процессы организации в терминах ролей и их потребностей. Она 
представляет собой расширение модели вариантов использова­
ния UML за счет введения набора стереотипов ~ Business Actor 
(стереотип действующего лица) и Business Use Case (стереотип 
варианта использования). 

Business Actor (действующее лицо бизнес-процессов) - это не­
которая роль, внешняя по отношению к бизнес-процессам орга­
низации. Потенциальными кандидатами в действующие лица 
бизнес-процессов являются: 

• акционеры; 
• заказчики; 
• поставщики; 
• партнеры; 
• потенциальные клиенты; 
• местные органы власти; 
• сотрудники подразделений организации, деятельность ко­

торых не охвачена моделью; 
• внешние системы. 
Список действующих лиц составляется по результатам отве­

тов на следующие вопросы: 
• кто извлекает пользу из существования организации? 
• кто помогает организации осуществлять свою деятельность? 
• кому организация передает информацию и от кого полу­

чает? 
Для правильного распознавания состава действующих лиц 

следует в первую очередь определить рассматриваемую организа-
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цию или область деятельности. В данном случае роль такой орга­
низации выполняет деканат, отвечающий за регистрацию студен­
тов на курсы, а следовательно, действующими лицами бизнес-
процессов являются: 

• студент — записывается на курсы; 
• профессор — выбирает курсы для преподавания. 

У п р а ж н е н и е 2.1. 
Создание действующих лиц бизнес-процессов в среде Rose 
При запуске Rose в окне "Create New Model" выберите шаблон 

"Rational Unified Process" (см. рис. 1.5). Для того чтобы поместить 
действующее лицо в браузер: 

1. Щелкните правой кнопкой мыши по пакету Business Use 
Case Model представления Use Case View в браузере. 

2. Выберите в открывшемся меню пункт New > Actor. В брау­
зере появится новое действующее лицо под названием NewClass. 
Слева от его имени вы увидите пиктограмму действующего лица 
UML. 

3. Выделите новое действующее лицо и введите его имя. 
4. Щелкните правой кнопкой мыши по действующему лицу. 
5. Выберите пункт Open Specification в открывшемся меню. 
6. Выберите Business Actor в поле стереотипа и щелкните по 

кнопке ОК. 
7. Сохраните модель под именем Coursereg с помощью пунк­

та меню File > Save после создания действующих лиц. 
Business Use Case (вариант использования с точки зрения биз­

нес-процессов) определяется как описание последовательности 
действий в рамках некоторого бизнес-процесса, приносящих 
ощутимый результат конкретному действующему лицу. 

При использовании данной методики необходимо сосредото­
чить внимание в первую очередь на элементарных бизнес-процес­
сах. Элементарный бизнес-процесс можно определить как задачу, 
выполняемую одним человеком в одном месте в одно время в от­
вет на некоторое событие, приносящую конкретный результат и 
переводящую данные в некоторое устойчивое состояние (напри­
мер, подтверждение платежа по кредитной карточке). Решение 
такой задачи обычно включает от 5 до 10 шагов и может занимать 
от нескольких минут до нескольких дней, но рассматривается как 
один сеанс взаимодействия действующего лица с исполнителями. 

Каждый Business Use Case отражает цель или потребность не­
которого действующего лица. Исходя из потребностей действую-
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щих лиц (студентов и профессоров), можно вьщелить следующие 
варианты использования: Зарегистрироваться на курсы и Вы­
брать курсы для преподавания. 

Упражнение 2.2. 
Создание вариантов использования для бизнес-процессов 
в среде Rose 
Для того чтобы поместить вариант использования в браузер: 
1. Щелкните правой кнопкой мыши по пакету Business Use 

Case Model представления Use Case \^ew в браузере. 
2. Выберите в появившемся меню пункт New > Use Case. 
3. Новый вариант использования под названием NewUseCase 

появится в браузере. Слева от него будет видна пиктограмма ва­
рианта использования UML. 

4. Вьщелите новый вариант использования и введите его на­
звание. 

5. Щелкните правой кнопкой мыши по варианту использова­
ния. 

6. Выберите пункт Open Specification в открывшемся меню. 
7. Выберите Business Use Case в поле стереотипа и щелкните 

по кнопке ОК. 
Создадим диафамму вариантов использования для бизнес-

модели деканата. Требуемые для этого действия подробно пере­
числены ниже. Готовая диафамма вариантов использования при­
ведена на рис. 2.1. 

Упражнение 2.3. 
Построение диаграммы вариантов использования 
для бизнес-модели 

Для создания новой диафаммы вариантов использования: 
1. Откройте пакет Business Use Case Model в представлении 

вариантов использования (Use Case View), щелкнув левой кноп­
кой мыши по значку"+" слева от него. 

2. Щелкните дважды по названию диафаммы Global View of 
Business Actors and Business Use Cases в браузере, чтобы открыть ее. 

3. Перетащите мышью из браузера действующее лицо или ва­
риант использования на диафамму вариантов использования. 

4. Нарисуйте ассоциации между действующими лицами и ва­
риантами использования с помощью кнопки Unidirectional 
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Рис. 2.1. Диафамма вариантов использования бизнес-модели 

Association (Однонаправленная ассоциация) панели инстру­
ментов. 

Описание Business Use Case представляет Собой специфика­
цию, которая состоит из следующих пунктов: 

• наименование; 
• краткое описание; 
• цели и результаты (с точки зрения действующего лица); 
• описание сценариев (основного и альтернативных); 
• специальные требования (ограничения по времени выпол­

нения или другим ресурсам); 
• расширения (частные случаи); 
• связи с другими Business Use Case; 
• диаграммы деятельности (для наглядного описания сцена­

риев — при необходимости). 
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Упражнение 2.4. 
Добавление описаний к вариантам использования 
Для добавления описаний: 
1. Выделите в браузере вариант использования "Зарегистри­

роваться на курсы". 
2. Введите в окне документации следующее описание к этому 

варианту использования: "Данный Business Use Case позволяет 
студенту зарегистрироваться на конкретные курсы в текущем се­
местре". 

3. Создайте с помощью MS Word текстовый файл с приведен­
ным ниже описанием варианта использования "Зарегистриро­
ваться на курсы". 

Спецификация Business Use Case "Зарегистрироваться на курсы** 
Наименование: 
Зарегистрироваться на курсы. 
Краткое описание: 
Данный Business Use Case позволяет студенту зарегистриро­

ваться на предлагаемые курсы в текущем семестре. 
Основной сценарий: 
1. Студент приходит к сотруднику деканата и передает ему за­

полненную форму регистрации на курсы. 
2. Сотрудник деканата подтверждает правильность заполне­

ния формы. 
3. Сотрудник деканата подтверждает, что студент выполнил 

предварительные требования для каждого выбранного курса (про­
хождение определенных курсов), а также наличие свободных мест 

4. Сотрудник деканата вносит студента в список каждого кур­
са, выбранного им. 

5. Сотрудник деканата формирует график студента на теку­
щий семестр и передает его студенту. 

Альтернативные сценарии: 
2а. Неправильно заполнена форма регистрации. 
Сотрудник деканата возвращает студенту форму для исправ­

ления ошибок. 
За. Не выполнены предварительные требования или заполнен курс: 
Если сотрудник деканата обнаружит, что студент не выпол­

нил необходимые предварительные требования или выбранный 
им курс заполнен (уже записались 10 студентов), то он предлага­
ет студенту изменить свой выбор курсов либо забрать форму и 
вернуться к нему позже. 
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Упражнение 2.5. 
Прикрепление файла к варианту использования 
Для прикрепления файла к варианту использования: 
1. Щелкните правой кнопкой мыши по варианту использова­

ния. 
2. Выберите пункт Open Specification в открывшемся меню. 
3. Перейдите на вкладку Files. 
4. Щелкните правой кнопкой мыши по белому полю и выбе­

рите из открывшегося меню пункт Insert File. 
5. Укажите созданный ранее файл и щелкните по кнопке 

Open, чтобы прикрепить файл к варианту использования. 

2.3. СОЗДАНИЕ МОДЕЛИ БИЗНЕС-АНАЛИЗА 
Для каждого Business Use Case строится модель бизнес-анализа — 

объектная модель, описывающая реализацию бизнес-процесса в 
терминах взаимодействующих объектов (бизнес-объектов — 
Business Object), принадлежащих к двум классам - Business 
Worker и Business Entity. 

Business Worker (исполнитель) — активный класс, представля­
ющий собой абстракцию исполнителя, выполняющего некото­
рые действия в рамках бизнес-процесса. Исполнители взаимо­
действуют между собой и манипулируют различными сущностя­
ми, участвуя в реализациях сценариев Business Use Case. На 
диаграмме классов UML исполнитель представляется в виде 
класса со стереотипом <<business worker». 

Business Entity (сущность) — пассивный класс, не инициирую­
щий никаких взаимодействий. Объект такого класса может уча­
ствовать в реализациях различных Business Use Case. Сущность 
является объектом различных действий со стороны исполните­
лей. На диаграмме классов UML сущность представляется в виде 
класса со стереотипом <<business entity>>. 

Модель бизнес-анализа может состоять из диафамм разных 
типов. В состав модели обязательно должна входить диаграмма 
классов, содержащая исполнителей и сущности. 

Согласно формулировке проблемы, роль исполнителя выпол­
няет сотрудник деканата (назовем его "регистратор"), который 
формирует учебный план и каталог курсов, записывает студентов 
на курсы, ведет все данные о курсах, профессорах и студентах. 
Сущностями, которыми он манипулирует, являются: 
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• студент; 
• профессор; 
• график студента (список курсов); 
• курс (в программе обучения); 
• предлагаемый курс (курс в расписании). 
Для Business Use Case "Зарегистрироваться на курсы" список 

сущностей будет следующим: 
• студент; 
• график студента; 
• предлагаемый курс. 
Диаграмма классов для модели бизнес-анализа, описываю­

щей Business Use Case "Зарегистрироваться на курсы", приведена 
на рис. 2.2 (для данных классов использовано изображение сте-

-Rational Rose -coursereg analysl$.mdl~ f C I M S - Ш Ш ^ Ш Ш Ш 1 Ш ' | | Ш | 

«Business Worker» 
Регистратор 

(from Business Object liilodel) 

«Business Entity» 
Студент 

(from Business Object il/lodeO 

«Business Entity» 
Конкретный курс 

(from Business Object Modei) 

0.4 

«Business Entity» 
График 

(from Business Object ftilodei) 

Ш з ; \?^^": ^̂ -̂ -̂..̂ <-

Рис. 2.2. Диаграмма классов модели бизнес-анализа 
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реотипа в виде метки — label). Настройка изображения стереоти­
па может быть выполнена следующими способами: 

1. Для всей модели — в меню Tools > Options > Diagram > 
Stereotype Display 

2. Для отдельного элемента модели — в его контекстном меню 
Options > Stereotype Display 

3. Для нескольких сгруппированных элементов модели — в 
меню Format > Stereotype Display 

У п р а ж н е н и е 2.6. 
Создание классов, участвующих в реализации бизнес-процесса 

"Зарегистрироваться на курсы", и кооперации, описывающей реали­
зацию бизнес-процесса 

Для создания классов, кооперации и диафаммы классов: 
1. Щелкните правой кнопкой мыши по пакету Business Object 

Model представления Logical View в браузере. 
2. Выберите в открывшемся меню пункт New > Class. Новый 

класс под названием NewClass появится в браузере. 
3. Выделите его и введите имя "Регистратор". 
4. Щелкните правой кнопкой мыши по данному классу. 
5. Выберите в открывшемся меню пункт Open Specification. 
6. Выберите Business Worker в поле стереотипа и щелкните по 

кнопке ОК. 
7. Создайте аналогичным образом классы-сущности со сте­

реотипом << Business Entity>>. 
8. Щелкните правой кнопкой мыши по пакету Business Object 

Model представления Logical View в браузере. 
9. Выберите в открывшемся меню пункт New > Package. 
10. Назовите новый пакет Business Use Case Realizations. 
11. Создайте кооперацию "Зарегистрироваться на курсы" (ко­

операция представляет собой вариант использования со стерео­
типом "business use-case realization", который задается в специфи­
кации варианта использования) в пакете Business Use Case 
Realizations. 

12. Щелкните правой кнопкой мыши по созданной коопера­
ции. 

13. Выберите в открывшемся меню пункт New > Class 
Diagram. 

14. Назовите новую диаграмму классов Participating Classes. 
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15. Откройте диаграмму классов Participating Classes и перета­
щите классы на открытую диаграмму в соответствии с рис. 2.2. 

Для того чтобы на диаграмме классов создать ассоциацию: 
1. Щелкните на панели инструментов по кнопке Association 

(после установки Rose эта кнопка по умолчанию не показана на 
панели. Для вывода кнопки необходимо настроить панель). 

2. Проведите мышью линию ассоциации от одного класса к 
другому. 

Для того чтобы задать мощность связи: 
1. Щелкните правой кнопкой мыши по одному концу связи. 
2. Выберите в открывшемся контекстном меню связи пункт 

Multiplicity 
3. Укажите нужную мощность. 
4. Повторите действия п. 1—3 для другого конца связи. 
5. Откройте спецификацию связи (дважды щелкнув по ней 

левой кнопкой мыши) и установите точное значение мощности в 
поле Multiplicity на вкладке "Role А Detail" или "Role В Detail", ес­
ли требуемое значение мощности не совпадает со стандартными 
значениями в контекстном меню связи. 

Кроме диаграммы классов, модель бизнес-анализа может 
включать: 

• диафаммы деятельности с потоками объектов и "плаватель­
ными дорожками", описывающие взаимосвязи между сценария­
ми одного или различных Business Use Case; 

• диаграммы последовательности (и кооперативные диаграм­
мы), описывающие сценарии Business Use Case в виде последова­
тельности обмена сообщениями между объектами-действующи-
ми лицами и объектами-исполнителями. Такие диаграммы помо­
гают явно определить в модели обязанности каждого 
исполнителя в виде набора его операций; 

• диаграммы состояний, описывающие поведение отдельных 
бизнес-объектов. 

Упражнение 2.7. 
Создание диаграммы деятельности 

Для описания процесса формирования каталога курсов и рас­
сылки его студентам можно построить следующую диаграмму де­
ятельности (рис. 2.3). 
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Рис. 2.3. Диаграмма деятельности 

Для того чтобы добавить диафамму деятельности: 
1. Щелкните правой кнопкой по пакету Business Use Case 

Realizations в браузере. 
2. Выполните в меню команду New > Activity Diagram. 
3. Rose создаст в браузере элемент State/Activity Model, нахо­

дящийся ниже пакета. 
4. Присвойте имя новой диаграмме деятельности. 
5. Щелкните дважды по этой диаграмме, чтобы открыть ее. 
В созданную диаграмму деятельности с помощью панели ин­

струментов добавляются "плавательные дорожки", деятельности 
и другие объекты. 

Для добавления в диаграмму дорожек: 
1. Выберите на панели инструментов кнопку Swimlane. 
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2. Щелкните внутри диаграммы. Появится новая дорожка с 
присвоенным по умолчанию именем NewSwimlane. 

3. Откройте спецификацию дорожки, щелкнув правой кноп­
кой по ее имени NewSwimlane и выбрав пункт Open Specification. 

4. Присвойте дорожке новое имя, удалив имя в поле Name и 
выбрав в списке поля Class значение "Регистратор" из модели 
Business Object (рис. 2.4). 

5. Создайте еще одну дорожку с именем "Профессор" из моде­
ли Business Use Case. 

iSwimlane Specification for УпМНаЩ 

Рис. 2.4. Спецификация "плавательной дорожки" 

Для того чтобы добавить в диафамму начальное (конечное) 
состояние: 

1. Выберите на панели инструментов кнопку Start (End) State. 



4 0 Глава 2 

2. Щелкните внутри диаграммы и внутри соответствующей 
дорожки. 

Для того чтобы добавить в диафамму новую деятельность: 
1. Выберите на панели инструментов кнопку Activity. 
2. Щелкните внутри диаграммы и внутри нужной дорожки, 

которая определяет действующее лицо или исполнителя, отвеча­
ющего за выполнение деятельности. 

3. Присвойте имя новой деятельности. 
Для того чтобы создать переход между деятельностями: 
1. Выберите на панели инструментов кнопку State Transition. 
2. Перетащите указатель мыщи с одной деятельности на дру­

гую. 
Для того чтобы добавить точку принятия решения: 
1. Выберите на панели инструментов кнопку Decision. 
2. Щелкните внутри диафаммы для вставки решения. 
3. Откройте окно спецификаций для решения и введите его 

имя (рис. 2.5). 
В Decision Specification for Все ароШсШШ! 
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Рис. 2.5. Спецификация решения 



Моделирование бизнес-процессов 41 

Н State Transition SpectficatioR 

^a^al.O^i^J 
щшм 

&MdTd[j£om(kiQn: . Нет 

^$^^$^Шф -^ г-^ 

с.,; V;'4 
;1а^Д4;:^^г„:>^^ж;^г 

профессора выбрали курсы? J4 

la: (Распределение курсое между просд 

^Ж. СагЫ I 
jimft я н * "-у ^ * 1 fi^Q'^.'^J '^Ш^ 

Рис. 2.6. Спецификация перехода 
4. Нарисуйте переход от деятельностей к решению или от ре­

шения к одной или нескольким деятельностям. 
Для того чтобы добавить фаничное условие: 
1. Щелкните правой кнопкой по переходу. 
2. Выберите Open Specification — откроется окно специфика­

ций для перехода. 
3. Перейдите на вкладку "Details" (рис. 2.6). 
4. Введите фаничное условие в поле Guard Condition (можно 

ввести фаничное условие непосредственно на стрелку перехода, 
заключив это условие в квадратные скобки). 

Для того чтобы добавить линейки синхронизации: 
1. Выберите на панели значок Vertical Synchronization или 

Horizontal Synchronization. 
2. Щелкните внутри диафаммы для вставки линейки синхро­

низации. 
3. Нарисуйте переходы между синхронизуемыми деятельнос-

тями. 



Глава 3 
СПЕЦИФИКАЦИЯ ТРЕБОВАНИЙ 
К ПРОГРАММНОМУ ОБЕСПЕЧЕНИЮ 

3 . 1 . ПОСТАНОВКА ЗАДАЧИ РАЗРАБОТКИ 
НОВОЙ СИСТЕМЫ РЕГИСТРАЦИИ 

Требования к ПО документируются в виде ряда документов и 
моделей. К основным документам относятся: 

• концепция — определяет глобальные цели проекта и основ­
ные особенности разрабатываемой системы. Существенной час­
тью концепции является постановка задачи разработки (подразд. 
3.1), определяющая требования к-выполняемым системой функ­
циям*; 

• словарь предметной области (глоссарий) - устанавливает 
общую терминологию для всех моделей и описаний требований к 
системе. Глоссарий (подразд. 3.2) предназначен для описания 
терминологии предметной области и может быть использован 
как словарь данных системы; 

• дополнительные спецификации (технические требования) -
содержат описание нефункциональных требований к системе, 
таких, как надежность, удобство использования, производитель­
ность, сопровождаемость и др. (подразд. 3.3). 

В целях ускорения и повышения эффективности процесса 
регистрации на курсы университета (см. подразд. 2.1) перед ру­
ководителем информационной службы университета ставится 
задача разработки новой клиент-серверной системы регистра­
ции студентов взамен старой системы на мейнфрейме. Новая си­
стема должна позволять студентам регистрироваться на курсы и 
просматривать свои табели успеваемости с персональных ком­
пьютеров, подключенных к локальной сети университета. Про­
фессора должны иметь доступ к онлайновой системе, чтобы ука-

Полный вариант концепции для системы регистрации, соответствую­
щий шаблону технологии Rational Unified Process, приведен в приложении 1. 
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зать курсы, которые они будут читать, и проставить оценки за 
курсы. 

Университет не в состоянии заменить сразу всю существую­
щую систему из-за недостатка средств. База данных, содержащая 
всю информацию о курсах (каталог курсов), остается функцио­
нировать в прежнем виде, она поддерживается реляционной 
СУБД. Новая система будет работать с существующей БД в режи­
ме доступа, без обновления. 

В начале каждого семестра студенты могут запросить каталог 
курсов, содержащий список курсов, предлагаемых для изучения в 
данном семестре. Информация о каждом курсе должна включать 
имя профессора, наименование кафедры и требования к предва­
рительному уровню подготовки (прослушанным курсам). 

Новая система должна позволять студентам выбирать четыре 
курса в предстоящем семестре. В дополнение каждый студент мо­
жет указать два альтернативных курса на тот случай, если какой-
либо из выбранных им курсов окажется уже заполненным или от­
мененным. На каждый курс могут записаться не более 10 и не ме­
нее 3 студентов (если менее 3, то курс будет отменен). В каждом 
семестре существует период времени, когда студенты могут изме­
нить свои планы. В это время студенты должны иметь доступ к 
системе, чтобы добавить или удалить выбранные курсы. После 
того как процесс регистрации некоторого студента завершен, си­
стема регистрации направляет информацию в расчетную систему, 
чтобы студент мог внести плату за семестр. Если курс окажется 
заполненным в процессе регистрации, студент должен быть изве­
щен об этом до того, как его личный учебный план будет оконча­
тельно сформирован. 

В конце семестра студенты должны иметь доступ к системе 
для просмотра своих электронных табелей успеваемости. По­
скольку эта информация конфиденциальная, система должна 
обеспечивать ее защиту от несанкционированного доступа. 

Профессора должны иметь доступ к онлайновой системе, 
чтобы указать курсы, которые они будут читать, и просмотреть 
список студентов, записавшихся на их курсы. Кроме этого, 
профессора должны иметь возможность проставить оценки за 
курсы. 
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3.2. СОСТАВЛЕНИЕ ГЛОССАРИЯ ПРОЕКТА 

Глоссарий предназначен для описания терминологии пред­
метной области. Он может быть использован как неформальный 
словарь данных системы. 

Ниже приведены термины проекта и их значения. 

Термин 

Курс 
Предлагаемый курс 

Каталог курсов 

Расчетная система 
Оценка 
Профессор 
Табель успеваемости 

Список курса 

Студент 
Учебный график 

Значение 

Учебный курс, предлагаемый университетом. 
Предлагаемое чтение данного курса в конкретном се­
местре (один и тот же курс может вестись в несколь­
ких параллельных сессиях). Включает конкретные 
дни недели и время. 
Полный каталог всех курсов, предлагаемых универ­
ситетом. 
Система обработки информации об оплате за курсы. 
Оценка, полученная студентом за конкретный курс. 
Преподаватель университета. 
Все оценки за все курсы, полученные студентом в 
данном семестре. 
Список всех студентов, записавшихся на предлагае­
мый курс. 
Личность, проходящая обучение в университете. 
Курсы, выбранные студентом в текущем семестре. 

3.3. ОПИСАНИЕ ДОПОЛНИТЕЛЬНЫХ 
СПЕЦИФИКАЦИЙ 

Назначение дополнительных спецификаций — определить 
требования к системе регистрации курсов, которые не охватыва­
ет модель вариантов использования. Вместе они образуют пол­
ный набор требований к системе. 

Дополнительные спецификации определяют нефункцио­
нальные требования к системе, такие, как удобство использова­
ния, надежность, производительность, а также ряд функциональ­
ных требований, являющихся общими для нескольких вариантов 
использования: безопасность, проектные ограничения. 
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Функциональные возможности 
Система должна обеспечивать многопользовательский режим 

работы. 
Удобство использования 
Пользовательский интерфейс должен быть Windows-coBMecTH-

мым. 
Пользовательский интерфейс системы должен быть простым и 

не требующим дополнительного обучения для пользователей, обла­
дающих компьютерной грамотностью. 

Каждая функция системы должна сопровождаться встроенной 
онлайновой помощью, которая должна включать пошаговые инст­
рукции по работе с системой, а также определения терминов и со­
кращений. 

Надежность 
Система должна быть^в работоспособном состоянии 24 ч в день 7 

дней в неделю, время простоя — не более 10%. Среднее время безот­
казной работы должно превышать 300 ч. 

Производительность 
Система должна поддерживать до 2000 пользователей, одновре­

менно работающих с центральной базой данных, и до 500 пользова­
телей, одновременно работающих с локальными серверами. 

Система должна обеспечивать доступ к унаследованной БД ката­
лога курсов со временем ожидания не более 10 с. 

Система должна быть способна завершать 80% всех транзакций в 
течение 2 мин. 

Безопасность 
Система не должна позволять студентам изменять любые учеб­

ные фафики, кроме своих собственных, а также позволять профес­
сорам модифицировать конкретные курсы, выбранные другими 
профессорами. 

Только профессора имеют право ставить оценки студентам. 
Только регистратор может изменять любую информацию о сту­

дентах. 
Проектные ограничения 
Система должна быть интегрирована с существующей системой 

каталога курсов, функционирующей на основе реляционной СУБД. 
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3.4. СОЗДАНИЕ НАЧАЛЬНОЙ ВЕРСИИ МОДЕЛИ 
ВАРИАНТОВ ИСПОЛЬЗОВАНИЯ 

Функциональные требования к системе моделируются и до­
кументируются с помощью вариантов использования (use case), 
которые трактуются следующим образом: 

• вариант использования фиксирует соглашение между участ­
никами проекта относительно поведения системы; 

• вариант использования описывает поведение системы при 
различных условиях, когда система отвечает на запрос одного из 
участников, называемого основным действующим лицом; 

• основное действующее лицо инициирует взаимодействие с 
системой, чтобы добиться некоторой цели. Система отвечает, со­
блюдая интересы всех участников. 

Варианты использования — это вид документации, применя­
емой, когда требуется сконцентрировать усилия на обсуждении 
принципиальных требований к разрабатываемой системе, а не на 
подробном описании их. Стиль их написания зависит от масшта­
ба, количества участников и критичности проекта. При описа­
нии вариантов использования (расположенных по степени повы­
шения точности) существуют четыре уровня точности: 

• действующие лица и цели (перечисляются действующие ли­
ца и все их цели, которые будет обеспечивать система); 

• краткое изложение варианта использования (в один абзац) 
или основной поток событий (без анализа возможных ошибок); 

• условия отказа (анализ мест возникновения возможных 
ошибок в основном потоке событий); 

• обработка отказа (написание альтернативных потоков 
событий). 

Спецификация требований в технологии Rational Unified 
Process не предполагает обязательного моделирования бизнес-
процессов организации, для которых создается ПО, однако нали­
чие бизнес-модели существенно упрощает построение систем­
ной модели вариантов использования. При переходе от бизнес-
модели к начальной версии модели вариантов использования 
выполняются следующие правила: 

• для каждого исполнителя в модели бизнес-анализа, кото­
рый в перспективе станет пользователем новой системы, в моде­
ли вариантов использования создается действующее лицо с та-
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КИМ же наименованием. В состав действующих лиц включаются 
также внешние системы, играющие в бизнес-процессах пассив­
ную роль источников информации; 

• варианты использования для данного действующего лица 
создаются на основе анализа обязанностей соответствующего ис­
полнителя (в простейшем случае для каждой операции исполни­
теля создается вариант использования, реализующий данную 
операцию в системе). 

Такая начальная версия модели описывает минимальный ва­
риант системы, пользователями которой являются только испол­
нители в бизнес-процессах. Если в дальнейшем в процессе разви­
тия системы ее непосредственными пользователями будут дейст­
вующие лица бизнес-процессов, то модель вариантов 
использования начнет модифицироваться. 

Применение данных правил для системы регистрации приво­
дит к появлению следующего списка действующих лиц для на­
чальной версии системы: 

• регистратор — формирует учебный план и каталог курсов, 
записывает студентов на курсы, ведет все данные о курсах, про­
фессорах, успеваемости и студентах; 

• расчетная система - получает информацию по оплате кур­
сов от данной системы. 

• каталог курсов - база данных, содержащая информацию о 
курсах. 

Упражнение 3.1. 
Создание действующих лиц в среде Rose 

Для того чтобы поместить действующее лицо в браузер: 
1. Щелкните правой кнопкой мыши по пакету Actors, входя­

щему в пакет Use Case Model представления вариантов использо­
вания в браузере. 

2. Выберите в открывшемся меню пункт New > Actor. 
3. В браузере появится новое действующее лицо под названи­

ем NewClass. Слева от его имени вы увидите пиктограмму дейст­
вующего лица UML. 

4. Выделив новое действующее лицо, введите его имя. 
Исходя из потребностей действующих лиц, выделяются сле­

дующие варианты использования: 
• Войти в систему. 
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Рис. 3.1. Начальная версия диаграммы вариантов использования 
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• Зарегистрироваться на курсы. 
• Просмотреть табель успеваемости. 
• Выбрать курсы для преподавания. 
• Проставить оценки. 
• Вести информацию о профессорах. 
• Вести информацию о студентах. 
• Закрыть регистрацию. 
Начальная версия диаграммы вариантов использования по­

казана на рис. 3.1. 

Упражнение 3.2. 
Создание вариантов использования в среде Rational Rose 
Для того чтобы поместить вариант использования в браузер: 
1̂. Щелкните правой кнопкой мыши по пакету Use Cases, вхо­

дящему в пакет Use Case Model представления вариантов исполь­
зования в браузере. 

2. Выберите в появившемся меню пункт New > Use Case. 
3. В браузере появится новый вариант использования под на­

званием NewUseCase. Слева от него будет видна пиктограмма ва­
рианта использования UML. 

4. Выделите новый вариант использования и введите его на­
звание. 

Создадим начальную диафамму вариантов использования 
для системы регистрации. Требуемые для этого действия подроб­
но перечислены ниже. Готовая диаграмма вариантов использова­
ния должна выглядеть, как на рис. 3.1. 

В среде Rose диафаммы вариантов использования создаются 
в представлении вариантов использования. Главная диафамма 
(Global View of Actors and Use Cases) предлагается no умолчанию. 
Затем для моделирования системы можно разработать столько 
дополнительных диафамм, сколько необходимо. 

Для создания новой диафаммы вариантов использования: 
1. Щелкните правой кнопкой мыши по пакету Use Case Model 

представления вариантов использования в браузере. 
2. Выберите из всплывающего меню пункт New > Use Case 

Diagram. 
3. Выделите новую диаграмму, введя ее имя. 
4. Щелкните дважды по названию новой диафаммы в браузе­

ре, чтобы открыть ее. 
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Упражнение 3.3. 
Построение начальной версии диаграммы вариантов использо­

вания 
Для того чтобы построить начальную версию диаграммы ва­

риантов использования: 
1. Откройте диаграмму вариантов использования Global View 

of Actors and Use Cases. 
2. Удалите с нее все элементы. 
3. Чтобы поместить действующее лицо или вариант использо­

вания на диафамму перетащите его мышью из браузера на диа­
грамму вариантов использования. 

4. Нарисуйте с помощью кнопки Unidirectional Association па­
нели инструментов ассоциации между действующими лицами и 
вариантами использования. 

3.5. МОДИФИКАЦИЯ МОДЕЛИ 
ВАРИАНТОВ ИСПОЛЬЗОВАНИЯ 

Согласно постановке задачи в состав пользователей системы 
следует ввести студентов и профессоров. При этом в описание 
действующих лиц и вариантов использования вносятся измене­
ния. Модифицированная версия диаграммы вариантов исполь­
зования показана на рис. 3.2. Поскольку вход в систему абсолют­
но одинаков для регистратора, студента и профессора, их поведе­
ние можно обобщить и ввести новое действующее лицо 
"Пользователь" (супертип) с общим вариантом использования 
"Войти в систему", подтипами которого являются Регистратор, 
Студент и Профессор. 

Действующие лица: 
• Студент — записывается на курсы и просматривает табель 

успеваемости. 
• Профессор — выбирает курсы для преподавания и ставит 

оценки. 
• Регистратор — формирует учебный план и каталог курсов, 

ведет все данные о курсах, профессорах и студентах. 
• Расчетная система — получает от данной системы информа­

цию по оплате за курсы. 
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• Каталог курсов — база данных, содержащая информацию о 
курсах. 

4<- Rational Rose ~ coursereo aoalysis.mti ~ [Use; Са«еШЩШШ-ШШ1шШ 
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Рис. 3.2. Модифицированная диаграмма вариантов использования 
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Варианты использования: 
• Войти в систему; 
• Зарегистрироваться на курсы; 
• Просмотреть табель успеваемости; 
• Выбрать курсы для преподавания; 
• Проставить оценки; 
• Вести информацию о профессорах; 
• Вести информацию о студентах; 
• Закрыть регистрацию. 

Упражнение 3.4. 
Добавление описаний к вариантам использования 
Для добавления описаний: 
1. Выделите в браузере вариант использования "Зарегистри­

роваться на курсы". 
2. Введите в окне документации следующее описание к этому 

варианту использования: "Этот вариант использования дает сту­
денту возможность зарегистрироваться на курсы в текущем семе­
стре". 

3. Создайте с помощью MS Word три текстовых файла с при­
веденными ниже описаниями вариантов использования: "Войти 
в систему", "Зарегистрироваться на курсы" и "Закрыть регистра­
цию"*. Имена файлов должны совпадать с наименованиями ва­
риантов использования. 

При определении вариантов использования нужно назначить 
каждому из них приоритет, определяющий порядок дальнейшей 
реализации их в проекте. 

Для того чтобы назначить варианту использования приори­
тет: 

1. Щелкните правой кнопкой мыши по варианту использова­
ния в браузере или на диаграмме вариантов использования. 

2. Выберите пункт Open Specification в открывшемся меню. 
3. Введите приоритет в поле Rank на вкладке General. 

* Описания остальных вариантов использования для системы регистра­
ции приведены в приложении 1. 
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Вариант использования 
"Войти в систему" 

Краткое описание: 
Данный вариант использования описывает вход пользователя в 

систему регистрации курсов. 
Основной поток событий: 
Данный вариант использования начинает выполняться, когда 

пользователь хочет войти в систему регистрации курсов. 
1. Система запрашивает имя пользователя и пароль. 
2. Пользователь вводит имя и пароль. 
3. Система подтверждает имя и пароль, после чего открывается 

доступ в систему. 
Альтернативные потоки: 
Неправильное имя/пароль: 
Если во время выполнения основного потока обнаружится, что 

пользователь ввел неправильное имя и/или пароль, система выводит 
сообщение об ошибке. Пользователь может вернуться к началу ос­
новного потока или отказаться от входа в систему, при этом выпол­
нение варианта использования завершается. 

Вариант использования 
"Зарегистрироваться на курсьГ' 

Краткое описание: 
Данный вариант использования позволяет студенту зарегистри­

роваться на предлагаемые курсы в текуш.ем семестре. Студент может 
изменить свой выбор (обновить или удалить курсы), если изменение 
выполняется в установленное время в начале семестра. Система ка­
талога курсов предоставляет список всех предлагаемых курсов теку­
щего семестра. 

Основной поток событий: 
Данный вариант использования начинает выполняться, когда 

студент хочет зарегистрироваться на конкретные курсы или изме­
нить свой график курсов. 

1. Система запрашивает требуемое действие (создать график, об­
новить график, удалить график). 

2. Когда студент указывает действие, выполняется один из под­
чиненных потоков (создать, обновить, удалить или принять график). 
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Создать график: 
1. Система выполняет поиск в каталоге курсов доступных пред­

лагаемых курсов и выводит их список. 
2. Система отображает пустой график для заполнения. 
3. Студент выбирает из списка четыре основных и два альтерна­

тивных курса для включения в график. 
4. Для каждого выбранного курса выполняется подчиненный по­

ток "Добавить курс в фафик". 
5. Система сохраняет график студента. 
Обновить график: 
1. Система выводит текущий график студента. 
2. Система выполняет поиск в каталоге курсов доступных пред­

лагаемых курсов и выводит их список. 
3. Студент может обновить свой выбор курсов, удаляя или добав­

ляя предлагаемые курсы. 
4. Для каждого выбранного курса выполняется подчиненный по­

ток "Добавить курс в график". 
5. Система сохраняет график студента. 

Удалить график: 
1. Система выводит текущий график студента. 
2. Система запрашивает у студента подтверждение удаления гра­

фика. 
3. Студент подтверждает удаление. 
4. Система удаляет график. Если график включает предлагаемые 

курсы, на которые записался студент, он должен быть удален из спи­
сков этих курсов. 

Добавить курс в график: 
Для каждого выбранного курса система проверяет факт выпол­

нения студентом предварительных требований (прохождение опре­
деленных курсов) и наличие приема на предлагаемый курс. Затем 
система добавляет студента в список выбранного курса. Курс отме­
чается в графике как "зарегистрированный". 

Альтернативные потоки: 
Сохранить график: 
Студент может сохранить график в любой момент, не фиксируя в 

нем выбранные курсы. В этом случае график сохраняется в системе, 
но система не добавляет студента в списки выбранных курсов. Кур­
сы отмечаются в графике как "выбранные". 
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Не выполнены предварительные требования или курс заполнен: 
Если во время выполнения подчиненного потока "Добавить курс 

в график" система обнаружит, что студент не выполнил необходимые 
предварительные требования или выбранный им курс заполнен, то 
выдается сообщение об ошибке. Студент может либо выбрать другой 
курс и продолжить выполнение варианта использования, либо отме­
нить операцию, после чего основной поток начнется сначала. 

График не найден: 
Если во время выполнения подчиненных потоков "Обновить 

график" или "Удалить график" система не может найти график сту­
дента, то выдается сообщение об ошибке. После того как студент 
подтвердит это сообщение, основной поток начнется сначала. 

Система каталога курсов недоступна: 
Если окажется, что установить связь с системой каталога курсов 

невозможно, то будет выдано сообщение об ошибке. После того как 
студент подтвердит это сообщение, вариант использования завер­
шится. 

Регистрация на курсы закончена: 
Если в самом начале выполнения варианта использования ока­

жется, что регистрация на текущий семестр закончена, будет выдано 
сообщение и вариант использования завершится. 

Предусловия: 
Перед началом выполнения данного варианта использования 

студент должен войти в систему. 

Вариант использования 
"Закрыть регистрацию*' 

Краткое описание: 
Данный вариант использования позволяет регистратору закры­

вать процесс регистрации. Предлагаемые курсы, на которые не запи­
салось достаточного количества студентов (менее трех), отменяются. 
В расчетную систему передается информация о каждом студенте по 
каждому предлагаемому курсу, чтобы студенты могли внести оплату 
за курсы. 

Основной поток событий: 
Данный вариант использования начинает выполняться, когда 

регистратор запрашивает прекращение регистрации. 
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1. Система подтверждает завершение процесса регистрации. 
2. Для каждого предлагаемого курса система проверяет, ведет ли 

его какой-либо профессор и записалось ли на него не менее трех сту­
дентов. Если эти условия выполняются, система окончательно фик­
сирует курс в каждом графике, который включает данный курс. 

3. Система закрывает все курсы, рассчитывает плату за обучение 
для каждого студента в текущем семестре и направляет информацию 
в систему оплаты счетов. Система оплаты счетов посылает студентам 
счета для оплаты с копией их окончательных графиков. 

Альтернативные потоки: 
Регистрация не завершена: 
Если при проверке завершения процесса регистрации выясняет­

ся, что регистрация еще выполняется, выдается сообщение и вари­
ант использования завершается. 

На курс записалось менее трех студентов: 
Если во время выполнения основного потока обнаруживается, 

что на некоторый курс записалось менее трех студентов, то этот курс 
отменяется и выполняется подчиненный поток "Отмена курса". 

Курс никто не ведет: 
Если во время выполнения основного потока обнаруживается, 

что некоторый курс не ведется никаким профессором, то этот курс 
отменяется и выполняется подчиненный поток "Отмена курса". 

Отмена курса: 
Система отменяет предлагаемый курс. Для каждого студента, за­

писавшегося на отмененный курс, система модифицирует его гра­
фик. Первый доступный альтернативный курс подставляется вместо 
отмененного курса. Если альтернативных курсов нет, то подстанов­
ки не происходит и управление передается в основной поток собы­
тий для обработки следующего предлагаемого курса. 

После обработки всех графиков текущего семестра система 
по электронной почте извещает студентов об изменениях в их 
графиках. 

Расчетная система недоступна: 
Если невозможно установить связь с расчетной системой, систе­

ма вновь попытается связаться с ней через некоторое установленное 
время. Попытки будут повторяться до тех пор, пока связь не устано­
вится. 

Предусловия: 
Перед началом выполнения данного варианта использования 

регистратор должен войти в систему. 
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3.6. СОЗДАНИЕ БАЗЫ ДАННЫХ ТРЕБОВАНИЙ 
REQUISITEPRO И РАБОТА С НЕЙ 

Прежде чем создавать типы требований, необходимо создать 
новый проект RequisitePro в соответствии с подразд. 1.2.2. 

Упражнение 3.5. 
Создание типов требований в проекте RequisitePro 
Перед описанием требований необходимо определить их ти­

пы: 
1. Выберите пункт меню File > Properties, появится диалого­

вое окно "Project Properties". Для добавления новых типов требо­
ваний активизируйте вкладку "Requirement Types" (рис. 3.3). 
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Рис. 3.3. Окно "Project Properties" 

2. Для добавления нового типа требований нужно щелкнуть 
по кнопке "Add...", а для редактирования существующего - по 
кнопке "Edit...". Затем заполните следующие поля в открывшем­
ся диалоге "Requirement Туре" (рис. 3.4): 
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• "Name" — название типа требования (обязательное поле). 
• "Description" — описание типа требования. 
• "Initial Requirement #" — уникальный номер, который будет 

присвоен первому требованию данного типа и станет увеличи­
ваться на единицу для всех последующих (обязательное поле). 

Requirement Туре 

Рис. 3.4. Окно "Requirement Туре" 

• "Allow External Traceability" - следует активировать, если тре­
бования этого типа будут связываться с требованиями из других 
проектов. 

• "Requirement Must Contain" — слово или простая фраза, со­
держащие не более 32 символов, которые обязательно должны 
входить в состав требований данного типа (RequisitePro будет вы­
водить предупреждающее сообщение, если при создании требо­
ваний данного типа это условие не будет выполнено). 

• "Requirement Tag Prefix" — префикс, который добавляется 
всем требованиям данного типа (обязательное поле). 

• "Requirement Color" и "Requirement Style" - характеристики 
форматирования требований данного типа, с помощью которых 
последние выделяются в документах Microsoft Word (выбрать из 
списка). 
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3. Щелкните по кнопке ОК и повторите действия для следую­
щего типа требований (рис. 3.5). 

Requirement Туре 
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Рис. 3.5. Новый тип требований 

Упражнение 3.6. 
Определение атрибутов требований 
Для созданных типов требований необходимо определить ат­

рибуты, которые позволяют ввести метрики для оценки требова­
ний с точки зрения пользователя. Примеры атрибутов приведены 
вподразд. 1.2.1. 

Некоторые атрибуты определяются только для служебных це­
лей и создаются автоматически при выполнении определенных 
операций. Например, атрибуты "Roseltemid", "RoseModePath" и 
"RoseType" создаются при выполнении интеграции некоторой 
модели Rose с проектом RequisitePro. 

Для добавления или изменения атрибутов нужно активизиро­
вать вкладку "Attributes" (рис. 3.6). 

В левом окне группы "Requirement Attributes" перечислены 
основные атрибуты типа требования, выбранного в "Requirement 
Туре". Если выделен один из этих атрибутов, то справа выводится 
дополнительная информация. 
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Proiecfc Properties 
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Активный элемент управления "Labels for Attributes" означает, 
что кнопки группы "Requirement Attributes" позволяют выполнять 
соответствующие операции над атрибутами списка (добавить ат­
рибут — кнопка "Add...", изменить свойства атрибута — кнопка 
"Edit...", удалить атрибут ~ "Delete", передвинуть атрибут в спис­
ке — соответственно кнопки "Move Up" и "Move Down"). Щелчок 
по кнопке "Add..." приводит к появлению диалогового окна "Add 
Attribute" (рис.3.7). 

Поля для заполнения: 
• "Label" — название атрибута. 
• "Туре" ~ тип атрибута (например, список значений, тексто­

вая строка, целочисленное поле, поле даты и т.д.). 
• "List Values" — список возможных значений атрибута (выво­

дится, если в "Туре" выбран список). 
• "Deafult Value" — значение атрибута, устанавливаемое по 

умолчанию для создаваемых требований (выводится, если в 
"Туре" указан какой-либо простой тип, например, строковый). 

• "Hidden from display" — флажок, установка которого позво­
ляет скрывать данный атрибут в представлениях Requisite Pro. 
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Add Attr ibute 
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Рис. 3.7. Добавление атрибута 

• "Change affect suspect" — флажок, установка которого окажет 
влияние на состояние трассируемых (по отношению к текущему) 
требований при изменении данного атрибута (в этом случае из­
менение атрибута приведет к установке всех трассируемых требо­
ваний в состояние "подозрительных", т.е. представление 
RequisitePro будет приравнивать изменение атрибута к измене­
нию самого требования). 

При создании нового типа требований RequisitePro по умол­
чанию создает для него начальный набор атрибутов, который 
можно взять за основу. 

В проекте системы регистрации на курсы удалим существую­
щие атрибуты для каждого созданного типа требований и созда­
дим следующие: 

• "Приоритет" (список значений; возможные значения: "Вы­
сокий", "Средний", "Низкий") — приоритет функционального 
требования или варианта использования; 
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• "Состояние" (список значений; возможные значения: 
"Предложено", "Одобрено", "Реализовано", "Протестировано") ~ 
состояние, в котором находится процесс реализации требования 
на данный момент; 

• "Сложность реализации" (список значений; возможные зна­
чения: "Высокая", "Средняя", "Низкая") — оценочная сложность 
реализации требования; 

• "Ответственный" (строка) — указывается фамилия ответст­
венного за реализацию требования. 

Упражнение 3.7. 
Создание типов документов 

Каждый документ RequisitePro должен иметь свой тип, кото­
рый определяет основное назначение этого документа (область 
использования в проекте). 

Для создания нового типа документов необходимо активизи­
ровать вкладку "Document Types" (рис. 3.8) и щелкнуть по кнопке 
"Add...". 
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Рис. 3.8. Типы документов 
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Откроется диалоговое окно "Document Туре" (рис. 3.9). Поля 
для заполнения: 

• "Name" — название типа документа (обязательное поле); 

Рис. 3.9. Окно "Document Туре": 
а ~ общий вид; б —для спецификации варианта использования 
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• "Description" - описание типа документа; 
• "File Extension" — расширение, с которым будут сохраняться 

файлы документов данного типа (обязательное поле); 
• "Default Requirement Type" — тип требования по умолчанию 

(обязательное поле); 
• "Outline" — указание на шаблон Microsoft Word, который 

будет использоваться при создании новых документов данного 
типа. 

Для проекта системы регистрации создадим два типа доку­
ментов: концепция (см. рис. 3.9) и спецификация варианта ис­
пользования (рис. 3.10). 

Упражнение 3.8. 
Связывание модели Rose и проекта RequisitePro 
Для использования модели Rose совместно с RequisitePro не­

обходимо, чтобы в Rose было активизировано соответствующее 
встроенное средство (Add-In). Для этого нужно выбрать пункт 
меню "Add-Iris/Add-In Manager...", что приведет к появлению ок­
на "Add-In Manager", и проконтролировать, чтобы пункт 
"RequisitePro" (рис. 3.10) был активен. 
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Рис. 3.10. Окно "Add-In Manager" 
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В результате появятся дополнительные пункты в главном и 
различных контекстных меню, позволяющие работать с 
RequisitePro из среды Rose. Затем нужно связать текущий файл 
модели Rose с проектом RequisitePro с помощью пункта меню 
"Tools/Rational Requisite Pro/Associate Model To Project". В от­
крывшемся окне "Associate Model To RequisitePro Project" следует 
указать проект RequisitePro, в который будут экспортированы ва­
рианты использования (рис. 3.11), а также типы требований и до­
кументов по умолчанию, с которыми будут автоматически связа­
ны экспортированные варианты использования. В дальнейшем 
указанные типы могут быть заменены на любые другие с помо­
щью этого окна. 

ф. Associate Model to RequisitePro l^r^i^fet;; 

Bojed: B&: 
urnNevvVPfOjectSCHcreMa регистрации нэ курсыЧСистема регистрации на курсы tqs 

DefaiJ^QCurr}emT>»pe: Default Д@дшегйеп^Т>^ес 

I Спецификация в>з{:1иант.эиспол{>зобания J jJ j В.з{:1иакгы использования ^ 

• В о ^ РФ Map: ••" - - " — 

РК 1 С^гЫ ( Ш(р I 

Рис. 3.11. Окно "Associate Model То RequisitePro Project" 

Щелчок по кнопке О К приведет к связыванию модели Rose и 
проекта RequisitePro. 

У п р а ж н е н и е 3.9. 
Экспорт вариантов использования из модели Rose в проект 

RequisitePro 

Рассмотрим экспорт вариантов использования на примере 
системы регистрации. Для экспорта варианта использования сле­
дует выбрать пункт его контекстного меню "Requirement 
Properties/New...". При этом появится форма добавления требова­
ний "Requirement Properties..." из RequisitePro (рис. 3.12). 
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Рис. 3.12. Форма добавления требований 

Данная форма позволяет установить значения атрибутов ва­
риантов использования (вкладка "Attributes", можно выполнить 
эту установку самостоятельно), создать связи с существующими 
требованиями любых типов (вкладка "Traceability") и сформиро­
вать иерархию вариантов использования (вкладка "Hierarchy"). 
Щелчок по кнопке ОК приведет к созданию требования типа 
"Варианты использования" в базе данных RequisitePro. 

Таким образом, можно экспортировать все остальные вариан­
ты использования в проект RequisitePro: 

• Войти в систему; 
• Просмотреть табель успеваемости; 
• Выбрать курсы для преподавания; 
• Проставить оценки; 
• Вести информацию о профессорах; 
• Вести информацию о студентах; 
• Закрыть регистрацию. 
Требования, созданные в RequisitePro, следует перенести в па­

кет, предназначенный для их хранения (создать новые пакеты 
"Документы", "Требования" и "Варианты использования" 
(рис. 3.13) с помощью контекстного меню проекта в Проводнике 
RequisitePro, используя пункты New > Package). 



Спецификация требований к программному обеспечению 67 

ARat iona l Requistl:ePro ~ С и с т е ! ^ ' р Ш с а д Ш Ш И ! ^ ^ 

Dl#lii-#i-OlMilll€l ЧЩЩ 
;. .Q l Документы 

й-Ш Требования 
В-Щ Варианты использований 

i ' 2 1 ^^^- Зарешстриробаться на курсы 
i ' Е 1 ^^^' Вести информацию о профессорах 
Ь'ШЁ ^^^'' Вести информацию о студентах 
i-'ffil ^^^'' Войти е систему 
! ' 'Е1 UC6: Выбрать курсы для преподавания 
; ' Е 1 ^^^' Закрыть регистрацию 
Ь'ЕМ ^^^'' просмотреть табель успеваемости 
?.><gg UC9: Проставить оиуемки 

Новый проект 

'Щт^. 

Рис. 3.13. Структура проекта после экспорта 
всех вариантов использования 

У п р а ж н е н и е 3.10. 
Создание представлений в проекте RequisitePro 

Представления (views) RequisitePro отображают в табличном 
или древовидном виде сами требования с их атрибутами или свя­
зи трассировки между требованиями различных типов. Можно 
создавать представления трех видов: 

• матрица атрибутов (Attribute Matrix). Она показывает все 
требования заданного типа с их атрибутами; 

• матрица трассировки (Traceability Matrix). Она показывает 
связи трассировки между требованиями двух типов; 

• дерево трассировки (Traceability Tree). Оно показывает це­
почки связей трассировки, направленные от требований задан­
ного типа или к ним. 
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С помощью представлений можно выполнить следующие 
действия: 

• создать и модифицировать наименование, текст и атрибуты 
требования, а также его связи трассировки; 

• упорядочить и отфильтровать информацию; 
• сохранить представление и вывести его на печать. 
Для создания матрицы атрибутов для вариантов использова­

ния создадим в Проводнике Requisite Pro пакет "Матрицы атрибу­
тов", выберем в его контекстном меню пункт New > View..., после 
чего появится окцо "View Properties". Зададим в окне значения, 
как показано на рис. 3.14. 

Iview Properties 

Шш^. 
^щшр^ют 

АиИщ 

DaHe: 

[Варианть! использования 

ji 

Attribute Matrix 
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, 

2ai1.2004. |,, Tin»: 
' ' " ' -y 

OK 1 C&tml 1 Н Ф 

m^^^ l̂ 
' Г ' * '. ' t 

^1 1 
мммиЛ 1 

iiiiiiS ifuiiM < i! 1 
WMIMMMMI ' > ' 1 

"3 JtebJ 

'|й18я . . 1 1 

тЛ 1 

Рис. 3.14. Окно "View Properties" 

После щелчка по кнопке ОК на экране появится окно матри­
цы атрибутов для вариантов использования (рис. 3.15). С помо­
щью контекстного меню для каждой клетки матрицы установите 
значения атрибутов требований, как показано на данном рисунке. 
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Упражнение 3.11. 
Добавление документов в проект RequisitePro 

Множество документов проекта может содержать самые раз­
нообразные требования к создаваемому продукту или к процессу 
создания этого продукта. Такие документы должны быть созданы 
или импортированы в проект RequisitePro. Далее в них будут со­
зданы необходимые требования. 

Создать документ в RequisitePro можно, импортировав готовый 
документ с помощью пункта меню "File > Import...". В появившемся 
окне "Import Wizard" (рис. 3.16) укажите в качестве источника 
Microsoft Word Document, в поле Name of the document to import ука­
жите (с помощью Browse) файл Зарегистрироваться на Kypcbi.doc, 
созданный в упражнении 3.4, затем щелкните по кнопке Next. 

Import Wizard 

Select а Зошсйс 

Ш [comma щшдШ v ^ ^ } or Uim ш Mictrndl Word doc^iett 

' Select «ЭШ» Ы Щ1К»Ш ̂ щМштЫ: 

I \Рго|ес1\Зарегистрнровзгься на к«^рсы. doc 8|СЙ»^Л,.. 

m> I 
Рис. 3.16. Окно "Import Wizard" 

В окне выбора содержимого укажите импорт Document only 
(рис. 3.17), затем щелкните по кнопке Next. 

В окне "Document Properties" введите описание документа 
(рис. 3.18) и щелкните по кнопке ОК. 

В сообщении Create Document появится запрос на перефор­
матирование документа в соответствии с определенным ранее 
для такого типа документов шаблоном RUP Use Case 
Specification, щелкните по кнопке Yes, чтобы сохранить текущее 
форматирование документа. 
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Рис. 3.18. Окно "Document Properties" 
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У п р а ж н е н и е 3.12. 
Создание иерархии требований в документе 

Заполнив новый документ, можно начать создавать требова­
ния в нем. Для этого нужно выделить необходимый фрагмент 
текста, который представляет очередное требование, и с помо­
щью главного или контекстного меню Word активировать пункт 
"New Requirement". 

В открывшемся диалоговом окне "Requirement Properties" 
указываются следующие данные: 

• на вкладке "General" — название требования (некоторое имя, 
которое позволит выделить данное требование среди других в ка­
ком-либо представлении RequisitePro) и его тип; 

• на вкладке "Attributes" -- конкретные значения атрибутов; 
• на вкладке "Traceability" — требования, с которыми должно 

быть связано данное требование; 
• на вкладке "Hierarchy" — родительское требование по отно­

шению к данному (для создания иерархии требований); 
• на вкладке "Discussions" - темы для обсуждения текущего 

требования между участниками проекта. 
Создадим требование для фрагмента текста с названием вари­

анта использования "Зарегистрироваться на курсы" (рис. 3.19). 
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Рис. 3.19. Окно "Requirement Properties" для требования 

"Зарегистрироваться на курсы" 
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Далее создадим требование для фрагмента текста с названием 
подчиненного потока событий "Создать фафик" (рис. 3.20). Ис­
пользуя вкладку "Hierarchy", выберем для него в качестве роди­
тельского требования "Зарегистрироваться на курсы" (рис. 3.21 
и 3.22). 
Requtrement Properties; UCpetidiiHiS 
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Рис. 3.20. Окно "Requirement Properties" для требования "Создать график" 
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general I Bsg^ion j Mrfeite^ | 1г«с«аШ^ Hl^mah^ j Di$cu$$bnsr 

OK С«яс^ 

Рис. 3.21. Вкладка "Hierarchy" 
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Parent Requirement Browser 

l ^ f * ^ * ^ * (FEAT! Фумкциомальн̂ е̂ требования j j 

I Зарегистриробаться ид курсы UCS Document ^ 

irtfriiiiniirtf m Miiiit iiirniiijiii.li iirT .f ^ 
UK 

Рис. 3.22. Выбор родительского требования 

Выполните те же самые действия для подчиненных потоков 
событий "Обновить график", "Удалить график", "Принять гра­
фик" и "Сохранить график". Кроме того, создайте требование для 
фрагмента текста "поиск в каталоге курсов" из подчиненного по­
тока "Создать график", выбрав для него в качестве родительского 
требования "Создать график". 

В результате импортированный документ примет вид, пока­
занный на рис. 3.23. Выберите в меню пункт RequisitePro > 
Document > Save, обратите внимание, что метки "pending" исчез­
ли. После сохранения документа требования будут перенесены в 
базу данных проекта и появятся в окне Проводника. Выберите в 
меню пункт RequisitePro > Document > Close. 

Создадим в окне Проводника RequisitePro новый пакет 
"Функциональные требования" и перенесем туда вновь создан­
ные требования. Создадим новую матрицу атрибутов для функ­
циональных требований. После ее открытия интерфейс 
RequisitePro должен принять вид, показанный на рис. 3.24. 
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1.1 Краткое описание 
Данный в^иант использованил позволяет студенту зарегистрироваться на 
конкретные кз^сы в текущем семестре. Студент может изменить свой выбор 
(обновить или удалить курсы), если изменение выполняется в установленное время 
в начале семестра. Система каталога курсов предоставляет список всех конкрегнык 
курсов текущего семестра. 

1.2 Поток событий 

1.2.1 Основной поток 
Данный вариант использования начинает выполняться, когда студент хочет 
зарегистрироваться на конкретные курсы или изменить свой график курсов, 
1. Система запрашивает требуемое действие (создать график, обновить п^афик, 

удалить график), 
2. Когда студент указывает действие, выполняется один из подчиненных потоков. 

1.2.1,1 y^EATpendinci4.Dend{nq6 Qq^nqT^. rp^iAi(} 
1. Система выполняет5^ЕАТреп41!>.й4 t>en<iina$,t>ettdiii.ftl 1 поис»; в у:ахалоге курсор 

]доступнык конкретных ку{>сов и выводит их список, 

2 Студент выбирает из списка 4 ос^новных курса и 2 альтернативных курса Щ 

i<ti(>,'i ' ''j*9*ai <-щ— jH91й^ ct t7^к^ Щ Щ^ Щ рт ^ ^ ^ fWT 

Рис. 3,23. Вид документа после создания требований 

Упражнение 3.13. 
Связывание вариантов использования Rose с документами 

RequisitePro 

После экспорта вариантов использования из Rose в 
RequisitePro можно связать каждый из них со своим документом 
(спецификацией варианта использования), предварительно им­
портированным в проект RequisitePro. Выполним такое связыва­
ние для варианта использования "Зарегистрироваться на курсы" 
(рис. 3.25). Для этого в его контекстном меню нужно выбрать 
пункт Use Case Document > Associate. 

В появившемся окне "Associate Document to Use Case" 
(рис. 3.26) выберите из списка нужный документ из ранее импор-
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Рис. 3.24. Матрица атрибутов для функциональных требований 
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Рис. 3.25. Связывание варианта использования с документом 
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Рис. 3.26. Окно "Associate Document to Use Case" 

тированных документов (в данном случае в списке присутствует 
только один документ). 

В результате Requisite Pro загрузит в окне "Microsoft Word" 
нужный документ (рис. 3.27), а в браузере Rational Rose под вари­
антом использования "Зарегистрироваться на курсы" появится 
ссылка на этот документ, с помощью которой его впоследствии 
можно будет загружать. 

Упражнение 3.14. 
Импорт документов и требований в проект RequisitePro 
Требования могут быть созданы автоматически путем импор­

та данных из внешнего источника или из других документов, хра­
нящихся в других проектах. 

Создадим новые нефункциональные требования в проекте 
путем импорта данных из документа "Дополнительные специфи­
кации". Предварительно следует создать в проекте новый тип до­
кумента с названием "Дополнительные спецификации" и новый 
тип требований с названием "Нефункциональные требования". 
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Рис. 3.27. Спецификация варианта использования после связывания I со 
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Импортируйте готовый документ аналогично упражнению 
3.11 с помощью пункта меню "File > Import...". В окне "Import 
Wizard" укажите в качестве источника Microsoft Word Document, в 
поле Name of the document to import укажите файл Дополнитель­
ные спецификации.doc, который должен быть создан с использо­
ванием описания в подразд. 3.3, затем щелкните по кнопке Next. 
В окне выбора содержимого укажите импорт Requirements and 
document, затем щелкните по кнопке Next (рис. 3.28). 

1 Import Wizard 

Is 1 
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Ш щ ^ Ш 

ЙФ 1 . 

''ШЖ:"ШШшШ№Ш^^^^^^^^^ 
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Щ0ЩШУхр. 

only or Ihe <loa«nenl &nd Ш requirements сопЫпес! Ы^ш> 

^ . ., 

> С Доош*ег*ш# 

.1. li^m йм.д тштштж^* 

1 ' 

% 1 

J 

] 

1-1 l4-«iiiHi<iirtill 1 

Рис. 3.28. Окно выбора содержимого 

В окне "Document Properties" введите описание документа 
(рис. 3.29) и щелкните по кнопке ОК. 

В новом окне "Import Wizard" (рис. 3.30) в списке Requirement 
Туре выберите "Нефункциональные требования", активируйте 
опции Keyword(s) и Sentence, в поле Keyword укажите "должна", 
затем щелкните по кнопке "Add...", укажите "должен", еще раз 
щелкните по кнопкам "Add..." и Next. 

Таким образом формируется указание для анализатора им­
порта по распознаванию требований в импортируемом докумен­
те (каждое требование сопровождается ключевым словом "долж­
на" или "должен"). В результате RequisitePro выполнит поиск в 
документе и создаст требования в соответствии с указанными 
критериями. Каждое требование появляется отдельно в окне 
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Рис. 3.30. Формирование условия для распознавания требований 
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(рис. 3.31), для его принятия щелкните по кнопке Yes (или по 
кнопке Yes to All для принятия всех требований полностью). 
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The mqumtmru proposed mWEC b^. ш11гШ: 
^ :^ r^7 

тмт т1)лтшшпжш01йщшт 

'Cncr^via должна смЗасоечйвагь мндгш>/ьза0агети(5кий. 
ражийршбты '-, .,^ "-^. --'^ 

'Л| 
: been'deteeted ш ^ртШг хщмт^^' 

\ ты^ to create Ш^м ы 

$т 

Рис. 3.31. Окно принятия требования 
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Рис. 3.32. Сохранение требований в базе данных проекта 
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В последнем окне "Import Wizard" (рис. 3.32) щелкните по 
кнопке Commit для сохранения требований в базе данных про­
екта. 

Просмотрите документ "Дополнительные спецификации" на 
предмет выявления ошибочно помеченных или пропущенных 
требований и закройте его. 

Создайте новый пакет "Нефункциональные требования" и со­
ответствующую матрицу атрибутов, перенесите вновь созданные 
требования в этот пакет (рис. 3.33). 

Попробуйте самостоятельно извлечь функциональные требо­
вания из документа "Концепция". 
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Рис. 3.33. Вновь созданные нефункциональные требования 
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Упражнение 3.15. 
Создание новых требований в базе данных проекта 
Требования могут не только импортироваться из внешнего 

источника или создаваться в документе, но и непосредственно 
помещаться в базу данных. 

Выберите матрицу атрибутов "Нефункциональные требова­
ния" и нажмите строку создания нового требования с надписью 
"Click here to create a requirement". В открывшемся окне введите 
наименование требования "Система должна быть написана на 
языке Java". 

Щелкните левой кнопкой мыши вне поля текста. Требование 
будет введено в базу данных проекта. 

Добавьте еще несколько требований по своему усмотрению. 
Выберите одно из вновь созданных требований и отредактируйте 
его атрибуты. 

Упражнение 3.16. 
Т]рассировка требований 

Трассировка требований определяет логическую связь между 
двумя различными требованиями. При добавлении нового требо­
вания необходимо оценить, изменение каких требований может 
привести к изменению добавляемого (или, говоря иначе, какие 
другие требования должны быть проверены на предмет возмож­
ных изменений). Если такие требования выявлены, нужно уста­
новить трассировку по отношению к ним со стороны текущего. 

Матрица трассировки (Traceability Matrix) позволяет устанав­
ливать такую трассировку, а также диагностировать, какие требо­
вания могут измениться. При создании подобного представления 
необходимо указать типы требований, между требованиями ко­
торых установлена трассировка (рис. 3.34). Можно трассировать 
не только требования одного или разных типов, но и требования, 
расположенные в разных проектах RequisitePro. Для этого в свой­
ствах данного типа требований должен быть установлен пере­
ключатель "Allow External Traceability". 

После создания и открытия матрица трассировки примет вид, 
показанный на рис. 3.35. 

Выберите пустую ячейку матрицы (рис. 3.36), щелкните пра­
вой кнопкой мыши и в появившемся контекстном меню выбери-
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Рис. 3.34. Свойства матрицы трассировки 

те Trace То. При этом установится связь трассировки между ука­
занными требованиями, с помощью которой можно определить, 
какие функциональные требования необходимо просмотреть на 
предмет возможных изменений, если изменились любые вариан­
ты использования. 

Теперь изменим в модели Rose наименование варианта ис­
пользования "Зарегистрироваться на курсы" на "Записаться на 
курсы". Для синхронизации с вариантом использования в 
RequisitePro выберем в модели Rose пункт контекстного меню из­
мененного варианта использования Requirement Properties > 
Open... (рис. 3.37). 

После подтверждения в открывшемся окне "Requirement 
Properties" в проекте RequisitePro требование "Зарегистрировать­
ся на курсы" из группы "Варианты использования" будет также 
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Рис. 3.37. Изменение наименования варианта использования 

изменено (рис. 3.38). Связь в матрице трассировки будет помече­
на красной чертой как "подозрительная" (suspect). 

Перечеркнутый значок трассировки показывает, что необхо­
димо просмотреть функциональное требование "Зарегистриро­
ваться на курсы" и все его дочерние требования. Очевидно, что 
после изменения названия варианта использования нужно как 
минимум изменить формулировку родительского требования на 
"Записаться на курсы". 

После внесения изменений в функциональные требования 
нужно вручную убрать значок перечеркивания, выбрав пункт 
контекстного меню Clear Suspect на перечеркнутом поле. Каждая 
"подозрительная" связь должна быть проверена, затем признак 
"подозрительности" снимается вручную. 
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Упражнение 3.17. 
Выполнение запросов (фильтрация и упорядочение требований) 

После создания представления (матрицы атрибутов) можно 
выполнять любые запросы к базе данных требований, выбирая и 
упорядочивая требования по заданным критериям. Например, 
показать только те варианты использования, которые имеют вы­
сокий приоритет и среднюю сложность реализации. 

Для создания запроса откройте матрицу атрибутов вариантов 
использования, затем выберите в меню пункт View > Query Row 
Requirements. В результате откроется окно "Select Attribute" 
(рис. 3.39). 

SeJect Attribute 

fuc .'Варианты использования 

^^ rWe to Filter/^orl Requirements: 

Прнорш&т 
Соспгояние 
Сложность реализации 
Отеетстаенный 
RoseltemlO 
RoseModelPath 
RoseType 
Unique 10 
Location 

OK Cmy::^B\ МФ I 

Рис. 3.39. Окно "Select Attribute" 

Выберите атрибут "Приоритет" и щелкните по кнопке ОК. 
Появится окно "Query Requirements". Щелкните по кнопке None 
для очистки значений атрибута, затем выберите значение "Высо­
кий" (рис. 3.40) и щелкните по кнопке ОК. 

В окне "Query Row Requirements" появится критерий запроса. 
Щелкните по кнопке "Add..." и задайте аналогичным образом 
фильтр для атрибута "Сложность реализации", указав значение 
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Query Requirements 
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Рис. 3.40. Окно "Query Requirements" 

"Средняя" (рис. 3.41). Щелкните по кнопке ОК для выполнения 
запроса. 
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i 

Рш»г)> Штш 
иСПРИОРИТЕТ in [Высокий] 
иС.СЛОЖНОСТЬ РЕАЛИЗАЦИИ т Средняя 

*" Шт НщтФк^ Displ^ Q^ 1 

^^^fft^^*'-^;^ .' 
SofI; 
ooCendirtQ 

' ; a^cendtna ш 

Cancel j HefLt j 

^ M 

L'SCZJ^ 

Mo<%... 

Ие«шу« 

Nfo\̂ jy[p 

M3v-DG<-n 

i 1 

1 

Рис. 3.41. Окно "Query Row Requirements" 

В результате матрица атрибутов примет вид, показанный на 
рис. 3.42. Для того чтобы вернуть ее в исходное состояние, следу­
ет выбрать в меню пункт View > Refresh. 
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Рис. 3.42. Результат выполнения запроса со 



Глава 4 

АНАЛИЗ ТРЕБОВАНИЙ 
К ПРОГРАММНОМУ ОБЕСПЕЧЕНИЮ 

4.1. АРХИТЕКТУРНЫЙ АНАЛИЗ 
Целью объектно-ориентированного анализа является транс­

формация функциональных требований к ПО в предваритель­
ный системный проект и создание стабильной основы архитекту­
ры системы. В процессе проектирований системный проект "по­
гружается" в среду реализации с учетом всех нефункциональных 
требований. 

Объектно-ориентированный анализ включает два вида дея­
тельности — архитектурный анализ и анализ вариантов использо­
вания. 

Архитектурный анализ выполняется архитектором системы и 
включает: 

• утверждение общих стандартов (соглашений) моделирова­
ния и документирования системы; 

• предварительное выявление архитектурных механизмов 
(механизмов анализа); 

• формирование набора основных абстракций предметной 
области (классов анализа); 

• формирование начального представления архитектурных 
уровней. 

Соглашения моделирования определяют: 
• используемые диафаммы и элементы модели; 
• правила их применения; 
• соглашения по именованию элементов модели; 
• организацию модели (пакеты). 
Пример набора соглашений моделирования: 
• имена вариантов использования должны быть короткими 

глагольными фразами; 
• имена классов должны быть существительными, соответст­

вующими по возможности понятиям предметной области; 
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• имена классов должны писаться с прописной буквы; 
• имена атрибутов и операций должны писаться со строчной 

буквы; 
• составные имена должны быть сплошными, без подчерки­

ваний, каждое отдельное слово должно писаться с прописной 
буквы; 

• все классы и диаграммы, описывающие предварительный 
системный проект, помещаются в пакет с именем Analysis 
Model; 

• диаграммы классов, реализующих вариант использования, 
и диаграммы взаимодействия, отражающие взаимодействие объ­
ектов в процессе реализации сценариев варианта использования, 
помещаются в кооперацию с именем данного варианта использо­
вания и стереотипом <<use case realization>>. Все кооперации по­
мещаются в пакет с именем Use Case Realizations. Связь между 
вариантом использования и его реализацией изображается на 
специальной диаграмме трассировки (рис. 4.1). 

1 ф Rational Rose - €:оиг»егед_аг1а1уШШШ1 
Щ ВЪ^ £Л:. ^w Pgtm^ i ' ^ ^ i ' . 8W»*, 

ШВВИ^^^^^ЯВВШ! 

1 «realizes» 

1 / N 
1 X / 
1 «usecase realization» 
1 Login 
1 |[from Use*Casa Realization«login J 

1 ^ 1 . . , : , . , . : , , , , . . , , , . „ , . , . : , , ; , ; , : J 
ftWfi.mhi 

ишшт 1 

<z:)\ 
Войти В систему 

(from Use Case Model) 1 

vj j 
• 11Я 

Рис. 4.1. Фрагмент диаграммы трассировки 

Идентификация основных абстракций заключается в предвари­
тельном определении набора классов системы (классов анализа) 
на основе описания предметной области и спецификации требо­
ваний к системе (в частности, глоссария). Способы идентифика-
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ции основных абстракций аналогичны способам идентификации 
сущностей в модели "сущность-связь". Основной (неформаль­
ный) способ идентификации сущностей - это поиск абстракций, 
описывающих физические или материальные объекты, процессы 
и события, роли людей, организации и другие понятия. Единст­
венным формальным способом идентификации сущностей явля­
ется анализ текстовых описаний предметной области, выделение 
из описаний имен существительных и выбор их в качестве "кан­
дидатов" на роль абстракций. Каждая сущность должна иметь на­
именование, выраженное существительным в единственном чис­
ле. Следуя этим рекомендациям, определим для системы регист­
рации пять классов анализа (рис. 4.2.): 

• Student (Студент); 
• Professor (Профессор); 
• Schedule (Учебный график); 
• Course (Курс); 
• CourseOffering (Предлагаемый курс). 

ф Rational Rose -^ tm^ts^^^^^^^^^m 

Tools;' '&ja-Iffe 'Ifmfewl'.tlMp'" '. '-''/iV: -".t,'"'лШ^й 

Student Professor 

Schedule 

CourseOffering Course 

Рис. 4.2. Классы анализа системьг регистрации 
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Упражне н ие 4.1. 
Создание структуры модели и классов анализа в соответствии 

с требованиями архитектурного анализа 

Для того чтобы создать пакеты и диаграммы трассировки: 
1. Щелкните правой кнопкой мыши по пакету Use Case 

Realizations, входящему в пакет Design Model логического пред­
ставления браузера. 

2. Выберите пункт New > Package в открывшемся меню. 
3. Создайте пакет с наименованием Use Case Realization — 

Register for Courses, затем таким же образом пакеты Use Case 
Realization - Close Registration и Use Case Realization - Login. 

4. Создайте в каждом из пакетов типа Use Case Realization со­
ответствующие кооперации Register for Courses, Close Registration 
и Login (каждая кооперация создается как вариант использова­
ния со стереотипом <<use case realization>>, который задается в 
окне спецификации варианта использования путем выбора нуж­
ного стереотипа из списка стереотипов). 

5. Создайте в каждом из пакетов типа Use Case Realization но­
вую диаграмму вариантов использования с названием Realize 
Dependency и постройте ее в соответствии с рис. 4.1, подставляя 
соответствующие кооперации и варианты использования. 

Для того чтобы создать классы анализа и соответствующую 
диаграмму Key Abstractions: 

1. Щелкните правой кнопкой мыши по пакету Analysis Model 
логического представления браузера. 

2. Выберите пункт New > Class в открывшемся меню. Новый 
класс под названием NewClass появится в браузере. 

3. Выделите его и введите имя Student. 
4. Создайте аналогичным образом классы Professor, Schedule, 

Course и CourseOffering. 
5. Щелкните правой кнопкой мыши по пакету Analysis Model. 
6. Выберите пункт New > Class Diagram в открывшемся меню. 
7. Назовите новую диаграмму классов Key Abstractions. 
8. Откройте диаграмму классов и перетащите классы на от­

крытую диаграмму мышью, для того чтобы расположить вновь 
созданные классы. Диафамма классов должна выглядеть, как по­
казано на рис. 4.2. 

Архитектурные уровни образуют иерархию уровней представ­
ления системы. В практике разработки клиент-серверных систем 
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существует ряд типовых решений — архитектурных образцов, 
среди которых наиболее распространен образец "Уровни" 
(Layers). В соответствии с ним базовый вариант системы включа­
ет следующие уровни (сверху вниз): 

• прикладной - набор компонентов, реализующих основную 
функциональность системы, отраженную в вариантах использо­
вания; 

• бизнес-уровень — набор компонентов, специфичных для 
конкретной предметной области; 

• промежуточный ~ различные платформо-независимые сер­
висы (библиотеки пользовательского интерфейса, брокеры за­
просов и др.); 

• системный - ПО для вычислительной и сетевой инфраст­
руктур (ОС, сетевые протоколы и др.). 

Архитектурные уровни представляются в модели в виде паке­
тов со стереотипом <<1ауег>>. В рамках архитектурного анализа 
определяется начальная структура модели и рассматриваются 
только верхние уровни (прикладной и бизнес-уровень). 

Для моделирования архитектурных уровней создайте в пакете 
Design Model два пакета с наименованиями "Application" и 
"Business Services" 

4.2. АНАЛИЗ ВАРИАНТОВ ИСПОЛЬЗОВАНИЯ 

Анализ вариантов использования включает: 
• идентификацию классов, участвующих в реализации пото­

ков событий варианта использования; 
• распределение поведения, реализуемого вариантом исполь­

зования, между классами (определение обязанностей классов); 
• определение атрибутов и ассоциаций классов; 
• унификацию классов анализа. 

4 . 2 . 1 . ИДЕНТИФИКАЦИЯ iOIACCOB 

В потоках событий варианта использования выявляются 
классы трех типов: 

1. Граничные классы (Boundary) — посредники при взаимодей­
ствии внешних объектов с системой. Как правило, для каждой 
пары "действующее лицо — вариант использования" определяет­
ся один граничный класс. Типы фаничных классов: пользова-
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тельский интерфейс (обмен информацией с пользователем без 
деталей интерфейса ~ кнопок, списков, окон), системный интер­
фейс и аппаратный интерфейс (используемые протоколы без де­
талей их реализации). 

2. Классы-сущности (Entity) — ключевые абстракции (поня­
тия) разрабатываемой системы. Источники выявления классов-
сущностей: ключевые абстракции, созданные в процессе архи­
тектурного анализа, глоссарий, описание потоков событий вари­
антов использования. 

3. Управляющие классы (Control) — обеспечивают координа­
цию поведения объектов в системе. Могут отсутствовать в неко­
торых вариантах использования, офаничивающихся простыми 
манипуляциями с хранимыми данными. Как правило, для каж­
дого варианта использования определяется один управляющий 
класс. Примеры управляющих классов: менеджер транзакций, 
координатор ресурсов, обработчик ошибок. 

Классы анализа отражают функциональные требования к си­
стеме и моделируют объекты предметной области. Совокупность 
классов анализа представляет собой начальную концептуальную 
модель системы.Пример набора классов, участвующих в реализа­
ции варианта использования "Зарегистрироваться на курсы", 
приведен на рис. 4.3. 

Упражнение 4.2. 
Создание классов, участвующих в реализации варианта исполь­

зования "Зарегистрироваться на курсы", и диаграммы классов 

Для выполнения упражнения: 
1. Щелкните правой кнопкой мыши по пакету Analysis Model. 
2. Выберите пункт New > Class в открывшемся меню. Новый 

класс под названием NewClass появится в браузере. 
3. Вьщелите его и введите имя RegisterForCoursesForm. 
4. Щелкните правой кнопкой мыши по классу 

RegisterForCoursesForm. 
5. Выберите пункт Open Specification в открывшемся меню. 
6. Выберите стереотип <<Boundary>> в поле стереотипа и 

щелкните по кнопке ОК. 
7. Создайте аналогичным образом классы Course Catalog 

System со стереотипом «Boundary>> и RegistrationController со 
стереотипом Control. 
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Рис. 4.3. Классы, участвующие в реализации варианта использования 

8. Назначьте классам Schedule, CourseOffering и Student сте­
реотип Entity. 

9. Щелкните правой кнопкой мыши по кооперации Register 
for Courses в пакете Use Case Realization - Register for Courses. 

10. Выберите пункт New > Class Diagram в открывшемся меню. 
11. Назовите новую диаграмму классов Register for Courses -

Participating Classes. 
12. Откройте ее и перетащите классы на открытую диаграмму 

в соответствии с рис. 4.3. 

4.2.2. РАСПРЕДЕЛЕНИЕ ОБЯЗАННОСТЕЙ 
МЕЖДУ КЛАССАМИ 

Исходя из назначения трех выделенных типов классов, можно 
кратко охарактеризовать распределение обязанностей между ними: 

• граничные классы отвечают за взаимодействие с внешней 
средой системы (действующими лицами); 
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• классы-сущности отвечают за хранение данных и манипу­
лирование ими; 

• управляющие классы координируют потоки событий вари­
анта использования. 

Более детальное распределение обязанностей (в виде опера­
ций классов) выполняется с помощью диафамм взаимодействия 
(диафамм последовательности и кооперативных диафамм). В 
первую очередь строится диафамма (одна или больше), описыва­
ющая основной поток событий и его подчиненные потоки. Для 
каждого альтернативного потока событий строится отдельная ди­
афамма. Примеры: 

• обработка ошибок; 
• контроль времени выполнения; 
• обработка неправильных вводимых данных. 
Нецелесообразно описывать тривиальные потоки событий 

(например, в потоке участвует только один объект). 

Упражнение 4.3. 
Создание диаграмм взаимодействия 
Создадим диафаммы последовательности и кооперативные 

диафаммы для основного потока событий варианта использова­
ния "Зарегистрироваться на курсы". Готовые диафаммы последо­
вательности должны иметь вид, показанный на рис. 4.4. 

Настройка: 
1. Выберите пункт Tools > Options в меню модели. 
2. Перейдите на вкладку диафамм. 
3. Контрольные переключатели Sequence Numbering, 

Collaboration Numbering должны быть помечены, а Focus of 
Control - нет. 

4. Щелкните по кнопке ОК, чтобы выйти из окна параметров. 
Создание диаграммы последовательности: 
1. Щелкните правой кнопкой мыши по кооперации Register 

for Courses в пакете Use-Case Realization ~ Register for Courses. 
2. Выберите пункт New > Sequence Diagram в открывшемся 

меню. 
3. Назовите новую диафамму Register for Courses — Basic Flow. 
4. Щелкните по ней дважды, чтобы открыть ее. 
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%' Rational Rose - coursereg^analysts^ndl - [Sequent 01арШ*?|1Й|| | |^^^^^Ш11| 

^.v:vj mm ЯЩё^тт^Ш^^^^ч 
: RegisterForCoursesForm : RegistratlonContfoiler 

: Студент 
, 1: / / register for courses() 
I ^ 

{registration open} 
3: // display possible operations() 

; 4: // create schecluie() 
I y^^ ^ 

One of these 
is executed: 

- J 5 .̂̂  

i 5:V/ updale sciieduie() 
! '>: ^--rr: >i 

; 6: // delete $chedule() 

I: // is registration bpen?() < 

"tb, 

u 
ъ, 

Ш 

j ^ ^ 
Sgqogfipe От^щгп' Register^ 
fpr СРМГ^?^ / R?giM?r fpf 

Рис. 4.4. Диаграмма последовательности Register for Courses — Basic Flow 

Добавление на диаграмму действующего лица, объектов и сооб­
щений: 

1. Перетащите действующее лицо "Студент" из браузера на 
диафамму. 
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2. Перетащите классы RegisterForCoursesForm и Registration-
Controller из браузера на диаграмму. Можно переместить объект 
из верхней части диаграммы в точку его создания. Для того чтобы 
расположить объект между двумя существующими объектами, 
достаточно щелкнуть мышью между ними. 

3. Щелкните по кнопке Object Message на панели инстру­
ментов. 

4. Проведите мышью от линии жизни действующего лица 
"Студент" к линии жизни объекта RegisterForCoursesForm. 

5. Выделите сообщение и введите его имя: / / register for courses. 
6. Повторите действия п. 3—5, чтобы поместить на диафамму 

остальные сообщения, как показано на рис. 4.4 (для рефлексив­
ного сообщения 3 используется кнопка Message to Self). 

Соотнесение сообщений с операциями: 
1. Щелкните правой кнопкой мыши по тексту сообщения 1, 

/ / register for courses. 
2. Выберите пункт new operation в открывшемся меню. По­

явится окно спецификации операции. 
3. Оставьте имя сообщения - / / register for courses в поле 

имени. 
4. Щелкните по кнопке ОК, чтобы закрыть окно специфика­

ции операции и вернуться на диаграмму. 
5. Повторяйте действия п. 1—4, пока не соотнесете с операци­

ями все остальные сообщения. 
Выполните аналогичные действия для создания диаграмм по­

следовательности, показанных на рис. 4.5 — 4.8. Обратите внима­
ние, что на диаграмме рис. 4.8 изображен объект нового класса 
PrimarySheduleOflFeringlnfo (ассоциации-класса, описывающего 
связь между классами Shedule и Offeringlnfo), который нужно 
предварительно создать. 

Для того чтобы добавить на диаграмму примечание: 
1. Щелкните на панели инструментов по кнопке Note. 
2. Щелкните мышью по тому месту диаграммы, куда собира­

етесь поместить примечание. 
3. Выделите новое примечание и введите туда текст. 
4. Щелкните по кнопке Anchor Notes То Item на панели инст­

рументов, для того чтобы прикрепить примечание к элементу 
диаграммы. 



7: // seted 4 iwiinsiy Mid 2 elt^rnate offiertessC) 
i >, 

8: // create cdtedtiie wMi «fTeringeC) 

At this, рЫа1 the Submit Scheduie suhflow It executed. 
Сфцп»? / Щ9ЧШ1 fof ^mn -

Рис. 4.5. Диафамма последовательности Register for Courses — Basic Flow (Create Schedule) 



^ 
: студент : l^agisferForCourMsFonnl ; CourseCatalogSystem 

|1 : // update scheduieOj 

: RegistrationControiier 

Student wishes ^ 2: // get ojrrant schedule(Stu<ient, for^emestef) 
to update an 
exieSne 
schedule 

3: /f get schedufefforSemestei) 

Existing schadi^e is C^'"' 
displayed 

4: // display |Echeduie|Schedule) 

IS: // get course offeringsC); 
J ^ 

A Itsi of the available 1^ 
course offering for 
[tftis semester are 
displayed 

6: // gfct course offerings^orSenfestei) 

7: / /di^lay (»urse offerlngs() 
I< 1 

8: // Update offering selecti«CRS() 

;— , ^ 
9: // update sdteduie with new seic№tiens() 

10;//update with now setectiens(;) 

Sequence Diagram; Register far t ^ 
Qmmf/Нщ 
Basic Flow (Submit Schedî le^ 

: Schedule 

At this, point the Submit Schedule subflow is executed. 

Рис. 4.6. Диаграмма последовательности Register for Courses — Basic Flow (Update Schedule) 



Рис. 4.7. Диаграмма последовательности Register for Courses — Basic Flow (Delete Schedule) 



: PrimafySdie^leOfferingfttle 

S://isMtecltii?() 

^-fiJMlectsdJ 
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^/^ still о|Мй?() 
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9: // Ш sludentfSchetiMie) 

WCftmvk as 9пп^лЛ Щ | 
* =̂̂~ >. 

: CouraeOffsHng 

Рис. 4.8. Диаграмма последовательности Register for Courses — Basic Flow (Submit Schedule) 
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^^ Rational Rose - coursereg^nalysis^mdl - [Ш§« :ШщШ| : :Ш^ 

«boundary» 
RegtslerFofCoufsesForm 

7/ submit $chediileO 
// display course offeringsO 
// update scheduteO 
// delete scheduleO 
// conlifm schedule deleticmO 
|// request schedule delete connrmatlonO 
// display scheduieQ 
// register for coursesO 
// display possible operations^ 
// create scheduleO 
// select 4 prtmaiy and 2 alternate otfenngsO 
|//display blank scheduleO 
// update offering selectionsQ 

«entity» 
Student 

// add scheduleO 
//get scheduleO 
// delete scheduleO 
I// has pre-requlsltesO 

«entity» 
CourseOffering 

//add studentO 
// remove studentO 
//still open?0 

«control» 
RegtstratlonController 

{// get course olferlngsO 
// get current scheduieQ 
|// delete current scheduieQ 
/̂  submit scheduleO 
// is registration open?0 
//createschedule with offerlngsQ 
// updziB schedule with new selectionsQ 

«boundary» 
CourseCatalogSystem 

|// get course offerlngsO 

«entity» 
Schedule 

//deleteO 
//submltO 
//saveO 
// any confilcts?0 
// create with offerlngsO 
// update with new selectlonsO 

lilv J 
Рис. 4.9. Диаграмма классов Register for Courses — Participating Classes 

с операциями "анализа" 
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5. Щелкните по левой кнопке мыши и проведите указатель от 
примечания до элемента диафаммы, с которым оно будет связано. 
Между примечанием и элементом возникнет штриховая линия. 

6. Создайте пустое примечание (без текста) и перетаидите на 
него из браузера нужную диафамму, для того чтобы создать приме­
чание-ссылку на другую диафамму (см. диафамму рис. 4.4 и др.). 

Кроме примечаний на диаграмму можно поместить также 
текстовую область и с ее помощью, например, добавить к сооб­
щению условие, как [registration open] на рис. 4.4. 

Для того чтобы поместить на диаграмму текстовую область: 
1. Щелкните по кнопке Text Box на панели управления. 
2. Щелкните мышью внутри диафаммы, чтобы поместить ту­

да текстовую область. 
3. Выделите эту область и введите в нее текст. 
Для создания кооперативной диафаммы достаточно открыть 

диаграмму последовательности и нажать клавишу F5. 
В процессе построения диафамм взаимодействия (соотнесе­

ния сообщений с операциями) в классах автоматически появля­
ются операции "анализа". Таким образом, диафамма классов 
Register for Courses — Participating Classes (см. рис. 4.3) после пост­
роения диафамм взаимодействия, описанного в упражнении 4.3, 
должна принять вид, показанный на рис. 4.9. 

4.2.3. ОПРЕДЕЛЕНИЕ АТРИБУТОВ 
И АССОЦИАЦИЙ КЛАССОВ 

Атрибуты классов анализа определяются исходя из знаний 
о предметной области, требований к системе и глоссария. 

Упражнение 4.4. 
Добавление атрибутов к классам 
Настройка: 
1. Выберите пункт Tools > Options в меню модели. 
2. Перейдите на вкладку "Diagram". 
3. Убедитесь, что переключатель Show All Attributes помечен. 
4. Убедитесь, что переключатели Suppress Attributes и Suppress 

Operations не помечены. 
Добавление атрибутов: 
1. Щелкните правой кнопкой мыши по классу Student. 
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2. Выберите пункт New Attribute в открывшемся меню. 
3. Введите новый атрибут Address. 
4. Нажмите на клавишу Enter. 
5. Повторите действия п. 1-4, добавив атрибуты name и 

studentlD. 
6. Добавьте атрибуты к классам CourseOffering и Shedule 

(рис. 4.10). 

iiatite 
address 
studetitiD 

// add scheduieO 
// get schedule^ 
// delete schedufeQ 
// has pre-requisitesO 

«entity» 
ComseOfferitig 

tiumber: String « *' 
startTime: Time 
endTlitie: Time 
days: Ettum 
/ numStudents: Int 

100^ 

// add studentO 
// remove studentQ 
//still open?0 

«entity» 
Schedule 

semester 

// deleteQ 
// submltO 
// saveO 
// any confiicts?0 
//create with offeringsO 
// update With new selectionsO 

i'<" 

Рис. 4.10. Классы с операциями "анализа" и атрибутами 
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Связи между классами (ассоциации) определяются в два этапа: 
Э т а п 1. Начальный набор связей устанавливается на основе 

анализа кооперативных диаграмм. Если два объекта взаимодей­
ствуют (обмениваются сообщениями), между ними на коопера­
тивной диаграмме должна существовать связь (путь взаимодейст­
вия), которая преобразуется в двунаправленную ассоциацию 
между соответствующими классами. Если сообщения между не­
которой парой объектов передаются только в одном направле­
нии, то для соответствующей ассоциации вводится направление 
навигации. 

Э т а п 2. Анализируются и уточняются ассоциации между 
классами-сущностями. Задаются мощности ассоциаций, могут 
использоваться множественные ассоциации, афегации, обобще­
ния и ассоциации-классы. 

У п р а ж н е н и е 4.5. 
Добавление связей 

Добавим связи к классам, принимающим участие в варианте 
использования Register for Courses. Для отображения связей меж­
ду классами построим три новых диаграммы классов в коопера­
ции Register for Courses пакета Use Case Realization - Register for 
Courses (рис. 4.11 — 4.13). 

Ha рис. 4.11 показаны только классы-сущности. Агрегация 
между классами Student и Schedule отражает тот факт, что каждый 
фафик является собственностью конкретного студента, принад­
лежит только ему. Предполагается также, что в системе будет хра­
ниться не только график текущего семестра, но и все фафики 
студента за разные семестры. Между классами Schedule и 
CourseOffering введены две ассоциации, поскольку конкретный 
курс может входить в график студента в качестве основного (не 
больше четырех курсов) и альтернативного (не больше двух кур­
сов). К классу Student добавлены ^ два новых подкласса — 
FulltimeStudent (студент очного отделения) и ParttimeStudent 
(студент вечернего отделения). 

На рис. 4.12 показаны ассоциации-классы, представляющие 
свойства связей между классами Schedule и CourseOffering. Ассо­
циация, связывающая фафик и альтернативный курс, имеет толь­
ко один атрибут — статус курса в конкретном фафике (status), ко­
торый может принимать значения "включен в график", "отменен", 
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«eirtit j f» 
Student 

tiaiiie 
address 
jstudentiD 
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Рис. 4.11. Диаграмма Entity Classes (классы-сущности) 
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f^^.i::'>:^'^^^^?Ay" .••• ^ r::..^:':)..< 2^.L^.^ "^I A^:'-' .j^^^^^ 

«ent i ty» 
PrimatySchedtileOfferirigltifo 

grade 

// Is eiiroiied rti?0 
// mark as enrolled InQ 
// mark as committedO 

«entity» 
Schedule 

0..П 
\ ^primaiyCourses 

.^jiiternateCourses 

«ent i ty» 
CourseOffering 

0..2 

«ent i ty» 
ScheduleOfferinglnfo 

status 

J/ mark as seiectedO 
// mark as cancetledQ 
y/i$selected?0 

w?;;wtfrirtni>;H^iffr>.w->^.^rt.Lw.^^w i;^.^,;;;^.^; ;.,пыЛ 

' i 

Рис. 4.12. Диафамма CourseOfferinglnfo (пример ассоциаций-классов) 

"внесен в список курса" и "зафиксирован в фафике". Если курс в 
процессе закрытия регистрации переходит из альтернативного 
в основные, то к соответствующей ассоциации добавляется атри­
бут "оценка" (grade). Таким образом, ассоциация-класс 
PrimaryScheduleOfFeringlnfo наследует свойства ассоциации-клас­
са ScheduleOfferinglnfo (атрибуты и операции, содержащиеся в 
этом классе, относятся как к основным, так и к альтернативным 
курсам) и добавляет свои собственные (оценка и окончательное 
включение курса в фафик могут иметь место только для основных 
курсов), что показано с помощью связи обобщения. 
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%> Rational Rose - coursereg_analysis.m<ll ~ fClass Ш^ШШШшШ^^^^^тшЩ^ 
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RegisterForCouisesForm 
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«control» 
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«boutidaiy» 
CourseCatalogSystein 

^ciirrei^Scheduie 

0»1 
«епЩ» 

Student C'^X , 

1 0..П 

«entltj^» 
Schedule 

0..П 

«ent i ty» 
ComseOffering 

Каталог курсов 
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Рис. 4.13. Полная диаграмма классов Register for Courses — Participating 
Classes (без атрибутов и операций) 

На рис. 4.13 показана полная диаграмма классов варианта ис­
пользования "Зарегистрироваться на курсы" (без атрибутов и 
операций). Ассоциации между граничными и управляющими 
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классами, а также между управляющими классами и классами-
сущностями введены на основе анализа кооперативных диа­
грамм и в отличие от устойчивых структурных (семантических) 
связей между сущностями отражают связи, динамически возни­
кающие между соответствующими объектами в потоке управле­
ния (в процессе работы приложения). Поскольку для ассоциаций 
это не свойственно, в дальнейшем (в процессе проектирования) 
они могут быть преобразованы в зависимости. 

Ассоциации создают непосредственно на диаграмме классов. 
Панель инструментов диаграммы классов содержит кнопки для 
создания как одно-, так и двунаправленных ассоциаций. 

Для того чтобы создать ассоциацию на диаграмме классов: 
1. Щелкните по кнопке Association на панели инструментов. 
2. Проведите мышью линию ассоциации от одного класса к 

другому 
Для того чтобы задать возможности навигации по ассо­

циации: 
1. Щелкните правой кнопкой мыши на связи по тому концу, 

на котором хотите показать стрелку 
2. Выберите пункт Navigable в открывшемся меню. 
Для того чтобы создать рефлексивную ассоциацию: 
1. Щелкните по кнопке Association на панели инструментов 

диаграммы. 
2. Проведите линию ассоциации от класса до какого-нибудь 

места вне класса. 
3. Отпустите кнопку мыши. 
4. Проведите линию ассоциации назад к классу. 
Для того чтобы создать агрегацию: 
1. Щелкните по кнопке Aggregation панели инструментов. 
2. Проведите линию афегации от класса-части к целому. 
Для того чтобы поместить на диаграмму классов рефлексив­

ную агрегацию: 
1. Щелкните по кнопке Aggregation на панели инструментов 

диаграммы. 
2. Проведите линию афегации от класса до какого-нибудь 

места вне класса. 
3. Отпустите кнопку мыши. 
4. Проведите линию афегации назад к классу 
При создании обобщения может потребоваться перенести не­

которые атрибуты или операции из одного класса в другой. Если, 
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например, понадобится перенести их из подкласса в суперкласс, 
в браузере достаточно просто перетащить атрибуты или операции 
из одного класса в другой. Не забудьте удалить копию атрибута из 
второго подкласса, если он имеется. 

Для того чтобы поместить обобщение на диаграмму классов: 
1. Щелкните по кнопке Generalization панели инструментов. 
2. Проведите линию обобщения от подкласса к суперклассу. 
Спецификации связей касаются имен ассоциаций, ролевых 

имен, мощности и ассоциаций-классов. 
Для того чтобы задать мощность связи: 
1. Щелкните правой кнопкой мыши по одному концу связи. 
2. Выберите пункт Multiplicity в открывшемся меню. 
3. Укажите нужную мощность. 
4. Повторите п. 1-3 для другого конца связи. 
Для того чтобы задать имя связи: 
1. Вьщелите нужную связь. 
2. Введите ее имя. 
Для того чтобы задать связи ролевое имя: 
1. Щелкните правой кнопкой мыши по ассоциации с нужно­

го конца. 
2. Выберите пункт role Name в открывшемся меню. 
3. Введите ролевое имя. 
Для того чтобы задать элемент связи (ассоциацию-класс): 
1. Откройте окно спецификации требуемой связи. 
2. Перейдите на вкладку "Detail". 
3. Задайте элемент связи в поле Link Element. 

Задание для самостоятельной работы 
Выполните анализ варианта использования Close Registration 

и постройте соответствующие диаграммы взаимодействия и 
классов. 



Глава 5 
ПРОЕКТИРОВАНИЕ СИСТЕМЫ 

Целью объектно-ориентированного проектирования являет­
ся адаптация предварительного системного проекта (набора 
классов "анализа"), составляющего стабильную основу архитек­
туры системы, к среде реализации с учетом всех нефункциональ­
ных требований. 

Объектно-ориентированное проектирование включает два 
вида деятельности: 

• проектирование архитектуры системы; 
• проектирование элементов системы. 

5 . 1 . ПРОЕКТИРОВАНИЕ 
АРХИТЕКТУРЫ СИСТЕМЫ 

Проектирование архитектуры системы включает: 
• идентификацию архитектурных решений и механизмов; 
• анализ взаимодействий между классами "анализа", выявле­

ние подсистем и интерфейсов; 
• формирование архитектурных уровней; 
• проектирование структуры потоков управления; 
• проектирование распределенной конфигурации системы. 

5.1.1. ВЫЯВЛЕНИЕ ПОДСИСТЕМ И ИНТЕРФЕЙСОВ 

Первым действием архитектора при выявлении подсистем 
является преобразование классов "анализа" в проектные классы 
(design classes). По каждому классу "анализа" принимается одно 
из двух решений: 

• класс "анализа" отображается в проектный класс, если он 
простой или представляет единственную логическую абстрак­
цию; 

• сложный класс "анализа" может быть разбит на несколько 
классов, преобразован в пакет или подсистему 
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Объединение классов в подсистемы проводится по следую­
щим соображениям: 

• функциональная связь: объединяются классы, участвующие 
в реализации варианта использования и взаимодействующие 
только друг с другом; 

• обязательность: совокупность классов, реализующая функ­
циональность, которая может быть удалена из системы или заме­
нена на альтернативную; 

• связанность: объединение в подсистемы сильно связанных 
классов; 

• распределение: объединение классов, размещенных на кон­
кретном узле сети. 

Примеры возможных подсистем: 
• совокупность классов, обеспечивающих сложный комплекс 

функций (например, безопасность и защиту данных); 
• граничные классы, реализующие сложный пользователь­

ский интерфейс или интерфейс с внешними системами; 
• различные продукты: коммуникационное ПО, доступ к ба­

зам данных, общие утилиты (библиотеки), различные приклад­
ные пакеты. 

При создании подсистем в модели выполняются следующие 
преобразования: 

• объединяемые классы помещаются в специальный пакет с 
именем подсистемы и стереотипом <<subsystem>>; 

• спецификации операций классов, образующих подсистему, 
выносятся в интерфейс подсистемы — класс со стереотипом 
<<interface>>; 

• описание интерфейса должно включать: 
имя интерфейса, отражающее его роль в системе; 
текстовое описание интерфейса размером с небольшой абзац, 

отражающее его обязанности; 
описание операций интерфейса (имя, отражающее результат 

операции, алгоритм выполнения операции, возвращаемое значе­
ние, параметры с их типами); 

характер использования операций интерфейса и порядок их 
выполнения документируются с помощью диаграмм взаимодей­
ствия, описывающих взаимодействие классов подсистемы при 
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реализации операций интерфейса, которые вместе с диафаммой 
классов подсистемы объединяются в кооперацию с именем ин­
терфейса и стереотипом «interface realization»; 

• в подсистеме создается класс-заместитель со стереотипом 
<<subsystem ргоху>>, управляющий реализацией операций ин­
терфейса. 

Все интерфейсы подсистем должны быть полностью опреде­
лены в процессе проектирования архитектуры, поскольку они 
будут служить в качестве точек синхронизации при параллельной 
разработке системы. 

Как пример (для системы регистрации) приведем подсистему 
CourseCatalogSystem, которая создана вместо граничного класса 
CourseCatalogSystem. Структура и диаграммы пакета (подсисте­
мы) CourseCatalogSystem (диаграммы классов и взаимодействия, 
описывающие данную подсистему и ее интерфейс) приведены на 
рис. 5.1 ~ 5.4. Классы DBCourseOfferring и CourseOfferringList от­
вечают за взаимодействие с БД каталога курсов в рамках JDBC. 

'*'̂ ' V , ^ . 47й','*'Ч'''**'%. 

} 
V '• 

CourseCatalogSystem 
О CourseCatalogSystem Context 
Q CourseCatalogSystem Dependencies 
Ш Main 
Ш «subsystem proxy» CourseCatalogSystem 
S DBCourseOfferring 
О «interface realfeation» ICourseCatalogSystem 

[§] tCourseCatalogSystemt 
[^ ICoufseCatalogSystem 
^ ICourseCataIogSystem::getCourseOfferings 
Щ lCoufseCatdlogSystem::getCourseOffering$ 
Щ ICourseCatalogSystem::8iitidli2e 
1^ ICourseCatabgSystem::initiali2e 
u^-^nriAHnr»-? 

МйЫШШнШИйШшй!^ JS^ 

Рис. 5.1. Структура пакета CourseCatalogSystem 
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Рис. 5.2. Контекст подсистемы CourseCatalogSystem 
с точки зрения архитектора (диаграмма CourseCatalogSystem Context) 
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%»Rational Rose - coursereg„de$»gn<nnd( - [Class Ш^дгтт^^шШШ^Щ^^^^^ШШЩ! 

«Interface» 
iCourseCatalogSystem 

(from Extern^ System Intgrfacgs) 

• getCourseOffenngsO : CoiirseOfFermgLlst 
• InltiailzeO 

^ "z^ 

«subsystem proxy» 
CourseCatalogSystem 

^ getCourseOfferlngsO: CourseOfferingLbt 
• InitlaiizeO 

--:И 

CourseOfforlngList 
gfom Untvcrgity Artifacts) 

newO 
^ addO 

'W 

JL 

«enti ty» 
CoufseOtfferiiig 

(from University/^ifacts) 

PBComseOfferritig 

createO 
readO 
InltiailzeO 

U l . -^:r^x.^^.fVf:v-^ v̂ :̂̂ 4 ^л>!Л"^^ ;̂̂ ^V4;̂  ^:ГУ-.:А;?^С^ . :1 

"̂ 4 
Ч m 
i 

Рис. 5.3. Диаграмма классов подсистемы CourseCatalogSystem 
с точки зрения проектировщика (диаграмма ICourseCatalogSystem) 

Объект CourseCatalogSystem Client (см. рис. 5.4) может принадле­
жать либо классу CloseRegistrationController, либо классу 
RegistrationController в зависимости от того, в каком из вариантов 
использования запрашивается каталог курсов. 
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^* Rational Rose ereg_destgn*m<i-'-::C^)iBii|^^^BR: 

CoMrseCatalogSystem Client 

1: getCour$eOfferlngsO 

; CoyrseCataloiiSvstam 

У 
2: rea(t($tring) 

; DBCom^eOffeffing 

6:setData() 

3: newO 
\ 6: adlcl(CourseOfferlng) 

: CourseOfferlnq : ComseOffeflngList 

frtiiiil ;iiniitfiii1 J 
Рис. 5.4. Кооперативная диаграмма, 

описывающая реализацию операции интерфейса getCourseOfferings 
(диафамма ICourseCatalogSystem:rgetCourseOfferings) 

5 . 1 . 2 . ФОРМИРОВАНИЕ АРХИТЕКТУРНЫХ УРОВНЕЙ 

В процессе анализа было принято предварительное решение 
о том, чтобы выделить архитектурные уровни. В процессе проек­
тирования все элементы системы должны быть распределены по 
данным уровням. С точки зрения модели это означает распреде­
ление проектных классов по пакетам, соответствующим архитек­
турным уровням (пакетам со стереотипом <<1ауег>>). 

В сложной системе архитектурные уровни могут разбиваться 
на подуровни, количество и структура которых, как было сказано 
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Рис. 5.5. Представление структуры модели в процессе проектирования 
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выше, зависят от сложности предметной области и среды реали­
зации. Подуровни могут формироваться по следующим критери­
ям: 

• группировка элементов с максимальной связанностью; 
• распределение в соответствии со структурой организации 

(обычно это касается верхних уровней архитектуры); 
• распределение в соответствии с различными областями 

компетенции разработчиков (предметная область, сети, комму­
никации, базы данных, безопасность и др.); 

• группировка отдельных компонентов распределенной сис­
темы; 

• распределение в соответствии с различной степенью безо­
пасности и секретности. 

Пример выделения архитектурных уровней и объединения 
элементов модели в пакеты для системы регистрации приведен 
на рис. 5.5. 

Данное представление отражают следующие решения, при­
нятые архитектором: 

• вьщелены три архитектурных уровня (созданы три пакета со 
стереотипом «layer») ; 

• в пакете Application создан пакет Registration, куда включе­
ны граничные и управляющие классы; 

• фаничные классы BillingSystem и CourseCatalogSystem пре­
образованы в подсистемы; 

• в пакет Business Services, помимо подсистем, включены еще 
два пакета: пакет External System Interfaces содержит интерфейсы 
подсистем (классы со стереотипом <<Interface>>), а пакет 
University Artifacts - все классы-сущности. 

5.1.3. ПРОЕКТИРОВАНИЕ СТРУКТУРЫ 
ПОТОКОВ УПРАВЛЕНИЯ 

Проектирование структуры потоков управления выполняется 
при наличии в системе параллельных процессов (параллелизма). 
Цель проектирования - выявление процессов, существующих в 
системе, характера их взаимодействия, создания, уничтожения и 
отображения в среду реализации. Требование параллелизма воз­
никает в следующих случаях: 

• необходимо распределить обработку между различными 
процессорами или узлами; 
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• система управляется потоком событий (event-driven system); 
• вычисления в системе обладают высокой интенсивностью; 
• в системе одновременно работает много пользователей. 
Например, система регистрации курсов обладает свойством 

параллелизма, поскольку она должна допускать одновременную 
работу многих пользователей (студентов и профессоров), каждый 
из которых порождает в системе отдельный процесс. 

Процесс (process) — это ресурсоемкий поток управления, ко­
торый может выполняться параллельно с другими процессами, а 
также в независимом адресном пространстве. В случае высокой 
сложности может разделяться на два потока или больше. Объект 
любого класса должен существовать внутри хотя бы одного про­
цесса. 

Поток (thread) — это облегченный поток управления, кото­
рый может выполняться параллельно с другими потоками в рам­
ках одного и того же процесса в общем адресном пространстве. 
Необходимость создания потоков в системе регистрации курсов 
диктуется следующими требованиями: 

• если курс окажется заполненным в то время, когда студент 
формирует свой учебный график, включающий данный курс, то 
он должен быть извещен об этом (нужен независимый процесс, 
управляющий доступом к информации конкретных курсов); 

• существующая база данных каталога курсов не обеспечива­
ет требуемую производительность (необходим процесс промежу­
точной обработки — подкачки данных). 

Реализация процессов и потоков обеспечивается средствами 
операционной системы. 

Для моделирования структуры потоков управления использу­
ются так называемые активные классы - классы со стереотипами 
<<process>> и <<thread>>. Активный класс владеет собственным 
процессом или потоком и может инициировать управляющие 
воздействия. Связи между процессами моделируются как зависи­
мости. Потоки могут существовать только внутри процессов, по­
этому связи между процессами и потоками моделируются как 
композиции. Модель потоков управления помещается в пакет 
Process View логического представления. В качестве примера на 
рис. 5.6 — 5.8 приведены фрагменты диаграммы классов, описы­
вающей структуру процесса регистрации студента на курсы. Ак-
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«thread» 
CourseCache 

«thread» 
OfferlngCache 

Рис. 5.6. Процессы и потоки 

тивные классы, показанные на этих диаграммах, выполняют сле­
дующее назначение: 

• StudentApplication — процесс, управляющий всеми функци­
ями студента-пользователя в системе. Для каждого студента, ко­
торый начинает регистрироваться на курсы, создается один объ­
ект данного класса; 

• CourseRegistrationProcess - процесс, управляющий непо-
средствейно регистрацией студента. Для каждого студента, кото­
рый начинает регистрироваться на курсы, также создается один 
объект данного класса; 
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• CourseCatalogSystemAccess — управляет доступом к системе 
каталога курсов. Один и тот же объект данного класса использу­
ется всеми пользователями при доступе к каталогу курсов; 

%^ Rational Rose - coursereg desian^mdl - Ют% ШщгмтМшШШ^Л 

^^t^Vv,^5V 
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T^ 
0..1 
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ReglsterrorCoursesForm 
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1 

«process» 
CourseRegistratlonProcess 

«control» 
ReglslratlonController 

(from Rftgtstfation) 

JL 
«process» 

CoMrseCatalogSystemAccess 
«subsystem proxy» 
CourseCatalogSystent 
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«Interface» 

ICourseCatalogSystem 
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Рис- 5.7. Классы, связанные с процессами 
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• CourseCache и OflferingCache используются для асинхронно­
го доступа к данным в базу данных с целью повышения произво­
дительности системы. Они представляют собой кэш для проме­
жуточного хранения данных о курсах, извлеченных из БД. 

•RationalRose - coursur^q^jiesignjnM^^^^^^K^MS^i 
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«thread» 
OfferitigCache 

7? 
O..II 

«entity» 
Course 

(from Uftivefsity Artifacts) 
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(from Unlvfefsity Artifacts) 

)1/>иЛЫшМЛшЛлтЛШшШшЛ 

Рис. 5.8. Классы, связанные с потоками 

5.1.4. МОДЕЛИРОВАНИЕ РАСПРЕДЕЛЕННОЙ 
КОНФИГУРАЦИИ СИСТЕМЫ 

Если создаваемая система является распределенной, необхо­
димо спроектировать ее конфигурацию в вычислительной среде, 
т.е. описать вычислительные ресурсы, коммуникации между ни­
ми и использование ресурсов различными системными процес-
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сами. Распределенная сетевая конфигурация системы моделиру­
ется с помощью диаграммы размещения. Ее основные элементы: 

• узел (node) — вычислительный ресурс (процессор или другое 
устройство (дисковая память, контроллеры различных устройств 
и т.д.)). Для узла можно задать выполняющиеся на нем процессы; 

• соединение (connection) — канал взаимодействия узлов 
(сеть). 

Пример такой диаграммы для системы регистрации (без про­
цессов) приведен на рис. 5.9. 

%- Rational Rose - €oursereg_<fesi^r>.mdl - fDeploymeiil:Щ^ШШШ 

'М ^l}J,^£>^.&';Ud:fi!.i:.v-,^i:.:^.::^i НЛг:^Ш "̂̂ JuPfl' 

Рис. 5.9. Сетевая конфигурация системы регистрации 
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Распределение процессов по узлам сети (рис. 5.10) проводит­
ся с учетом следующих факторов: 

• используемые образцы распределения (трехзвенная клиент-
серверная конфигурация, "толстый" и "тонкий" клиенты, равно­
правные узлы (peer-to-peer) и т.д.); 

• время отклика; 
• минимизация сетевого трафика; 
• мощность узла; 
• надежность оборудования и коммуникаций. 

4^ Rational Rose ~ coursereg desk|n.mdl - Шщ^ШШШШШШ^Ш 
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Рис. 5.10. Сетевая конфигурация системы регистрации 
с распределением процессов по узлам 
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Упражнение 5.1. 
Создание диаграммы размещения системы регистрации 
Для того чтобы открыть диафамму размещения, надо дважды 

щелкнуть мышью по представлению Deployment View (представ­
лении размещения) в браузере. 

Для того чтобы поместить на диафамму процессор: 
1. Щелкните по кнопке на панели инструментов диафаммы 

Processor. 
2. Щелкните по диафамме размещения в том месте, куда хо­

тите его поместить. 
3. Введите имя процессора. 
В спецификациях процессора можно ввести информацию о 

его стереотипе, характеристиках и планировании. Стереотипы 
применяются для классификации процессоров (например, ком­
пьютеров под управлением Unix или ПК). 

Характеристики процессора могут, в частности, включать его 
скорость и объем памяти. 

Поле планирования (scheduling) процессора содержит описа­
ние того, как осуществляется планирование его процессов: 

1. Preemptive (с приоритетом). Высокоприоритетные процес­
сы имеют преимущество перед низкоприоритетными. 

2. Non preemptive (без приоритета). У процессов не имеется 
приоритета. Текущий процесс выполняется до его завершения, 
после чего начинается следующий. 

3. Cyclic (циклический). Управление передается между про­
цессами по кругу. Каждому процессу дается определенное время 
на его выполнение, затем управление переходит к следующему 
процессу. 

4. Executive (исполнительный). Существует некий вычис­
лительный алгоритм, который и управляет планированием 
процессов. 

5. Manual (вручную). Процессы планируются пользователем. 
Для того чтобы назначить процессору стереотип: 
1. Откройте окно спецификации процессора. 
2. Перейдите на вкладку "General". 
3. Введите стереотип в поле Stereotype. 
Для того чтобы ввести характеристики и планирование про­

цессора: 
1. Откройте окно спецификации процессора. 
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2. Перейдите на вкладку "Detail". 
3. Введите характеристики в поле характеристик. 
4. Укажите один из типов планирования. 
Для того чтобы показать планирование на диаграмме: 
1. Щелкните правой кнопкой мыши по процессору 
2. Выберите пункт Show Scheduling в открывшемся меню. 
Для того чтобы добавить связь на диафамму: 
1. Щелкните по кнопке Connection на панели инструментов. 
2. Щелкните по узлу диаграммы. 
3. Проведите линию связи к другому узлу. 
Для того чтобы назначить связи стереотип: 
1. Откройте окно спецификации связи. 
2. Перейдите на вкладку "General". 
3. Введите стереотип в поле Stereotype (Стереотип). 
Для того чтобы добавить процесс: 
1. Щелкните правой кнопкой мыши по процессору в браузере. 
2. Выберите пункт New > Process в открывшемся меню. 
3. Введите имя нового процесса. 
Для того чтобы показать процессы на диаграмме: 
1. Щелкните правой кнопкой мыши по процессору в браузере. 
2. Выберите пункт Show Processes в открывшемся меню. 

5.2. ПРОЕКТИРОВАНИЕ ЭЛЕМЕНТОВ СИСТЕМЫ 

Проектирование элементов системы включает: 
• уточнение описания вариантов использования (заключается 

в модификации их диаграмм взаимодействия и диафамм классов 
с учетом вновь появившихся на шаге проектирования классов и 
подсистем, а также проектных механизмов); 

• проектирование классов; 
• проектирование баз данных. 

5 .2 .1 . ПРОЕКТИРОВАНИЕ КЛАССОВ 

Проектирование классов включает: 
• детализацию проектных классов; 
• уточнение операций и атрибутов; 
• моделирование состояний для классов; 
• уточнение связей между классами. 
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Детализация проектных классов 
Каждый фаничный класс преобразуется в некий набор клас­

сов в зависимости от своего назначения. Это может быть набор 
элементов пользовательского интерфейса, зависящий от возмож­
ностей среды разработки, или набор классов, реализующий сис­
темный или аппаратный интерфейс. 

Классы-сущности с учетом соображений производительнос­
ти и защиты данных могут разбиваться на ряд классов. Основа­
нием для разбиения является наличие в классе атрибутов с раз­
личной частотой использования или видимостью. Такие атрибу­
ты, как правило, выделяются в отдельные классы. 

Управляющие классы, реализующие простую передачу ин­
формации от граничных классов к сущностям, могут быть удале­
ны. Сохраняются классы, выполняющие существенную работу 
по управлению потоками событий (управление транзакциями, 
распределенная обработка и т.д.). 

Полученные в результате уточнения классы подлежат непо­
средственной реализации в коде системы. 

Уточнение операций и атрибутов 
Обязанности классов, определенные в процессе анализа и до­

кументированные в виде операций "анализа", преобразуются в 
операции, которые будут реализованы в коде. При этом: 

• каждой операции присваивается краткое имя, характеризу­
ющее ее результат; 

• определяется полная сигнатура операции (в соответствии с 
нотацией, принятой в языке UML); 

• создается краткое описание операции, включая смысл всех 
ее параметров; 

• задается видимость операции: public, private или protected; 
• определяется область действия операции: экземпляр (опе­

рация объекта) или классификатор (операция класса); 
• может быть составлено описание алгоритма выполнения 

операции (с использованием диаграмм деятельности в виде блок-
схем, а также диаграмм взаимодействия различных объектов при 
выполнении операции). 

Уточнение атрибутов классов (рис. 5.11) заключается в следу­
ющем: 

• кроме имени атрибута задаются его тип и значение по умол­
чанию (необязательное); 
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Рис. 5.11. Класс Student с полностью определенными атрибутами 
и операциями 

• учитываются соглашения по именованию атрибутов, при­
нятые в проекте и языке реализации; 

• задается видимость атрибутов: public, private или protected; 
• при необходимости определяются производные (вычисляе­

мые) атрибуты. 

Упражнение 5.2. 
Определение атрибутов и операций для класса Student 
Для того чтобы задать тип данных, значение по умолчанию и 

видимость атрибута: 
1. Щелкните правой кнопкой мыши по атрибуту в браузере. 
2. Выберите пункт Open Specification в открывшемся меню. 
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3. Укажите тип данных в раскрывающемся списке типов или 
введите собственный тип данных. 

4. Введите значение атрибута по умолчанию в поле Initial Field 
(Первоначальное значение). 

5. Выберите видимость атрибута: public, protected, private или 
implementation в поле Export Control. По умолчанию видимость 
всех атрибутов соответствует private. 

Для того чтобы изменить нотацию для обозначения види­
мости: 

1. Выберите пункт Tools > Options в меню модели. 
2. Перейдите на вкладку "Notation". 
3. Пометьте контрольный переключатель Visibility as Icons, 

чтобы использовать нотацию Rose, или снимите пометку, чтобы 
использовать нотацию UML. 

Примечание . Изменение значения этого параметра при­
ведет к смене нотации только для новых диафамм и не затронет 
существующие диаграммы. 

Для того чтобы задать тип возвращаемого значения, стерео­
тип и видимость: 

1. Щелкните правой кнопкой мыши по операции в браузере. 
2. Откройте окно спецификации класса этЬй операции. 
3. Укажите тип возвращаемого значения в раскрывающемся 

списке или введите свой тип. 
4. Укажите стереотип в соответствующем раскрывающемся 

списке или введите новый. 
5. Укажите значение видимости операции в поле Export 

Control: public, protected, private или implementation. По умолча­
нию видимость всех операций установлена в public. 

Для того чтобы добавить к операции аргумент: 
1. Откройте окно спецификации операции. 
2. Перейдите на вкладку "Detail". 
3. Щелкните правой кнопкой мыши по области аргументов, в 

открывшемся меню выберите Insert. 
4. Введите имя аргумента. 
5. Щелкните по колонке Data type и введите туда тип данных 

аргумента. 
6. Щелкните по колонке default при необходимости и введите 

значение аргумента по умолчанию. 
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Моделирование состояний для классов 
Если в системе присутствуют зависимые от состояния объ­

екты со сложной динамикой поведения, то для них можно пост­
роить модель, описывающую состояния объектов и переходы 
между ними. Эта модель представляется в виде диаграмм состо­
яний. 

В качестве примера, связанного с системой регистрации, рас­
смотрим поведение объекта класса CourseOffering. Диаграмма со­
стояний строится в несколько этапов. 

Этап 1. И д е н т и ф и к а ц и я состояний . Признаками 
для выявления состояний являются изменение значений атрибу­
тов объекта или создание и уничтожение связей с другими объек­
тами. Так, объект CourseOffering может находиться в состоянии 
Open (прием на курс открыт) до тех пор, пока количество зареги­
стрировавшихся на него студентов не превышает 10, а как только 
оно станет равным 10, объект переходит в состоянии Closed (при­
ем на курс закрыт). Кроме того, объект CourseOffering может на­
ходиться в состоянии Unassigned (его никто не ведет, т.е. отсутст­
вует связь с каким-либо объектом Professor) или Assigned (такая 
связь существует). 

Этап 2. И д е н т и ф и к а ц и я событий. События связа­
ны, как правило, с выполнением некоторых операций. Так, в 
классе CourseOffering в результате распределения обязанностей 
при анализе варианта использования "Выбрать курсы для препо­
давания" определены две операции — addProfessor и 
removeProfessor, связанные с выбором курса некоторым профес­
сором (созданием новой связи) и отказом от выбранного курса 
(разрывом связи). Этим операциям ставятся в соответствие два 
события - addProfessor и removeProfessor. 

Этап 3. И д е н т и ф и к а ц и я переходов между со ­
стояниями . Переходы вызываются событиями. Таким обра­
зом, состояния Unassigned и Assigned соединяются двумя пере­
ходами (рис. 5.12). 

Дальнейшая детализация поведения объекта CourseOffering 
приведет к построению диаграммы состояний (рис. 5.13). На дан­
ной диаграмме использованы такие возможности моделирования 
состояний, как композитные (composite state) и историческое со-
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Рис. 5.12. Переходы между состояниями 

стояния (history state). В данном случае композитными состояни­
ями являются Open и Closed, а вложенными состояниями -
Unassigned, Assigned, Cancelled (курс отменен), Full (курс запол­
нен) и Committed (курс включен в расписание). Композитные со­
стояния позволяют упростить диафамму, уменьшая количество 
переходов, поскольку вложенные состояния наследуют все свой­
ства и переходы композитного состояния. 

Историческое состояние (обозначенное на диаграмме ок­
ружностью с буквой Н) — это псевдосостояние, которое восста­
навливает предыдущее активное состояние в композитном со­
стоянии. Оно позволяет композитному состоянию Open запо­
минать, какое из вложенных состояний (Unassigned или 
Assigned) было текущим в момент выхода из Open, для того что­
бы любой из переходов в Open (add student или remove student) 
возвращался именно в это вложенное состояние, а не в началь­
ное состояние. 
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Рис. 5.13. Диаграмма состояний с композитными состояниями 

Упражнение 5.3. 
Создание диаграммы состояний для класса CourseOffering 
Для того чтобы создать диаграммы состояний: 
1. Щелкните правой кнопкой мыши по браузеру на нужном 

классе. 
2. Выберите пункт New > Statechart Diagram в открывшемся 

меню. 
Для того чтобы добавить состояние: 
1. Щелкните по кнопке State на панели инструментов. 
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2. Щелкните мышью по диафамме состояний в том месте, ку­
да хотите поместить его. 

Все элементы состояния можно добавить с помощью вкладки 
"Detail" окна спецификации состояния. 

Для того чтобы добавить деятельность: 
1. Откройте окно спецификации требуемого состояния. 
2. Перейдите на вкладку "Detail". 
3. Щелкните правой кнопкой мыши по окну "Actions". 
4. Выберите пункт Insert в открывшемся меню. 
5. Щелкните дважды по новому действию. 
6. Введите действие в поле Actions. 
7. Укажите Do в окне "When", чтобы сделать новое действие 

деятельностью. 
Для того чтобы добавить входное действие, в окне "When" ука­

жите On Entry. 
Для того чтобы добавить выходное действие, в окне "When" 

укажите On Exit. 
Для того чтобы послать событие: 
1. Откройте окно спецификации требуемого состояния. 
2. Перейдите на вкладку "Detail". 
3. Щелкните правой кнопкой мыши по окну "Actions". 
4. Выберите пункт Insert в открывшемся меню. 
5. Щелкните дважды по новому действию. 
6. Укажите Send Event в качестве типа действия. 
7. Введите событие (event), аргументы (arguments) и целевой 

объект (Target) в соответствующие поля. 
Для того чтобы добавить переход: 
1. Щелкните по кнопке Transition панели инструментов. 
2. Щелкните мышью по состоянию, откуда осуществляется 

переход. 
3. Проведите линию перехода до того состояния, где он завер­

шается. 
Для того чтобы добавить рефлексивный переход: 
1. Щелкните по кнопке Transition to Self панели инструментов. 
2. Щелкните по тому состоянию, где осуществляется рефлек­

сивный переход. 
Для того чтобы добавить событие, его аргументы, ограждаю­

щее условие и действие: 
1. Щелкните дважды по переходу, чтобы открыть окно его 

спецификации. 



проектирование системы 139 

2. Перейдите на вкладку "General". 
3. Введите событие в поле Event. 
4. Введите аргументы в поле Arguments. 
5. Введите ограждающее условие в поле Condition. 
6. Введите действие в поле Action. 
Для того чтобы отправить событие: 
1. Щелкните дважды по переходу, чтобы открыть окно его 

спецификации. 
2. Перейдите на вкладку "Detail".-
3. Введите событие в поле Send Event. 
4. Введите аргументы в поле Send Arguments. 
5. Задайте цель в поле Send Target. 
Для того чтобы указать начальное или конечное состояние: 
1. Нажмите кнопку Start State или End State на панели инстру­

ментов. 
2. Щелкните мышью по диафамме состояний в том месте, ку­

да хотите поместить состояние. 

Уточнение связей между классами 
В процессе проектирования связи между классами (ассоциа­

ции, афегации и обобщения) подлежат уточнению: 
• ассоциации между фаничными и управляющими классами 

отражают связи, динамически возникающие между соответству­
ющими объектами в потоке управления. Для таких связей доста­
точно обеспечить видимость классов, поэтому они преобразуют­
ся в зависимости; 

• если для некоторых ассоциаций нет необходимости в двуна­
правленной связи, то вводятся направления навигации; 

• афегации, обладающие свойствами композиции, преобра­
зуются в связи композиции. 

Пример преобразования связей в соответствии с данными ре­
комендациями для классов варианта использования "Зарегистри­
роваться на курсы" приведен на рис. 5.14. Ассоциация между уп­
равляющим и фаничным классами преобразована в зависимость. 
Афегация между классами Student и Schedule обладает свойства­
ми композиции. Направления навигации на ассоциациях между 
классами Schedule и CourseOffering введены по следующим сооб­
ражениям: нет необходимости в получении списка фафиков, в 
которых присутствует какой-либо курс; количество фафиков 
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относительно мало по сравнению с количеством конкретных 
курсов. 

Для того чтобы преобразовать агрегацию в композицию: 
1. Щелкните правой кнопкой мыши по тому концу агрегации, 

который упирается в класс-часть (на рис.5.14 - Schedule). 
2. Выберите пункт Containment в открывшемся меню. 
3. Укажите метод включения By Value. 

«control» 
RegistrationController 

<»^registraf)t 

-H 
«Interface» 

iCoufseCatalogSystem 
(from Sxt«rnal Sygtftm Inlttrfacoig) 

0..1 

0,.1 •currentScheduie 

«entibf» 
Student 

(from University Arttfacts) 
0;.n 

«ent i ty» 
Schedule 

(from University Artifacts I 

Ж. 

0..П 

«ent i ty» 
CourseOffering 

(from University Artifacts) 

-t-aiternateCouises 

O.M 

^̂ primaiyCourses 

W 

Щ 

^ 

Рис. 5.14. Пример преобразования ассоциаций и агрегаций 
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П р и м е ч а н и е . Значение By Value предполагает, что целое и 
часть создаются и разрушаются одновременно, что соответствует 
композиции. Агрегация (By Reference) предполагает, что целое и 
часть создаются и разрушаются в разное время. 

Связи обобщения могут преобразовываться в ситуациях с так 
называемой метаморфозой подтипов. Например, в случае с сис­
темой регистрации студент может переходить с очной формы 

i> Rational Rose - coursereci^^desiaa.mdl - [ C l a s r l i i ^ ^ R P -

'Wyf^'- A 

«ent i ty» 
Student 

. name: string 
• address: string 
«class» - nextAvaiitD : int 
- studentiD: int 
«dateofflirth: Date 

«ent i ty» 
FulltimeClassification 

«ent i ty» 
ParttimeCiassifi cation 

' maxNumCourses 

i '§fMMM'^k^SM^f:rf(\\ 

Рис. 5.15. Преобразование обобщения 
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обучения на вечернюю, т.е. объект Student может менять свой 
подтип. При таком изменении придется модифицировать описа­
ние объекта в системе. Для того чтобы избежать этой модифика­
ции и тем самым повысить устойчивость системы, иерархия на­
следования реализуется с помощью классификации (рис. 5.15). 

5.2.2. ПРОЕКТИРОВАНИЕ БАЗ ДАННЫХ 

Проектирование базы данных зависит от того, какой тип 
СУБД используется для хранения данных СУБД - объектная или 
реляционная. Для объектных БД никакого проектирования не 
требуется, поскольку классы-сущности непосредственно отобра­
жаются в БД. Для реляционных БД классы-сущности объектной 
модели должны быть отображены в таблицы реляционной БД. 
Совокупность таблиц и связей между ними может быть представ­
лена в виде диафаммы классов, которая, по существу, является 
ER-диаграммой. Набор правил, применяемых при отображении 
классов в таблицы БД, фактически совпадает с правилами преоб­
разования сущностей и связей в таблицы БД. В технологии RUP 
для такого отображения используется специальный инструмент 
— Data Modeler. Он выполняет преобразование классов-сущнос­
тей в классы-таблицы с последующей генерацией описания БД 
как на стандартном языке SQL (ANSI SQL), так и на его диалек­
тах для различных СУБД (Oracle, IBM DB2, Sybase Adaptive 
Server, MS SQL Server). Для описания схемы БД применяется сле­
дующий набор элементов языка UML со своими стереотипами 
(профиль и ML): 

• таблица представляется в виде класса со стереотипом 
« T a b l e » ; 

• представление изображается в виде класса со стереотипом 
« V i e w » ; 

• столбец таблицы представляется в виде атрибута класса с со­
ответствующим типом данных; 

• обычная ассоциация и агрегация представляются в виде ас­
социации со стереотипом <<Non-Identifying>> (в терминологии 
IDEF1X — неидентифицирующей связи); 

• композиция представляется в виде ассоциации со стереоти­
пом <<Identifying>> (в терминологии IDEF1X — идентифициру­
ющей связи); 
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• схема БД представляется в виде пакета со стереотипом 
<<Schema», содержащего классы-таблицы; 

• контейнер хранимых процедур представляется в виде класса 
со стереотипом <<SP Container»; 

• ограничения целостности, индексы и триггеры представля­
ются в виде операций классов-таблиц со стереотипами < < Р К » 
(Primary key), « F K » (Foreign key), « U n i q u e » , « C h e c k » , 
<<Index>> и «Trigger>>; 

• физическая база данных представляется в виде компонента 
со стереотипом «Database>>. 

У п р а ж н е н и е 5.4. 
Проектирование реляционной базы данных 

Проектирование БД состоит из следующих шагов. 
Ш а г 1. Создание нового компонента — базы данных: 
1. Щелкните правой кнопкой мыши по представлению ком­

понентов. 
2. Выберите пункт Data Modeler > New > Database в открыв­

шемся меню. 
3. Откройте окно спецификации вновь созданного компо­

нента DB_0 и в списке Target выберите Oracle 8.x. 
Ш а г 2. Определение устойчивых (persistent) классов: 
1. Откройте окно спецификации класса Student в пакете 

University Artifacts. 
2. Перейдите на вкладку "Detail". 
3. Установите значение переключателя Persistence в Persistent. 
4. Проделайте такие же действия для классов Classification, 

FulltimeClassification и ParttimeClassification. 
5. Откройте класс Student в браузере, нажав"+". 
6. Щелкните правой кнопкой мыши по атрибуту studentlD. 
7. Выберите пункт Data Modeler > Part of Object Identity в от­

крывшемся меню (указание атрибута в качестве части первично­
го ключа). 

Ш а г 3. Создание схемы БД: 
1. Щелкните правой кнопкой мыши по пакету University 

Artifacts. 
2. Выберите пункт Data Modeler > Transform to Data Model в 

открывшемся меню. 
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Рис. 5.16. Диаграмма "сущность-связь" 
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3. Укажите DB_0 и щелкните по кнопке ОК в появившемся 
окне в списке Target Database. В результате в логическом пред­
ставлении появится новый пакет Schemas. 

4. Откройте пакет Schemas и щелкните правой кнопкой мыши 
по пакету «Schema» S_0. 

5. Выберите пункт Data Modeler > New > Data Model Diagram 
в открывшемся меню. 

6. Откройте пакет, затем вновь созданную диаграмму "сущ­
ность-связь" NewDiagram и перенесите на нее все классы-табли­
цы, находящиеся в пакете <<Schema» S_0. Получившаяся диа­
грамма показана на рис. 5.16. 
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ГЕНЕРАЦИЯ КОДА 

6 . 1 . ГЕНЕРАЦИЯ ОПИСАНИЯ БАЗЫ ДАННЫХ 
НА ЯЗЫКЕ SQL 

После завершения проектирования БД можно сгенерировать 
описание базы данных на языке SQL. 

Упражнение 6.1. 
Генерация описания базы данных 

Для генерации описания БД: 
1. Щелкните правой кнопкой мыши по пакету «Schema>> 

S 0. 

Рис. 6.1. Окно мастера "Forward Engineering Wizard" 
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2. Выберите пункт Data Modeler > Forward Engineer в открыв­
шемся меню. 

3. Щелкните по кнопке Next в открывшемся окне мастера 
"Forward Engineering Wizard" (рис. 6.1). 

4. Оставьте все флажки генерации языка описания данных 
(DDL) отмеченными (рис. 6.2) и щелкните по кнопке Next. 

Ш Forward Engineermg Wizard 

Choo»e Options 
Select the model elements you would like generated into a DDL scnpt. AC 

IIL^LJ!!!^^:^^ .. 1 ' 1 

^•^'"•^•»'>1'^111|Д»"«»»>«'И*«««^^ .Jiiif^lM M ijiiiiT 

Рис. 6.2. Параметры генерации DDL 

5. Укажите имя и расположение текстового файла с результа­
тами генерации (рис. 6.3) и щелкните по кнопке Next. 

6. Завершив генерацию, откройте созданный текстовый файл 
и просмотрите результаты. 
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forward Fngineerinq Wizard 

Choote to Save and Execute DDL • { 
Specify e path to »ave the genertfed DDL «dipt. You can choo«e to execute ^ f w ^ l 
the DDL script by piovidng у(м databate connection informetion. 

Рис. 6.3. Задание имени файла с результатами генерации DDL 

Результаты генерации должны выглядеть следующим обра­
зом: 

CREATE TABLE T_ParttimeClassification ( 
maxNumCourses SMALLINT NOT NULL, 
StudentID SMALLINT NOT NULL, 
CONSTRAINT PK_T_ParttimeCIassification29 PRIMARY KEY 

(StudentID) 
) 
/ 
CREATE TABLE T_Classification ( 
StudentID SMALLINT NOT NULL, 
CONSTRAINT PK_T_Classification23 

(StudentID), 
CONSTRAINT TC_T_Classification44 UNIQUE (studentID) 
) 
/ 

PRIMARY KEY 
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CREATE TABLE T_FulltimeClassification ( 
gradDate SMALLINT NOT NULL, 
StudentID SMALLINT NOT NULL, 
CONSTRAINT PK_T_FulltimeClassification28 PRIMARY KEY 

(studentID) 
) 
/ 
CREATE TABLE T_Student ( 
name SMALLINT NOT NULL, 
address SMALLINT NOT NULL, 
nextAvaillD SMALLINT NOT NULL, 
StudentID SMALLINT NOT NULL, 
dateofBirth DATE NOT NULL, 
CONSTRAINT PK_T_Student25 PRIMARY KEY (studentID) 
) 
/ 
CREATE INDEX TC_T_Classification43 ON T_Classification 

(studentID) 
/ 
ALTER TABLE T_ParttimeClassification ADD (CONSTRAINT 

FK_T_ParttimeClassification29 FOREIGN KEY (studentID) REFER­
ENCES T_Classification (studentID)) 

/ 
ALTER TABLE T_Classification ADD (CONSTRAINT 

FK_T_aassification23 FOREIGN KEY (studentID) REFERENCES 
T_Student (studentID)) 

/ 
ALTER TABLE T_FulltimeClassification ADD (CONSTRAINT 

FK_T_FulltimeClassification28 FOREIGN KEY (studentID) REFER­
ENCES T_Classirication (studentID)) 

/ 

6.2. ГЕНЕРАЦИЯ КОДА ПРИЛОЖЕНИЯ 

Процесс генерации кода приложения состоит из следующих 
шагов: 

Шаг L Проверка модели. 
Ш а г 2. Создание компонентов. 
Шаг 3. Соотнесение классов с компонентами. 
Шаг 4. Установка свойств генерации кода. 



150 Глава 6 

Ш а г 5. Выбор класса, компонента или пакета. 
Шаг 6. Генерация кода. 

Упражнение 6.2. 
Проверка модели 
В Rose существует средство проверки моделей, не зависящее 

от языка и применяемое для обеспечения корректности модели 
перед генерацией кода. Рекомендуется всегда выполнять такую 
проверку, поскольку она помогает выявить в модели неточности 
и ошибки, не позволяющие генерировать код надлежащим обра­
зом. 

Для проверки модели Rose: 
1. Выберите в меню Tools > Check Model. 
2. Проанализируйте все ошибки, появившиеся в окне журнала. 
К наиболее распространенным ошибкам относятся, напри­

мер, сообщения на диаграмме последовательности или коопера­
тивной диаграмме, не отображенные на операцию, либо объекты 
этих диафамм, не отображенные на класс. 

С помощью пункта меню Check Model можно выявить боль­
шую часть неточностей и ошибок в модели. Пункт меню Access 
Violations позволяет обнаруживать нарушения правил доступа, 
возникающие тогда, когда существует связь между двумя класса­
ми разных пакетов, но связи между самими пакетами нет. 

Для того чтобы обнаружить нарушение правил доступа: 
1. Выберите в меню Report > Show Access Violations. 
2. Проанализируйте все нарушения правил доступа в окне. 

Упражнение 6.3. 
Создание компонентов и соотнесение классов с компонентами 

В Rose диаграммы компонентов создаются в представлении 
компонентов (рис. 6.4). Отдельные компоненты можно создавать 
непосредственно на диаграмме или перетаскивать их туда из бра­
узера. 

Выберем э качестве языка профаммирования C++ и создадим 
для класса Student соответствующие этому языку компоненты. 

Для создания диаграммы компонентов: 
1. Щелкните мышью дважды по главной диафамме компо­

нентов Main в представлении компонентов. 



Генерация кода 151 

Рис. 6.4. Диаграмма компонентов 

2. Щелкните по кнопке Package Specification на панели инст­
рументов. 

3. Поместите элемент Package Specification на диаграмму 
4. Откройте спецификацию элемента, введите имя Student и 

укажите в окне языка язык ANSI C++. 
5. Щелкните по кнопке Package Body на панели инструмен­

тов. 
6. Поместите элемент Package Body на диаграмму. 
7. Откройте спецификацию элемента, введите имя Student и 

укажите в окне языка язык ANSI C++. 
8. Щелкните по кнопке Dependency на панели инструментов. 
9. Проведите линию зависимости от тела пакета к специфика­

ции пакета. 
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Для соотнесения класса с компонентами: 
1. Найдите класс Student в логическом представлении брау­

зера. 
2. Перетащите этот класс на спецификацию пакета компо­

нента Student в представлении компонентов браузера. В результа­
те класс Student будет соотнесен со спецификацией и телом паке­
та компонента Student. 

Упражнение 6.4. 
Генерация кода 
Для каждого языка в Rose предусмотрен ряд определенных 

свойств генерации кода. Перед генерацией кода рекомендуется 
анализировать эти свойства и вносить необходимые изменения. 

Для анализа свойств генерации кода выберите Tools > Options, 
а затем вкладку соответствующего языка. В окне списка можно 
выбрать класс, атрибут, операцию и другие элементы модели. Для 
каждого языка в этом списке указаны свои собственные элемен­
ты модели. При выборе разных значений на экране появляются 
разные наборы свойств. Любые изменения, вносимые в набор 
свойств в окне Tools > Options, воздействуют на все элементы мо­
дели, для которых используется данный набор*. 

Во время генерации кода Rose выбирает информацию из ло­
гического и компонентного представлений модели и генерирует 
большой объем "скелетного" (skeletal) кода: 

• Классы. Генерируются все классы модели. 
• Атрибуты. Код включает атрибуты каждого класса, в том 

числе видимость, тип данных и значение по умолчанию. 
• Сигнатуры операций. Код содержит определения операций 

со всеми параметрами, типами данных параметров и типом воз­
вращаемого значения операции. 

• Связи. Некоторые из связей модели вызывают создание ат­
рибутов при генерации кода. 

• Компоненты. Каждый компонент реализуется в виде соот­
ветствующего файла с исходным кодом. 

Для генерации кода C-f-+: 
1. Откройте диаграмму компонентов системы. 
2. Выберите все объекты на диаграмме компонентов. 

• Более подробно генерация кода средствами Rose рассмотрена в книге: 
Боггс У., Боггс М. UML и Rational Rose 2002: Пер. с англ. - М.: ЛОРИ, 2004. 
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3. Выберите Tools > ANSI C-f-f > Generate Code в меню. 
4. Выберите каталог для генерации кода. 
5. Щелкните по кнопке ОК и выполните генерацию в окне ге­

нерации кода. 
6. Просмотрите результаты генерации (меню Tools > С+-ь > 

Browse Header и Tools > С-Ь+ > Browse Body). 
Результаты генерации должны выглядеть следующим образом. 

Файл Student.h: 

#ifndefSTUDENT_H_HEADER_INCLUDED_BE29599B 
#defineSTUDENT_H_HEADER_INCLUDED_BE29599B 

//##ModelId=35A6336C03DE 
class Student 
{ 
public: 
//##ModelId=360EBEFA015E 
double getTuitionO; 

//##ModelId=374AFB93006B 
addSchedule(Schedule theSchedule); 

//##ModelId=374AFBDA0117 
Schedule getSchedule(Semester forSemester); 

//##ModelId=374B00540183 
deIeteSchedule(Semester forSemester); 

//##ModelId=374B02690049 
boolean hasPrerequisites(CourseOffering forCourseOffering); 

//##ModelId=37812F3903C4 
int getNextAvaillDO; 

//##ModelId=379779F60364 
intgetStudentlDO; 

//##ModelId=37BE859E00CA 
string getNameO; 
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//##ModelId=37BF215800D8 
string getAddressO; 

protected: 
//##ModelId=3781276401OE 
boolean passed(CourseOffering theCourseOffering); 

private: 
//##ModelId=35E9A8EA00BE 
string name; 

//##ModelId=374D92DE019A 
string address; 

//##ModelId=37812F2301 D8 
int nextAvaillD; 

//##ModelId=378130B900EB 
int studentID; 

//##ModelId=378BE6A5015D 
Date dateoffiirth; 

}; 

#endif/* STUDENT_H_HEADER_INCLUDED_BE29599B */ 

Файл Studentxpp: 

#include "Student, h" 

//##ModelId=360EBEFA015E 
double Student: :getTuition() 
{ 
} 

//##ModelId=374AFB93006B 
Student: :addSchedule(Schedule theSchedule) 
{ 
} 
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//##ModelId=374AFBDA0117 
Schedule Student: :getSchedule(Semester forSemester) 

//##ModelId=374B00540183 
Student::deleteSchedule(Semester forSemester) 

//##ModelId=374B02690049 
boolean Student::hasPrerequisites(CourseOffering forCourseOffering) 

//##ModelId=37812F3903C4 
int Student::getNextAvailID() 

//##ModelId=379779F60364 
int Student: :getStudentID() 

//##ModelId=37BE859E00CA 
string Student::getName() 

//##ModelId=37BF215800D8 
string Student: :getAddress() 

//##ModelId=37812764010E 
boolean Student::passed(CourseOffering theCourseOffering) 



ПРИЛОЖЕНИЯ 

1 . ДОКУМЕНТЫ СИСТЕМЫ РЕГИСТРАЦИИ КУРСОВ 

КОНЦЕПЦИЯ 

1 . Введение 

1.1. Цель 

Цель этого документа - определить требования высокого уровня 
к системе регистрации курсов (СРК) в терминах потребностей ко­
нечных пользователей. 

1.2. Область применения 

В данном документе рассматривается система СРК, разрабаты­
ваемая информационной службой университета. Клиент-серверная 
система СРК должна взаимодействовать с существующей базой дан­
ных каталога курсов. 

Система регистрации курсов позволит студентам регистриро­
ваться на курсы в онлайновом режиме, а профессорам — указывать 
курсы, которые они будут читать, и ставить оценки за курсы. 

1.3. Определения, акронимы и сокращения 

См. Глоссарий. 

2 . Основные положения 

2.1 . Возможности системы 

Новый проект полностью заменит внешний интерфейс суще­
ствующей системы регистрации курсов на современную диалого­
вую систему, которая позволит студентам и профессорам осуще­
ствлять доступ с персональных компьютеров. 

Существующая система регистрации используется с 1985 г. и об­
ладает недостаточной пропускной способностью. Кроме того, уста-
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ревшая технология универсальной ЭВМ позволяет поддерживать 
доступ только через сотрудника деканата. Новая система позволит 
всем профессорам и студентам получить доступ к системе через ПК, 
связанные с университетом компьютерной сетью, и через любой 
персональный компьютер, подключенный к интернету 

Новая система обеспечит университету ведущую позицию в об­
ласти компьютерных систем регистрации курсов и, таким образом, 
улучшит его репутацию, привлечет'больше студентов и упростит 
процесс администрирования. 

2.2. Формулировка проблемы 

Проблема 

Затрагивает 

Последствия 

Успешное решение 
позволит 

Устаревший и в значительной степени неавтомати­
зированный процесс регистрации студентов в уни­
верситете 

Студентов, профессоров и администрацию уни­
верситета 

Медленный и дорогостоящий процесс регистра­
ции, неудовлетворенность студентов и профессо­
ров 

Улучшить репутацию университета, привлечь 
больше студентов и упростить процесс админист­
рирования 

2.3. Формула продукта 

|Для 

Которые 

1 СРК является 

Который 

В отличие от 

Наш продукт 

Студентов университета, профессоров и регистра­
тора курсов 

Посещают, преподают или администрируют курсы 
университета 
Инструментом | 

Обеспечит диалоговую регистрацию на курсы и до­
ступ к информации 0 курсах и оценках | 
Существующей устаревшей системы регистрации 
на базе универсальной ЭВМ 

Обеспечит получение своевременной информации 
относительно всех курсов, регистрации, препода­
вателей и оценок для всех пользователей любых 
ПК через ЛВС университета или интернет 
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3. Описание заинтересованных лиц и пользователей 

В этом разделе описаны три существующих типа пользователей 
СРК: регистратор курсов, студенты и профессора. 

3.1. Потенциальные потребители 

Университетское сообщество пользователей - большое и слож­
ное сообщество, которому требуются гибкие и высокопроизводи­
тельные системы диалоговой регистрации на курсы. 

Пользователи обладают высоким уровнем образования, ком­
пьютерной грамотности и в большинстве случаев имеют домашние 
персональные компьютеры. Возможность регистрироваться на кур­
сы посредством персональных компьютеров и просматривать свои 
оценки существенно упростила бы процесс регистрации. Студенты и 
профессора имеют свободный доступ к локальной сети университе­
та через персональные компьютеры, расположенные в библиотеке 
университетского городка и студенческом корпусе. 

Распространение первой версии СРК будет ограничено самим 
университетом. Возможность распространения последующих версий 
для других школ и университетов будет рассмотрена информацион­
ной службой университета. В этом случае СРК будет разработана с 
учетом возможности ее конфигурирования в процессе установки. 

3.2. Заинтересованные лица 

Наименование 

Директор ин­
формацион­
ной службы 
Регистратор 
(сотрудник де­
каната) 

Студент 

Профессор 

Представляет 

Информацион­
ную службу и уни­
верситет в целом 
Службу регистра­
ции, администра­
тивный персонал 
и персонал, зани­
мающийся подго­
товкой данных 
Студентов 

Профессоров 

Роль 

Отвечает за финансирование проекта 
и контроль за ходом работ 

Удостоверяет, что система соответст­
вует потребностям регистратора, ко­
торые заключаются в управлении 
данными регистрации курса, вклю­
чая базы данных профессоров и сту­
дентов 
Удостоверяет, что система соответст­
вует потребностям студентов | 
Представляет интересы факультета 
(профессоров) 
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3.3. Пользователи 
Наименование 

Регистратор 

Студент 

Профессор 

Описание 

Управляет базой данных профессоров и студентов, от­
крывает и закрывает процесс регистрации 

Регистрируется на курсы, запрашивает оценки и дру­
гую информацию 0 курсах 

Выбирает курсы для преподавания. Ставит оценки сту­
дентам 

3.4. Пользовательская среда 

Пользовательская среда включает персональные компьютеры, 
Windows ХР/2000. 

3.5. Основные потребности заинтересованных 
лиц/пользователей 

Группа представителей, включающая студентов, профессоров и 
регистратора, составила обзор, содержащий проблемы, которые воз­
никают у пользователей существующей системы регистрации курса, 
и предложения по ее усовершенствованию. Резюме результатов об­
зора приведено ниже (в порядке их относительной важности): 

Потреб­
ность 

Регистра­
ция сту­
дентов на 
курсы 

Приори­
тет 

Высокий 

Проблема 

Регистрация 
студентов на 
курсы мед­
ленная и не­
эффективная 

Существующее 
решение 

В настоящее время 
студенты должны 
заполнить форму 
регистрации на 
курсы и предста­
вить ее регистрато­
ру Регистратору 
требуется около 
двух недель, чтобы 
обработать форму, 
и еще неделя, что­
бы послать под­
тверждение студен­
ту Любые измене­
ния в расписании 
из-за заполненнос­
ти курсов или из-

Предла-
гаемые 

решения 
Студенты хо­
тели бы 
иметь диало­
ге вый доступ 
к системе, 
чтобы быст­
ро опреде­
лять доступ­
ность курсов 
и назначен­
ных профес­
соров 
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Продолжение 

Потреб­
ность 

Быстрый 
доступ к 
оценкам 
студентов 

Низкие 
наклад­
ные рас­
ходы 

Приори­
тет 

Средний 

Средний 

Проблема 

Большие 
затраты вре­
мени на по­
лучение ин­
формации об 
оценках, по­
стоянные 
обращения к 
профессорам 

Организаци­
онная работа 
занимает 
много вре­
мени и доро­
гостояща 

Существующее 
решение 

менений в предпо­
чтениях студентов 
требуют, чтобы 
трехнедельный 
процесс был повто­
рен. Это офаничи-
вает возможности 
выбора курсов 

Заполненные табе­
ли успеваемости 
обычно отправля­
ют студентам спус­
тя восемь недель 
после начала экза­
менационного пе­
риода. В это время 
студенты непре­
рывно звонят сво­
им профессорам, 
пытаясь узнать 
оценки как можно 
быстрее 

Регистратору и 
двум-трем времен­
ным служащим тре­
буется 400-500 ч 
в каждом семестре, 
чтобы обработать 
документы регист­
рации курсов. 
Большая часть это­
го времени тратит­
ся на ввод инфор­
мации в главную 
базу данных регис­
трации курсов и 
перерегистрацию 
студентов на дру­
гие курсы при раз­
решении конфлик­
тов фафика и про­
блем доступности 
курсов 

- , .J 

Предла­
гаемые 

решения 

Диалоговый 
доступ к ин­
дивидуаль­
ным оцен­
кам был ре­
комендован 
большинст­
вом студен­
тов, участво­
вавших в об­
зоре 

Доступ сту­
дентов к сис­
теме регист­
рации курсов 
мог бы ис­
ключить эти 
расходы 
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4. Обзор продукта 

Данный раздел содержит общее описание возможностей СРК, ее 
внешних интерфейсов с расчетной системой и базой данных катало­
га курсов, а также конфигурации. 

4.1 . Перспективы продукта 

Система регистрации курсов заменит существующую систему 
регистрации курсов университета на базе универсальной ЭВМ. Но­
вая система будет взаимодействовать с существующей расчетной си­
стемой и базой данных каталога курсов. 

Система регистрации курсов будет состоять из клиентского и 
серверного компонентов. 

Компонент клиента размещается на персональном компьютере 
и будет установлен на всех ПК университета. Любой ПК, который 
находится вне университета, должен зафузить программное обеспе­
чение клиента с Unix-сервера через интернет. Как только компонент 
клиента будет установлен на ПК, пользователь может получить до­
ступ к СРК через локальную сеть университета или интернет Для 
доступа необходимо получить идентификатор и пароль. 

Компонент сервера размещается на Unix-сервере университета и 
должен взаимодействовать с расчетной системой и базой данных ка­
талога курсов на универсальной ЭВМ университета. 

4.2. Возможности продукта 

Ниже приведены основные возможности СРК в терминах ее 
свойств и достоинств с точки зрения потребителей. Свойства систе­
мы описаны в разд. 5. 

Достоинство 

Своевременная инфор­
мация 0 курсах 

Свойство системы 

Система имеет доступ к базе данных каталога 
курса для получения своевременной информа­
ции относительно всех курсов, предлагаемых в 
университете. 
Студенты и профессора могут просмотреть опи­
сание каждого курса, требования к предшеству­
ющим курсам, назначенных преподавателей, ме­
стоположение классов и время занятий 
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Продолжение 

Достоинство 

Своевременная инфор­
мация 0 регистрации 

Простой и своевремен­
ный доступ к оценкам 
за курсы 

Доступ с любого ПК 
университета 

Простой и удобный до­
ступ с домашнего ПК 

Безопасность и конфи­
денциальность 

Мгновенное информи- | 
рование о заполненных 
или отмененных курсах 

Свойство системы 

Все регистрации на курсы немедленно фиксиру­
ются в базе данных регистрации, чтобы обеспе­
чить своевременную информацию относительно 
заполненных или отмененных курсов 

Студенты могут просматривать свои оценки за 
любой курс, указывая свои идентификатор и па­
роль. 
Студенты могут получить доступ к системе реги­
страции с любого ПК университета или с домаш­
него ПК через интернет. 
Профессора вводят все оценки непосредственно 
в базу данных регистрации со своих ПК 

Студенты могут получить доступ к системе реги­
страции с любого ПК университета или со свое­
го домашнего ПК через интернет 
Установку компонента клиента системы регист­
рации на ПК легко выполнить через интернет 

Студенты могут получить доступ к системе реги­
страции с любого ПК университета или со свое­
го домашнего ПК через интернет 

Для доступа к системе регистрации необходимы 
пользовательский идентификатор и пароль. 
Студенческий табель успеваемости защищен от 
несанкционированного доступа 

Все регистрации на курсы немедленно фиксиру­
ются в базе данных регистрации, чтобы обеспе­
чить своевременную информацию относительно 
заполненных или отмененных курсов 

4.3. Проектные ограничения 

Существующие расчетная система и база данных каталога кур­
сов, которые размещаются на универсальной ЭВМ университета, 
будут поддерживаться по крайней мере до 2008 г 

Внешние интерфейсы расчетной системы и базы данных катало­
га курсов не будут изменены. 
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Предполагается, что университет продолжит использовать и 
поддерживать существующий Unix-сервер и универсальную ЭВМ по 
крайней мере до 2008 г 

Предполагается, что к 2008 г будет получено дополнительное 
финансирование для замены расчетной системы и базы данных ка­
талога курсов. 

Реализация новой системы регистрации, запланированная на 
январь 2007 г, зависит от того, будет ли утверждено финансирование 
к 1 марта 2006 г 

4.4. Стоимость проекта 

Затраты на разработку системы не должны превышать 
1 200 000 долл. в связи с тем, что финансирование ограниченно. 

Ожидается, что будут использоваться существующие компьюте­
ры университета и не потребуется затрат на приобретение аппарат­
ных средств. 

4.5. Лицензирование и установка 

К версии 1.0 системы не предъявляется никаких требований ли­
цензирования, поскольку она будет использоваться только в универ­
ситете. 

Установка клиентского компонента должна быть доступна с дис­
кеты, компакт-диска или из интернета. 

Установка серверного компонента должна обеспечить варианты 
сохранения существующей базы данных регистрации (без потери 
данных) или генерации новой базы данных. 

5. Функциональные возможности продукта 

В данном разделе определены и описаны высокоуровневые 
функциональные возможности (свойства) системы регистрации, ко­
торые необходимы с точки зрения пользователей. 

5 . 1 . Вход в систему 

Студенты, профессора и регистратор должны располагать иден­
тификатором и паролем для входа в систему регистрации. На период 
приема в университет пользователи получают идентификатор и вре­
менный пароль. Система должна позволять пользователю изменить 
свой временный пароль. 
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5.2. Регистрация на курсы 

Система должна выводить по запросу студента доступные курсы. 
Студент может указывать в запросе наименование курса, код курса и 
кафедру (факультет). Система должна регистрировать студентов на 
курсы в соответствии с их доступностью, конфликтами фафика и 
предварительным прохождением необходимых курсов. Если регист­
рация на курс невозможна, система должна немедленно уведомить 
студента об этом. 

Система должна позволять студенту изменить свой выбор курсов 
до окончания периода регистрации. 

5.3. Отмена курсов 

Система доджна позволять регистратору отменять курсы. Регис­
тратор обычно рассматривает все курсы в конце периода регистра­
ции и отменяет курсы, которые никто не ведет или на которые запи­
салось менее трех студентов. Регистратор уведомляет студентов об 
отмене курсов по телефону или почте. 

5.4. Расчеты за курсы 

Система СРК должна посылать уведомления расчетной системе 
после закрытия регистрации. Эти уведомления должны включать 
имя студента, его адрес, информацию о выбранных курсах и размер 
оплаты. 

5.5. Ввод, обновление и просмотр информации 
о профессорах 

Система должна вводить и обновлять информацию о профессо­
рах, включая имя, адрес, телефон, факс и адрес электронной почты. 
Информация о профессорах должна быть доступна профессорам и 
регистратору для просмотра. 

5.6. Просмотр оценок студентов 

Система должна позволять студенту просматривать оценки по 
отдельным курсам или полный табель успеваемости. Система долж­
на защищать информацию об оценках студента от доступа любого 
другого пользователя, кроме самого студента и профессоров. 
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5.7. Выбор курсов для преподавания 

Система должна позволять профессорам выбирать курсы для 
преподавания до окончания периода регистрации. 

5.8. Ввод, обновление и просмотр информации 
о студентах 

Система должна вводить и обновлять информацию о студентах, 
включая студенческий ID, имя, адрес, телефон и адрес электронной 
почты. Информация о студентах должна быть доступна профессорам 
и регистратору для просмотра. Система должна гарантировать, что 
только студент имеет доступ к собственной информации. Регистра­
тор ведет информацию о студентах. 

5.9. Запись оценок студентов 

Система должна сохранять оценки, введенные профессором. 

5.10. Просмотр каталога курсов 

Информация каталога курсов, содержащаяся в базе данных, 
должна выводиться по запросу пользователя, включающему наиме­
нование и код курса, имя профессора и наименование кафедры. 

5.11. Просмотр графика курсов 

Система должна выводить полный фафик курсов для конкрет­
ного студента по его запросу. 

5.12. Мониторинг заполнения курсов 

Система должна гарантировать, что ни на один курс не будет за­
писано более 10 студентов. 

6. Ограничения 
Список, приведенный в подразд. 4.3, дополняют следующие ог­

раничения: 
• система не должна требовать никакого развития или приобре­

тения аппаратных средств; 
• доступная информация о курсах ограничена данными, поддер­

живаемыми в существующей базе данных каталога курсов. 
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7. Требования к качеству 

В данном разделе определены требования к производительнос­
ти, надежности, удобству использования и другим характеристикам 
качества системы регистрации. 

Готовность: работоспособное состояние 24 ч в день 7 дней в не­
делю. 

Удобство использования: должна быть простой в использовании 
для студентов и профессоров, а также включать диалоговую помощь 
и не требовать использования твердой копии руководств. 

Сопровождаемость: должна обеспечивать простоту сопровожде­
ния. Все данные университета должны изменяться без перекомпиля­
ции системы. 

8. Приоритеты 

Данный раздел определяет относительную важнбсть предлагае­
мых функциональных возможностей системы, которые должны 
быть включены в первые два выпуска системы. Реализация зсех воз­
можностей, касающихся регистрации студентов на курсы, должна 
быть запланирована в выпуске 1. 

Ожидается, что система регистрации начнет эксплуатироваться в 
университете через два-четыре основных выпуска. 

Выпуск 1 должен содержать как минимум следующие основные 
функциональные возможности: 

• вход в систему; 
• регистрацию на курсы; 
• интерфейс с базой данных каталога курсов; 
• ведение информации о студентах; 
• ведение информации о профессорах. 
Выпуск 2 должен включать: 
• проставление оценок студентам; 
• просмотр оценок; 
• выбор курсов для преподавания. 
Функциональные возможности для выпуска 3 еще не определе­

ны. Ожидается, что этот выпуск будет содержать расширение суще­
ствующих функциональных возможностей. 

Замена существующих расчетной системы и базы данных ката­
лога курсов намечается в выпуске 4 в 2008 г 
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9. Прочие требования к продукту 

9.1. Используемые стандарты 
Пользовательский интерфейс должен быть Windows ХР/2000-

совместимым. 

9.2. Системные требования 

В системе должны быть предусмотрены интерфейсы с существу­
ющей базой данных каталога курсов и расчетной системой. 

Серверный компонент системы должен функционировать на 
сервере университетского городка под управлением Unix. 

Клиентский компонент системы должен функционировать на 
любом персональном компьютере под управлением Windows 
ХР/2000. 

Клиентский компонент системы не должен требовать дисковой 
памяти больше, чем 256 Мбайт RAM и 20 Мбайт. 

9.3. Требования к производительности 

Система должна поддерживать до 2000 пользователей, работаю­
щих с центральной базой данных в любое время, и до 500 пользова­
телей, одновременно работающих с локальными серверами в любой 
момент. 

Система должна обеспечивать доступ к базе данных каталога 
курсов в течение не более 10 с. 

Система должна завершать 80 % всех транзакций в течение 
2 мин. 

9.4. Требования к окружающей среде 

Отсутствуют. 

10. Требования к документации 

10.1. Руководство пользователя 

Руководство пользователя должно описывать использование си­
стемы с точки зрения студентов, профессоров и регистратора и 
включать: 
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• минимальные системные требования; 
• установку ПК-клиента; 
• вход в систему; 
• выход из системы; 
• все функциональные возможности системы; 
• информацию о поддержке пользователей. 
Руководство пользователя должно иметь объем от 50 до 100 стра­

ниц с размером страницы 7х 9 дюймов. Руководство пользователя 
должно быть доступно как в твердой копии, так и в онлайновом ре­
жиме. 

10.2. Диалоговая помощь 

Диалоговая помощь должна быть доступна пользователю для 
каждой функции системы. 

10.3. Руководство по установке, конфигурированию 
и файл Read Me 
Руководство по установке для серверной части должно включать: 
• минимальные системные требования; 
• инструкции по установке; 
• конфигурирование под конкретные параметры университета; 
• инициализацию базы данных регистрации; 
• сохранение существующей базы данных регистрации; 
• информацию о поддержке пользователей; 
• информацию о получении обновлений. 
Файл Read Me должен быть доступен во время установки в любое 

время и размещаться на диске. Файл Read Me должен включать: 
• возможности нового выпуска; 
• сведения об устраненных дефектах. 

10.4. Маркировка и упаковка 

Пользовательская документация и экранные заставки должны 
содержать логотип университета. 

Поскольку начальные выпуски предназначены только для уни­
верситета, маркетинговая литература и рекламные материалы разра­
батываться не будут. 
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Вариант использования "Выбрать курсы для 
преподавания": 

Краткое описание: 
Данный вариант использования позволяет профессору выбрать 

из каталога курсов курсы, которые он желает вести в предстоящем 
семестре. 

Основной поток событий: 
Данный вариант использования начинает выполняться, когда 

профессор выбирает из каталога курсов курсы, которые он желает 
вести в предстоящем семестре. 

1. Система выполняет поиск и выводит список предлагаемых 
курсов, которые профессор может вести в текущем семестре, а также 
список курсов, которые профессор выбрал ранее. 

2. Профессор выбирает и/или отменяет курсы, которые он жела­
ет вести в предстоящем семестре. 

3. Система удаляет связь между профессором и отмененным кур­
сом. 

4. Система подтверждает отсутствие конфликтов между выбран­
ными курсами (совпадение даты и времени) и обновляет информа­
цию для каждого выбранного курса (включает данные профессора). 

Альтернативные потоки: 
Отсутствуют доступные курсы: 
Если во время выполнения основного потока обнаружится, что 

профессор не может вести никаких курсов в предстоящем семестре, 
система выводит сообщение об ошибке. Когда профессор подтверж­
дает прием сообщения, выполнение варианта использования завер­
шается. 

Конфликт графика: 
Если система обнаружит конфликт фафика, будет выведено со­

общение об ошибке. Система должна также указать, какие курсы 
конфликтуют. Профессор может либо разрешить конфликт (напри­
мер, отменив выбор одного из курсов), либо отменить всю опера­
цию, при этом информация о выборе не сохраняется и выполнение 
варианта использования завершается. 

Недоступен каталог курсов: 
Если система не может установить связь с каталогом курсов, 

выводится сообщение об ошибке. Когда профессор подтверждает 
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прием сообщения, выполнение варианта использования завер­
шается. 

Регистрация на курсы закончена: 
Если в самом начале варианта использования выясняется, что 

регистрация на текущий семестр закончена, выводится сообщение и 
выполнение варианта использования завершается. После заверше­
ния регистрации профессор не может вносить изменения в курсы. 
Если такая необходимость возникнет, она реализуется за пределами 
данной системы. 

Специальные требования: 
Отсутствуют. 
Предусловия: 
Перед началом выполнения данного варианта использования 

профессор должен войти в систему. 

Вариант использования "Проставить оценки" 

Краткое описание: 
Данный вариант использования позволяет профессору проста­

вить оценки студенту за один курс или больше курсов, прослушан­
ных в течение семестра. 

Основной поток событий: 
Данный вариант использования начинает выполняться, когда 

профессор хочет проставить студенту оценки за один курс или боль­
ше курсов, прослушанных в течение семестра. 

1. Система выводит список курсов, которые профессор вел в те­
чение семестра. 

2. Профессор выбирает курс. 
3. Система выполняет поиск и выводит список всех студентов, 

зарегистрировавшихся на данный курс. Для каждого студента выво­
дятся все оценки, полученные ранее. 

4. Для каждого студента в списке профессор вводит оценку: 2, 3, 
4 или 5. Система записывает оценку. Если профессор хочет пропус­
тить какого-либо студента, поле информации об оценке может быть 
оставлено незаполненным и будет заполнено позднее. Профессор 
также может изменить оценку и ввести новую оценку 
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Альтернативные потоки: 
Отсутствуют курсы: 
Если во время выполнения основного потока обнаружится, что 

профессор не вел никаких курсов в данном семестре, система выво­
дит сообщение об ошибке. Когда профессор подтверждает прием со­
общения, выполнение варианта использования завершается. 

Специальные требования: 
Отсутствуют. 
Предусловия: 
Перед началом выполнения данного варианта использования 

профессор должен войти в систему. 

Вариант использования "Просмотреть табель 
успеваемости" 

Краткое описание: 
Данный вариант использования позволяет студенту просмотреть 

свой табель успеваемости после завершения семестра. 
Основной поток событий: 
Данный вариант использования начинает выполняться, когда 

студент хочет просмотреть свой табель успеваемости после заверше­
ния семестра. 

1. Система выполняет поиск и отображение информации об оцен­
ках за каждый из курсов, оконченных студентом в течение семестра. 

2. Когда студент указывает, что он завершил просмотр оценок, 
выполнение варианта использования завершается. 

Альтернативные потоки: 
Информация об оценках недоступна: 
Если во время выполнения основного потока система не может 

найти какую-либо информацию об оценках, выводится соответству­
ющее сообщение. Когда студент подтверждает прием сообщения, 
выполнение варианта использования завершается. 

Специальные требования: 
Отсутствуют. 
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Предусловия: 
Перед началом выполнения данного варианта использования 

студент должен войти в систему 

Вариант использования "Вести информацию 
о профессорах" 

Краткое описание: 
Данный вариант использования позволяет регистратору 

вести информацию о профессорах (добавлять, удалять и изменять 
данные). 

Основной поток событий: 
Данный вариант использования начинает выполняться, когда 

регистратор хочет добавить, удалить и/или изменить данные о про­
фессорах. 

1. Система запрашивает требуемое действие (создать, обновить 
или удалить данные о профессорах). 

2. Когда регистратор указывает действие, выполняется один из 
подчиненных потоков. 

Добавить данные профессора: 
1. Система запрашивает у регистратора ввод информации о про­

фессоре. Она включает: имя, дату рождения, номер страхового сви­
детельства, наименование должности, кафедры. 

2. После ввода требуемой информации система формирует уни­
кальный идентификационный номер профессора и сохраняет дан­
ные о нем. 

Обновить данные профессора: 
1. Система запрашивает у регистратора ввод идентификатора 

профессора. 
2. Регистратор вводит идентификатор. Система выполняет поиск 

и выводит информацию о профессоре. 
3. Регистратор выполняет требуемые изменения. 
4. Система обновляет данные о профессоре. 
Удалить данные о профессоре: 
1. Система запрашивает у регистратора ввод идентификатора 

профессора. 
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2. Регистратор вводит идентификатор. Система выполняет поиск 
и выводит информацию о профессоре. 

3. Система запрашивает у регистратора подтверждение того, что 
информация о профессоре удалена. 

4. Регистратор подтверждает удаление 
5. Система удаляет данные о профессоре. 

Альтернативные потоки: 
Профессор не найден: 
Если во время выполнения подчиненных потоков "Обновить 

данные профессора" или "Удалить данные о профессоре" выясняет­
ся, что профессора с заданным идентификатором не существует, то 
выдается сообщение об ошибке. Регистратор может ввести другой 
идентификатор либо отменить операцию, после чего вариант ис­
пользования завершится. 

Профессор уже существует: 
Если во время выполнения подчиненного потока "Добавить дан­

ные профессора" обнаруживается, что профессор с таким именем уже 
существует, то выдается сообщение об ошибке. Регистратор может из­
менить имя, ввести данные нового профессора с таким же именем или 
отменить операцию, после чего вариант использования завершится. 

Специальные требования: 
Отсутствуют. 
Предусловия: 
Перед началом выполнения данного варианта использования 

регистратор должен войти в систему 

Вариант использования "Вести информацию 
о студентах" 

Краткое описание: 
Данный вариант использования позволяет регистратору вести 

информацию о студентах (добавлять, удалять и изменять данные). 
Основной поток событий: 
Данный вариант использования начинает выполняться, когда ре­

гистратор хочет добавить, удалить и/или изменить данные о студентах. 
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1. Система запрашивает требуемое действие (создать, обновить 
или удалить данные о студентах). 

2. Когда регистратор указывает действие, выполняется один из 
подчиненных потоков. 

Добавить данные студента: 
1. Система запрашивает у регистратора ввод информации о сту­

денте. Она включает: имя, дату рождения, номер страхового свиде­
тельства, дату поступления. 

2. После ввода требуемой информации система формирует уникаль­
ный идентификационный номер студента и сохраняет данные о нем. 

Обновить данные студента: 
1. Система запрашивает у регистратора ввод идентификатора 

студента. 
2. Регистратор вводит идентификатор. Система выполняет поиск 

и выводит информацию о студенте. 
3. Регистратор выполняет требуемые изменения. 
4. Система обновляет данные о студенте. 
Удалить данные о студенте: 
1. Система запрашивает у регистратора ввод идентификатора 

студента. 
2. Регистратор вводит идентификатор. Система выполняет поиск 

и выводит информацию о студенте. 
3. Система запрашивает у регистратора подтверждение того, что 

информация о студенте удалена. 
4. Регистратор подтверждает удаление 
5. Система удаляет данные о студенте. 
Альтернативные потоки: 
Студент не найден: 
Если во время выполнения подчиненных потоков "Обновить 

данные студента" или "Удалить данные о студенте" обнаружится, что 
студента с заданным идентификатором не существует, то выдается 
сообщение об ошибке. Регистратор может ввести другой идентифи­
катор либо отменить операцию, после чего вариант использования 
завершится. 

Студент уже существует: 
Если во время выполнения подчиненного потока "Добавить дан­

ные студента" обнаружится, что студент с таким именем уже сущест-
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вует, то вьщается сообщение об ошибке. Регистратор может изме­
нить имя, ввести данные нового студента с таким же именем или от­
менить операцию, после чего вариант использования завершится. 

Специальные требования: 
Отсутствуют. 

Предусловия: 
Перед началом выполнения данного варианта использования 

регистратор должен войти в систему. 

2. МЕТОДИЧЕСКИЕ УКАЗАНИЯ 
ПО КУРСОВОМУ ПРОЕКТИРОВАНИЮ 

ТЕМАТИКА КУРСОВОГО ПРОЕКТА И ЗАДАНИЯ 
ПО ЕГО ВЫПОЛНЕНИЮ 

Тематика курсового проекта ориентирована на разработку систе­
мы для решения конкретных прикладных задач в заданной предмет­
ной области. 

Основное задание курсового проекта — это построение моделей 
ПО с помощью инструментального средства Rational Rose. Процесс 
создания модели состоит из нескольких этапов. 

Э т а п 1. Составление глоссария проекта. 
Э т а п 2. Создание модели вариантов использования. 
Э т а п 3. Анализ вариантов использования. 
Э т а п 4. Проектирование системы. 
Процесс создания модели должен проходить так, как это описа­

но э настоящем практикуме. Структура модели в браузере Rose 
должна соответствовать структуре, предусмотренной технологией 
Rational Unified Process. 

После выполнения третьего этапа модель должна удовлетворять 
следующим требованиям: 

• глоссарий проекта должен иметь вид таблицы и храниться в от­
дельном файле; 

• на диафаммах вариантов использования каждое действующее 
лицо и вариант использования должны сопровождаться описанием. 
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Описание действующего лица должно коротко (в одну-две строки) 
характеризовать роль данного лица. Описание варианта использова­
ния должно включать пояснение, предусловие, потоки событий (ос­
новной и альтернативные, если таковые имеются) и постусловие. 
Описания представляют собой либо присоединенные текстовые 
файлы, либо текст, введенный в поле Documentation спецификации 
соответствующего элемента диафаммы; 

• диафаммы взаимодействия, соответствующие потокам собы­
тий вариантов использования, должны содержать необходимые по­
яснения. 

При проектировании системы требуется: 
• создать иерархию классов системы; 
• разместить классы по пакетам (в зависимости от постановки 

задачи); 
• связать объекты с классами, сообщения на диафаммах взаимо­

действия — с операциями; 
• сопроводить кратким описанием каждый класс (обязанности 

класса), описанием атрибутов в виде таблицы (имя, описание, тип) и 
таблицей с описанием операций (имя, описание, сигнатура); 

• указать стереотипы для классов; 
• построить диафаммы классов системы, отображающие связи 

между классами; 
• построить диафаммы состояний для описания поведения объ­

ектов отдельных классов; 
• разработать (если фебуется) схему базы данных и отобразить ее 

на диафамме "сущность-связь". 
Следует также разработать диафамму размещения. В зависимос­

ти от варианта задания диафамма размещения должна показывать 
расположение компонентов в распределенном приложении. 

Структура курсового проекта 

Курсовой проект должен состоять из четырех глав и заключения. 
Первая глава "Постановка задачи" должна содержать формули­

ровку задания. 
Вторая глава "Анализ требований" должна содержать глоссарий, 

диафамму вариантов использования, описания действующих лиц и 
вариантов использования. 

Третья глава "Анализ системы" должна содержать диаграммы 
взаимодействия между объектами (последовательности и коопера-
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тивные), соответствующие потокам событий вариантов использова­
ния. При необходимости можно включить диаграммы деятельности 
и сопроводить их пояснениями, указывающими, какому потоку со­
бытий они соответствуют (если это не ясно из их названия), и ком­
ментариями. 

Четвертая глава "Проектирование" должна содержать иерархию 
классов системы и описание пакетов. Для каждого класса системы 
дается описание, которое включает: ответственность класса, описа­
ние атрибутов в виде таблицы из трех столбцов: имя, описание, тип; 
таблицу с описанием операций (имя, описание, сигнатура). Должны 
быть приведены диафаммы классов системы, отображающие связи 
между классами, и диаграммы состояний, описывающие поведение 
экземпляров отдельных классов. Также приводится диаграмма раз­
мещения с комментариями. Если вариант предполагает создание 
схемы базы данных, то такая схема также должна быть включена в 
отчет. 

В заключение должен быть подведен итог и оценены результаты 
работы. 

3. ТЕМЫ КУРСОВОГО ПРОЕКТА 

Система начисления заработной платы 

Перед информационной службой компании поставлена задача 
создания новой системы начисления заработной платы взамен мо­
рально устаревшей существующей системы. Новая система должна 
предоставлять служащим возможность записывать электронным 
способом информацию из карточки учета рабочего времени и авто­
матически формировать чеки на оплату, учитывающие количество 
отработанных часов и общий объем продаж (для служащих, получа­
ющих комиссионное вознафаждение). 

Новая система должна предоставлять служащим возможность 
вводить информацию из карточки учета рабочего времени и заказы 
на поставку, изменять свои параметры (такие, как способ оплаты за 
работу) и формировать различные отчеты. Система должна работать 
на персональных компьютерах служащих всей компании. В целях 
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обеспечения безопасности и аудита служащие должны иметь воз­
можность доступа и редактирования только своих собственных кар­
точек учета рабочего времени и заказов на поставку 

В системе должна храниться информация обо всех служащих 
компании, в том числе работающих в различных странах. Система 
должна обеспечивать правильную и своевременную оплату труда 
каждого служащего в соответствии с указанным им способом. Ком­
пания из соображений экономии расходов желает сохранить без из­
менений одну из существующих баз данных (БД управления проек­
тами), которая содержит всю информацию относительно проектов и 
тарифов. База данных управления проектами функционирует в сре­
де DB2 на мейнфрейме IBM. Новая система может читать данные из 
БД управления проектами, но не может обновлять их. 

Некоторые служащие получают почасовую заработную плату, 
которая начисляется на основе карточек учета рабочего времени, 
каждая из которых содержит дату и количество часов, отработанных 
в соответствии с конкретным тарифом. Если какой-либо служащий 
отработал в день больше 8 ч, сверхурочное время оплачивается с ко­
эффициентом 1,5. Служащие-почасовики получают заработную 
плату каждую пятницу. 

Некоторые служащие получают фиксированный оклад, однако 
они тоже представляют свои карточки учета рабочего времени. Бла­
годаря этому система может вести учет количества часов, отработан­
ных в соответствии с конкретными тарифами. Такие служащие полу­
чают заработную плату в последний рабочий день месяца. 

Некоторые из служащих, получающих фиксированный оклад, 
также получают комиссионное вознаграждение, учитывающее объ­
ем продаж. Они представляют заказы на поставку, отражающие дату 
и объем продаж. Процент комиссионного вознафаждения опреде­
ляется индивидуально для каждого служащего и может составлять 
10%, 15, 25 или 35%. 

Одной из наиболее часто используемых возможностей новой си­
стемы является формирование различных отчетов: запросить коли­
чество отработанных часов, суммарную заработную плату, оставше­
еся время отпуска и т.д. 

Служащие могут выбирать способ оплаты за работу и получать 
свои чеки на оплату по почте, на счет в банке или на руки в офисе. 

Администратор системы ведет информацию о служащих. В его 
обязанности входят ввод данных о новых служащих, удаление дан­
ных и изменение любой информации о служащем, такой, как имя, 
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адрес и способ оплаты, а также формирование различных отчетов 
для руководства. 

Приложение начисления заработной платы запускается автома­
тически каждую пятницу и в последний рабочий день месяца для 
расчета в эти дни заработной платы соответствующих служащих. На­
числение заработной платы должно проводиться автоматически, без 
ручного вмешательства. 

Интернет-магазин 

Производитель компьютеров предлагает приобретать свою про­
дукцию через интернет. Клиент может выбрать компьютер на Web-
странице производителя. Компьютеры подразделяются на серверы, 
настольные и портативные. Заказчик может выбрать стандартную 
конфигурацию или построить требуемую в диалоговом режиме. 
Компоненты конфигурации (такие, как оперативная память) пред­
ставляются в виде списка для выбора из доступных альтернатив. Для 
каждой новой конфигурации система может подсчитать цену. 

Для того чтобы оформить заказ, клиент должен заполнить ин­
формацию по доставке и оплате. В качестве платежных средств до­
пускается использование кредитных карточек или чеков. После вво­
да заказа система отправляет клиенту по электронной почте сообще­
ние, содержащее подтверждение получения заказа вместе с 
относящимися к нему деталями. Пока клиент ожидает доставку ком­
пьютера, он может проверить состояние заказа в любое время в диа­
логовом режиме. Серверная часть обработки заказа состоит из зада­
ний, необходимых для проверки кредитоспособности и способа рас­
чета клиента за покупку, истребования заказанной конфигурации со 
склада, печати счета и подачи заявки о доставке компьютера клиен­
ту на склад. 

Дополнительные требования: 
• для знакомства со стандартной конфигурацией выбираемого 

сервера, настольного или портативного компьютера клиент исполь­
зует Web-страницу интернет-магазина. При этом также приводится 
цена конфигурации; 

• клиент выбирает детали конфигурации, с которыми он хочет 
ознакомиться и, возможно, купить готовую или составить более под­
ходящую конфигурацию. Цена для каждой конфигурации может 
быть подсчитана по требованию пользователя; 
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• клиент может выбрать вариант заказа компьютера по интернету 
либо попросить, чтобы продавец связался с ним для объяснения де­
талей заказа, договорился о цене и тому подобном, прежде чем заказ 
будет фактически размещен; 

• для размещения заказа клиент должен заполнить электронную 
форму с адресами для доставки товара и отправки счет-фактуры, а 
также деталями, касающимися оплаты (кредитная карточка 
или чек); 

• после ввода заказа клиента в систему продавец отправляет на 
склад электронное требование, содержащее подробное описание 
заказанной конфигурации; 

• детали сделки, включая номера заказа и счета клиента, отправ­
ляются по электронной почте клиенту, так что заказчик может про­
верить состояние заказа по интернету; 

• склад получает счет-фактуру от продавца и отфужает компью­
тер клиенту 

Магазин проката видеопродукции 

Магазин проката видеопродукции нуждается в компьютеризо­
ванной системе учета, так как его ассортимент составляют около 
1000 видеокассет и 500 видеодисков. Запас уже заказан у поставщи­
ка, однако директор намерен прибегать к услугам большего числа 
поставщиков. Все видеокассеты и диски снабжены штрих-кодом, 
так что сканер, интегрированный в систему, может поддерживать 
операции вьщачи напрокат и возврата видеофильмов. Членские кар­
точки клиентов также снабжены штрих-кодом. 

Клиенты имеют возможность резервировать видео таким обра­
зом, чтобы комплект видеофильмов был собран к определенной да­
те. Система должна обладать поисковым механизмом для ответов на 
запросы клиентов, включая вопросы, касающиеся фильмов, кото­
рых нет в ассортименте магазина (но которые он может заказать по 
просьбе клиента). 

Для каждого фильма установлен конкретный период проката 
(исчисляемый в днях) с соответствующей платой за прокат за этот 
период. 

Видеомагазин должен быть в состоянии немедленно дать ответ 
на любой запрос по наличию фильмов в запасе, а также количеству 
кассет или дисков (текущие условия по каждой ленте и диску долж­
ны быть известны и зафиксированы). 
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Плата за прокат отличается в зависимости от видеоносителя: 
кассета или диск. 

Хотя магазин держит в запасе видеодиски только одного форма­
та DVD, пользователи желали бы расширить в будущем систему про­
ката и на диски других форматов. 

Работники видеомагазина стремятся запомнить коды наиболее 
популярных лент Зачастую при идентификации фильма они ис­
пользуют именно код фильма, а не его название (поскольку фильм с 
одним названием мог выпускаться разными режиссерами). 

Дополнительные требования: 
• за кассеты и диски, возвращенные позже указанного срока, 

взимается дополнительная плата за период, превышающий срок 
проката. Каждый видеоноситель обладает уникальным идентифика­
ционным номером. 

Фильмы заказываются у поставщика, который может поставить 
кассеты и диски в течение недели. Обычно делается один заказ на 
несколько фильмов. 

Забронировать можно те фильмы, которые заказаны у постав­
щика и/или все копии которых находятся в прокате, а также филь­
мы, которых нет в запасе и которые не заказаны у поставщика; при 
этом с клиента требуется задаток за один период проката. 

Клиент может также сделать несколько предварительных зака­
зов, однако для каждого забронированного фильма нужно подгото­
вить отдельный запрос на бронирование. Бронирование может быть 
отменено из-за того, что клиент не проявил никакой реакции в тече­
ние недели, прошедшей с момента, когда ему сообщили о возможно­
сти взять фильм напрокат Если за фильм был уплачен задаток, он 
записывается на счет клиента. 

База данных хранит традиционную информацию о поставщиках 
и клиентах, т.е. адреса, телефонные номера и т.д. В каждом заказе по­
ставщику указываются заказываемые фильмы, их количество, фор­
мат кассеты/диска, а также дата ожидаемой доставки, отпускная це­
на, возможные скидки и т.д. 

Когда кассета возвращается клиентом или поступает от постав­
щика, работники магазина в первую очередь обслуживают клиентов, 
сделавших предварительный заказ. Для правильной обработки бро­
нирования фильмов информация, связанная с бронированием, об­
новляется дважды: после установления контакта с клиентом, когда 
ему сообщается, что "забронированный фильм пришел", и после 
сдачи фильма клиенту напрокат. Эти шаги гарантируют правильное 
проведение операции бронирования. 
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Клиент может взять несколько кассет или дисков, однако каждо­
му взятому видеоносителю ставится в соответствие отдельная за­
пись. Для каждого вьщаваемого напрокат фильма фиксируются дата 
и время выдачи, установленный и фактический срок возврата. Поз­
же запись о прокате обновляется, чтобы отразить факт возврата ви­
деофильма и факт окончательного платежа (или возврата денег). 
Кроме того, запись хранит информацию о продавце, отвечающем за 
прокат фильма. Детальная информация о клиенте и по прокату хра­
нится в течение года, чтобы можно было легко определить уровень 
доверия к клиенту. Старая информация по прокату сохраняется в те­
чение года в целях проведения аудита. 

Все операции выполняются с использованием наличности, эле­
ктронного перевода денег или кредитных карточек. От клиентов тре­
буется внести плату за прокат при выдаче кассет/дисков. 

Если кассета/диск возвращены позже установленного срока 
(или не могут быть возвращены по каким-либо причинам), плата 
снимается либо со счета клиента, либо принимается непосредствен­
но от клиента. 

Если кассета/диск задержаны более чем на два дня, клиенту от­
правляется уведомление о задержке. После отправки двух уведомле­
ний о задержке одной и той же кассеты/диска клиент получает пре­
дупреждение о том, что-он является "нарушителем" и при следую­
щем обращении его в магазин руководство будет рассматривает 
вопрос о снятии с него статуса "нарушителя". 

Служба занятости в рамках вуза 
Система предназначена для того, чтобы помочь студенту устро­

иться на работу уже в процессе обучения его в вузе. Подав заявление 
в систему, студент становится ее клиентом и начинает обслуживать­
ся на протяжении всего обучения в вузе. Заявление представляет со­
бой анкету Система предлагает профессиональные (основанные на 
изучаемых предметах) психологические тестирования, проводимые 
регулярно (раз в семестр (полгода)). Особое внимание уделяется 
обучению студента, по итогам успеваемости составляются эксперт­
ные оценки. На основе собранной информации составляется резю­
ме, представляющее собой полную характеристику человека, и рас­
сылается всем организациям, имеющим необходимые вакансии. 

Основным назначением системы являются автоматизация ввода 
и хранения отчетных данных о студентах, составление характерис-
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тик и резюме, поиск вакансий в фирмах. Система позволяет изме­
нять, дополнять, вести поиск и просмотр информации о студентах, 
накладывать ограничения доступа к системе, хранить списки сту­
дентов, окончивших обучение, в виде архива, контролировать выда­
чу студенту заданий на курсовые работы и проекты, связывать ин­
ститут с фирмами, заинтересованными в поиске сотрудников. 

Данная система также может быть использована для составления 
отдельных списков групп, печати зачетных ведомостей и полной ба­
зы данных, для статистики. 

Система состоит из четырех подсистем: 
• контроля за успеваемостью студентов; 
• профессиональных и психологических тестов; 
• обработки запросов, определения категорий полномочий поль­

зователей; 
• экспертных оценок. 
Подсистема "Контроль успеваемости студентов" отвечает за ста­

тистическую отчетность по успеваемости отдельного студента, груп­
пы или целого факультета, а также за хранение и правильность ее 
ввода. 

Входными данными подсистемы являются: оценки, даты сдачи 
экзаменов, имена студентов, номера фупп, факультет. На выходе 
подсистема выдает обработанные данные: средний балл по студенту, 
группе или факультету, процентное соотношение оценок у студента 
в группе или на факультете, имена и количество стипендиатов в 
фуппе или на факультете. Подсистема "Контроль успеваемости сту­
дентов" может функционировать отдельно от всей системы, что дает 
возможность установить и использовать ее независимо, если это не­
обходимо. 

Подсистема "Контроль успеваемости студентов" включает следу­
ющие функции: 

• ввод, вывод и редактирование информации по информацион­
ным объектам подсистемы; 

• сохранение информации, поступившей от подсистемы "Кон­
троль успеваемости студентов"; 

• расчет процентного соотношения оценок у студента в фуппе 
или на факультете и вывод его в виде таблиц, графиков и диаграмм; 

• расчет среднего балла по студенту, фуппе или факультету; 
• формирование данных по студенту, фуппе или факультету; 
• выявление сильнейших и слабейших студентов в группе или на 

факультете; 
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• расчет количества стипендиатов в группе или на факультете; 
• проверку правильности ввода данных. 
Подсистема обработки запросов, определения категорий поль­

зователей предназначена для определения категории, полномочий и 
обработки запросов пользователей службы занятости. В частности, 
она выполняет следующие функции: 

• регистрацию новых фирм; 
• регистрацию новых студентов; 
• определение прав доступа зарегистрированного пользователя; 
• обработку запросов; 
• прием регистрационных данных от фирм, студентов и обслу­

живающего персонала; 
• составление резюме; 
• запись данных в БД студентов, фирм и зарегистрированных 

пользователей. 
В соответствии с выполняемыми функциями система работает 

со следующими сведениями: 
• регистрационными данными студентов и фирм; 
• личными данными студентов; 
• информацией о студентах (получаемой фирмами); 
• информацией о фирмах (получаемой студентами); 
• идентификационными данными пользователей; 
• информацией о системе; 
• запросом; 
• служебной информацией (для обслуживающего персонала); 
• результатами психологического и профессионального тестов; 
• экспертными оценками. 

Система складского учета 
Система складского учета — профаммная система, затрагиваю­

щая все аспекты, связанные с движением товара на склад и со скла­
да. По результатам анализа можно выделить семь основных функций 
системы. 

Функция системы Описание 
Учет заказов Прием заказов от клиентов и ответы на запросы клиен­

тов о состоянии заказов 
Ведение счетов Направление счетов клиентам и отслеживание плате­

жей. Прием счетов от поставщиков и отслеживание 
платежей, направляемых поставщикам 
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Функция системы Описание 

Отфузка со склада Составление спецификаций на комплектацию товаров, 
отправляемых со склада клиентам 

Складской учет Постановка прибывающих товаров на учет и снятие то­
варов с учета при отправке заказов 

Закупки Заказ товаров поставщикам и отслеживание поставок 

Получение Принятие на склад товаров от поставщиков 

Планирование Выпуск отчетов, в том числе отражающих тенденции 
спроса на отдельные виды товаров и активность постав­
щиков 

В качестве части стратегии компании, занимающейся торговлей 
по каталогам, по проникновению на новые участки рынка было ре­
шено создать ряд относительно автономных региональных складов 
продукции. Каждый такой склад несет ответственность за учет това­
ров и выполнение заказов. В целях повышения эффективности сво­
ей работы склад обязан сам поддерживать ту номенклатуру товаров, 
которая в наилучшей степени соответствует потребностям местного 
рынка. Номенклатура может быть разной для каждого региона и 
должна оперативно меняться в соответствии с потребностями кли­
ентов. Головная компания хотела бы иметь на всех складах одинако­
вую систему учета. 

Основными функциями системы являются: 
• учет товаров, приходящих от разных поставщиков, при приеме 

их на склад; 
• учет заказов по мере поступления их из центральной удаленной 

организации; заказы также могут приниматься по почте. Их обра­
ботка ведется на местах; 

• генерация указаний персоналу, в частности, об упаковке това­
ров; 

• генерация счетов и отслеживание оплат; 
• генерация запросов о поставке и отслеживание платежей по­

ставщикам. 
Кроме автоматизации стандартных складских операций система 

также должна предоставлять богатые возможности по генерации 
различных форм отчетности, в том числе отражающих тенденции 
развития рынка, списков наиболее надежных и ненадежных постав­
щиков и клиентов, материалов для рекламных кампаний. 
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Web-сайт авиакомпании 

Коммерческий отдел авиакомпании предложил расширить свой 
Web-сайт, чтобы пользователи смогли: 

• узнать о выполнении рейсов текущего дня; 
• запросить информацию о расписании рейсов, стоимости биле­

тов и наличии мест; 
• купить билеты. 
Постоянные клиенты авиакомпании могут использовать также 

следующие функции: 
• получить текущую информацию о состоянии своего личного 

счета (количество километров, проведенных в воздухе с начала года 
на данное число, количество налетанных километров для получения 
вознаграждения (бесплатного перелета) и т.д.); 

• купить билеты, используя либо информацию о налетанных ки­
лометрах (для постоянных клиентов), либо кредитную карточку. 

Для того чтобы гарантировать конфиденциальность частной ин­
формации и предотвратить несанкционированное использование 
данных о постоянных клиентах, необходимо требовать, чтобы поль­
зователь при доступе к личным счетам зарегистрировался, введя но­
мер счета и личный идентификационный номер владельца карточки 
(PIN). После регистрации пользователь должен увидеть начальную 
страницу с учетом его предпочтений и привычек, полученных из ба­
зы данных, хранящей информацию о перелетах постоянных клиен­
тов. Постоянные клиенты могут оперативно обновлять сведения о 
себе. 

Для того чтобы сэкономить деньги, руководство компании при­
няло решение использовать ряд существующих систем: 

• систему управления счетами, хранящую информацию о посто­
янных клиентах и балансе "премиальных километров"; 

• маркетинговую базу данных, которая отслеживает данные о 
выполненных рейсах, классе оплаты и др. Эти данные используются 
для формирования специальных уведомлений, которые включаются 
в ежемесячные выписки из лицевого счета постоянных клиентов; 

• базу данных тарифов; 
• базу данных наличия билетов. 
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4. РЕКОМЕНДАЦИИ ПО УСТАНОВКЕ 
ИНСТРУМЕНТАЛЬНЫХ СРЕДСТВ 

При выполнении упражнений, приведенных в практикуме, ис­
пользуются следующие версии инструментальных средств: 

• IBM Rational Rose Enteфrise Edition 2003. 
ф IBM Rational RequisitePro 2003. 

Для того чтобы обеспечить совместную работу данных инстру­
ментальных средств, в процессе установки их с компакт-диска 
Rational Solutions for Windows нужно выполнить следующие дейст­
вия: 

• в окне выбора продукта для установки (рис. П.4.1) отметить 
строку Rational Suite DevelopmentStudio или Rational Suite Enteфrise; 

Rattonaf Setup Wizard 

PfoducI Seieclion 
Choose the product to install 

^'^^'^'ir^^.'l.X." - i ^ . ^ . ' .̂ :У:•:f:•̂ :̂ .r•r:>̂ .̂ ;̂ ^ /."!: .̂ '̂.-"""-̂  '-'*'"'</'*"=-'?V - "'''-'̂ <:*' .l\ -' 
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" Ф Rational Rose Realtime 
Ф Rational SoOA for Word 
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Rational Suite DevelopmentStuc'^.] 
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Рис. П.4.1. Окно выбора продукта для установки 
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• в окне выбора программ (рис. П.4.2) оставить отмеченными 
строку Rational Rose Enterprise Edition и Rational RequisitePro. 

l^ Rational Suite DevelopmentStudio ~ Setup Wizard 

Custom Setup 
Select the program features you want Installed. 

: X ^ 
Ш" X ^ 
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й X 

Rational ClearCase IT Client 
Rational ClearQuest 
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Rational SoDA for Word 
Rational Extended Help 
Web Server Components 
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Рис. п.4.2. Окно выбора программ 
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